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Introduction Welcome

Welcome
RFXpress RFX100 is a software application that creates digitally modulated baseband, IQ, IF, RF,
UWB-WiMedia, and Radar signals that can be generated through arbitrary waveform generators (AWG).
This software runs as an integral part of AWG5000 and AWG7000 series arbitrary waveform generators
and can also run from an external PC.

Using RFXpress RFX100 (referred to as RFXpress), you can define baseband I and Q signals with various
modulation schemes and create single or multi-carrier signals where each carrier can be independently
defined. For each carrier, you can apply impairments such as quadrature error and I/Q imbalance, add
interferences such as sinusoidal interference, and define the graphs to create. Upon compilation, the signal
can be viewed as graphs, sent to an arbitrary waveform generator, and saved for later use. Compilation
options include sending signals directly to the AWG and completely eliminating the wrap-around
effects found in arbitrary waveform generators. This provides seamless signals that can be played back
continuously without any discontinuity or glitch in the time, frequency, modulation, or channel coding
domains. Waveform transfer and control of the AWG5000 and AWG7000 series can be performed directly
from RFXpress.

Waveforms captured from oscilloscopes and real-time spectrum analyzers can be modified in RFXpress
before they are regenerated.

You can create UltraWideBand WiMedia signals in the Conformance and Custom modes. In the
conformance mode, you can either select a standard setup or define your own setup based on the UWB
standards. In the Custom mode, you can create a customized signal by defining packet parameters and
setting processing preferences. The Calibration feature for the UWB-WiMedia module allows you to
create correction files and apply these correction files to channels during compilation.

The RFXpress RFX100 radar application supports basic pulse generation of different shapes and
modulation types.

Related Documentation
In addition to this RFXpress Online Help, the following documentation is included with the software:

RFXpress Installation Manual (Tektronix part number 077-0160-XX). The installation manual has
information about installing and upgrading the software.

RFXpress Printed Help Document (User Manual) (Tektronix part number 077-0045-XX). The user
manual is adapted from the online help and is available in PDF format.

RFXpress Quick Start User Manual (Tektronix part number 077-0159-XX). The quick start user
manual has information about using the software creating IF/IQ/RF signal output.

RFXpress Programmer Online Help (Tektronix part number 076-0216-XX). The programmer online
help has information about the available programmer commands for RFXpress.

RFXpress Programmer Manual (Tektronix part number 077-0435-XX). The programmer manual is
adapted from the programmer online help and is available in PDF format.
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Introduction Conventions

For WiMedia standards, please refer to the MultiBand OFDM Physical Layer Specification Version 1.2
by WiMedia Alliance.

Conventions
The online help uses the following conventions:

When steps require a sequence of selections using the software interface, the ">" delimiter marks each
transition between a menu and an option. For example, File > Save.

DUT refers to the Device Under Test

Three dots (...) following a menu item indicates that the menu item will open a submenu.

The terms "signal" and "waveform" are used interchangeably.

Feedback
Tektronix, Inc.

14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:

In North America, call 1-800-833-9200.

Worldwide, visit www.tektronix.com to find contacts in your area.
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Getting Started Minimum System Requirements

Minimum System Requirements
RFXpress when installed on a personal computer runs in the offline mode. The minimum requirements for
the offline version of the application are listed in the following table.

Table 1: Minimum system requirements
Supported OS Windows XP Professional Service Pack 2.1

Windows 7 Professional
Windows Vista Business Edition (English Language)

Minimum Requirements 2.0 GHz or higher
512 MB RAM
15 GB free disk space
Microsoft Internet Explorer 6.01 or higher
.NET 3.5 runtime
1024 x 768 display resolution with 120 dpi font size

xxx

Prerequisites
TekVisa version 3.3.4.6 or above to communicate with test instruments, such as oscilloscopes,
over LAN. If TekVisa is not already installed in your system, you can download the software from
www.tektronix.com/software.

MATLAB Runtime version 7.9 installed on your instrument.

.NET v3.5 Service Pack 1 installed on your instrument.

Ordering RFXpress
RFXpress can be ordered as follows:

Table 2: Ordering RFXpress
Part number Description
RFX100 Base Software: RFXpress for General Purpose IQ, IF, and

RF signal creation
Opt. UWBCF RFXpress plug-In for UWB-WiMedia IQ, IF, and RF

conformance signal creation (requires RFX100 as
prerequisite)

Opt. UWBCT RFXpress plug-in for UWB-WiMedia IQ, IF, and RF custom
and conformance signal creation (requires RFX100 as
prerequisite and includes Option UWBCF)

Opt. RDR RFXpress plug-in for RADAR signal creation (requires
RFX100 as prerequisite)
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Getting Started Installation

Table 2: Ordering RFXpress (cont.)

Part number Description
Opt. SPARA RFXpress option for including S-Parameter for Generic

Signal and DUT Characterization (requires RFX100 as
prerequisite)

Opt OFDM RFXpress option for including OFDM signal generation
(requires RFX100 as prerequisite)

RFXUP
OFDM

Upgrade option to include OFDM signal generation for
RFX100

xxx

Installation
An installation wizard installs RFXpress. If you have not installed TekVisa version 3.3.4.6, MATLAB
Runtime version 7.9, and .NET 3.5, you will be notified during installation. You can cancel the installation
any time during the process.

For details on how to install the software, refer to the RFXpress Installation Manual (Tektronix part
number 077-0160-XX) available as a PDF on the CD-ROM.

You can uninstall RFXpress in either of the two ways:

From Start > Programs > Tektronix RFXpress > Uninstall RFXpress.

From Add/Remove programs in Control panel.

Setup for RF Signal Generation
1. Start the RFXpress installed on the AWG.

2. From the toolbar, select the signal type as IF/RF.

3. Make connections as shown in the figure:

Connect the AWG Ch 1 Analog Output to the DUT where the RF Signal must be fed.

When using the Interleave mode, the RF output should be taken from Interleave Output as shown.
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Getting Started Setup for IF Signal Generation

4. Click Compile. The waveform is compiled according to the default settings in the Compile Settings
window. The compiled waveform is displayed in the Waveform List. This IF/RF waveform is
transferred to the AWG channel (Ch1) and this can also be seen in the Instrument Control > AWG tab.

5. Click On/Off to turn on the channel Ch1.

6. Click Run to generate the signal on the AWG.

See also:

Calibration (see page 133)

Find Instruments (see page 29)

Setup for IF Signal Generation
1. Start the RFXpress installed on the AWG.

2. From the toolbar, select the signal type as IF/RF.

3. Connect the AWG Ch 1 Analog Output to the DUT where the IF Signal must be fed.

4. Click Compile. The waveform is compiled according to the default settings in the Compile Settings
window. The compiled waveform is displayed in the Waveform List. This IF waveform is transferred
to the AWG channels (Ch1) and this can also be seen in the Instrument Control > AWG tab.

5. Click On/Off to turn on the channel Ch1.

6. Click Run to generate the signal on the AWG.

See also:

Calibration (see page 133)

Find Instruments (see page 29)
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Getting Started Setup for AWG IQ Signal Generation

Setup for AWG IQ Signal Generation
1. Start the RFXpress installed on the AWG.

2. From the toolbar, select the signal type as IQ.

3. Make connections as shown in the figure:

Connect the AWG Ch1 Analog Output to the DUT where the I Signal must be fed.

Connect the AWG Ch2 Analog Output to the DUT where the Q Signal must be fed.

NOTE. Both cables must be the same length, otherwise you would need to deskew them.

4. Click Compile. The waveform is compiled according to the default settings in the Compile Settings.
The compiled waveform is displayed in the Waveform List. This waveform is transferred to the AWG
channels (Ch1 and Ch2). This can also be seen in the Instrument Control > AWG tab.

5. Click On/Off to turn on the channels Ch1 and Ch2.

6. Click Run to generate the signal on the AWG.

Setup for AWG IQ Signal Generation with External Modulator
1. Start the RFXpress installed on the AWG.

2. Select the Signal type as IQ.
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Getting Started Setup for AWG IQ Signal Generation

3. Make connections as shown in the figure:

Connect the AWG and Agilent performance signal generator® (E8267D with Option 015) through
LAN or GPIB.

Connect the AWG Ch1 Analog Output to the Agilent performance signal generator's (PSG®)
external I Input (in the rear panel).

Connect the AWG Ch2 Analog Output to the Agilent performance signal generator (PSG®)
external Q Input (in the rear panel).

Connect the PSG RF output from the front to the DUT.

NOTE. Both cables must be the same length, otherwise you would need to deskew them.

4. Click Compile. The waveform is compiled according to the default settings in the Compile Settings
window. The compiled waveform is displayed in the Waveform List. This waveform is transferred to
the AWG channels (Ch1 and Ch2). This can also be seen in the Instrument Control > AWG tab.

5. Click On/Off to turn on the channels Ch1 and Ch2.

6. Click Run to generate the signal on the AWG.

See also:

Calibration (see page 133)

Find Instruments (see page 29)
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Operating Basics About Basic Operations

About Basic Operations
The basic operations section describes the software, tells how to start the software, use the menus and
toolbars, and describes the dialog boxes.

In this online help, all menu selections are indicated with Menu name and Menu options separated by
">". You can access a command or a menu option in more than one way. Several main menu options are
available in a toolbar that you can use instead of selecting the option from the main menu. Shortcut menus,
which open with a right-click, are provided for editing, creating and viewing graphs, importing data from a
file or a Tektronix oscilloscope, and transferring a waveform to an arbitrary waveform generator.

Some dialog boxes also have a Help button that displays help for that dialog box.

Detailed operations and parameters are described in the sections on Generic Signal, OFDM,
UWB-WiMedia, Radar, Calibration for WiMedia Signals, Instrument Control, and Graphing. The
References section lists Error Messages, Shortcut Keys, and provides a note on Interleaving and Types of
Modulation.

The following figure shows the application screen, the menu, the toolbar, and other elements of the
user interface.
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Operating Basics Overview of the Software

Overview of the Software
RFXpress is a software application that creates digitally modulated baseband, IQ, IF, RF, UWB-WiMedia,
and Radar signals that can be generated through arbitrary waveform generators (AWG). This software runs
as an integral part of AWG5000 and AWG7000 series arbitrary waveform generators and can also run
from an external PC.

Features of RFXpress
Baseband data generation. Define baseband I and Q signals using a variety of modulation schemes
such as No Mod, QPSK, PI/2 QPSK, BPSK, PI/4 QPSK, OQPSK, 8-PSK, O-8PSK, QAM-16, PI/2
QAM16, QAM-32, QAM-64, QAM-128, QAM-256, QAM-512, QAM-1024, GMSK, 2-FSK, 4-FSK,
8-FSK, 16-FSK, 32-FSK, ASK, AM, PM, FM, nDPSK, OOK, and Pi/2 BPSK.

Multi-carrier setup. Define multiple RF/IF carriers in a single waveform. Each carrier can be
independently defined with parameters such as carrier frequency, symbol rate, modulation type,
and baseband filters.

Single or multiple pulse groups to form a pulse train. Each pulse group can be independently defined
with various predefined pulse shapes and user defined shapes for a pulse group.

Allows you to apply various modulation schemes or define your own.

Allows you to have Pulse- to-Pulse hopping within a pulse group and to apply impairments like Edge
Jitter, Width Jitter, Overshoot, Ripple and Droop on a pulse group.

IQ impairments. Apply impairments including quadrature error and quadrature imbalance.

Generate the following graphs:

Frequency Domain: Spectrum

I v Q: Constellation

Time Domain: I(t) and Q(t) versus time, and Pulse shape

Statistical: CCDF and Eye Diagram

Time versus Frequency: Spectrogram and Coherent Pulse Interval

Distortion measurement for system calibration. To maintain system integrity and coherency with
Amplitude, Phase inband flatness, and skew between separate channels. The setup includes capturing
data from a TDS oscilloscope and a real-time spectrum analyzer and downloading the data to generate
the correction data.

Noise/interference generation and addition. Generate and add interference for waveforms. Generate
gated noise on specific frames designated by the user.

Capture and Replay. Waveforms captured from oscilloscopes and real-time spectrum analyzers can
be modified in RFXpress before they are regenerated.
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Wrap around. RFXpress completely eliminates all the wrap-around effects found in arbitrary
waveform generators, providing seamless signals that can be played back continuously without any
discontinuity or glitch in the time, frequency, modulation, or channel coding domains.

Connectivity between AWG, oscilloscope, and Agilent Performance Signal Generator® (PSG).
The ability to identify and connect to a Tektronix Arbitrary Signal Generator (AWG), a Tektronix
oscilloscope, and the Agilent PSG®, and to configure their setups remotely. The radar application uses
the AWG sequence mode is to optimize the memory and create large number of pulses. However if
Option 08 is not purchased, the radar application uses the Continuous Mode instead of Sequence Mode.

Remotely configure a Tektronix real-time spectrum analyzer and import I and Q trace data.

Characterize a DUT and provide S-parameter emulation of RF components.

Define antenna beam profile and simulate target returns for radar signals.

Create multiple layers of modulation using subcarrier multiplexing.

Define a staggered PRI with ramp and user-defined profiles, and add up to ten multipaths.

Configure all parameters of OFDM

Build custom OFDM frames from defining base data, symbols, packets, and frames

Support Reed Solomon, Convolution coding, and Scrambling

Add Impairments Phase noise, Multipath, and Quantization

Define frequency hopping and gated noise

Support a variety of subcarrier modulation (BPSK, QPSK, QAM (16,32,64,256) and 8-PSK)

Support Tone Nulling and Clipping

Provide presets for WiFi and WiMax standards
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Starting the Software
From the Start menu, click All Programs > Tektronix RFXpress > RFXpress. You can also double-click
the RFXpress shortcut on the desktop.

You can use the software in three modes:

RFXpress on any AWG5000 or AWG7000 series instrument. In this case, the software automatically
detects the AWG software. You can transfer data directly to the AWG. The status bar shows
"AWGXXXX Online".

RFXpress on a PC with the AWG software running in the offline mode. In this case, the AWG
software has to be started before starting RFXpress. You can transfer data to the AWG offline software.
The status bar shows "AWGXXXX Offline".

RFXpress on a PC without the AWG software. In this case, the software does not detect the AWG
software, and you cannot transfer data to the AWG (although you can create and store the waveform
for later use). The status bar shows "AWGXXXX Not Available".

Using the Software to Create a Signal
Using RFXpress, you can generate a signal as follows:

1. Select an application or module: Generic Signal, UWB-WiMedia, or Radar.

2. Select the signal type: IF/RF or IQ.

3. For a Generic signal, select the number of carriers: Single or Multi-carrier. For a UWB signal, select
the mode: Conformance or Custom. For a Radar signal, select the number of pulses.

4. For a Generic signal, define the carrier parameters: Frequency, Modulation, Amplitude, Filter and
others. For a UWB signal, select the setup and define the selected packet group and packet parameters.
For a Radar signal, select the pulse envelope, frequency, and other pulse parameters.

5. Select the compilation options and compile the signal.

You can also specify the graphs that you want to create and view them in the Graph Preview window. You
can transfer the signal to an arbitrary waveform generator in the Instrument Control window. Importing
files and replicating waveform files work with only the following instruments:

Oscilloscopes: Tektronix TDS6000, DPO/DSA70000, and DPO7000 series (*.wfm)

Arbitrary Waveform Generators: Tektronix AWG400, AWG500, AWG600, and AWG700 series
(*.wfm)

Real-time Spectrum Analyzers: Tektronix RSA3000 and RSA60000 series (*.iqt, *.tiq)

Others: MATLAB binary formats (*.MAT)
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Exiting the Software
Select File > Exit to exit the application. If you have not saved the waveforms, you are prompted to do so.

File Name Extensions and Directories
The software uses the following file name extensions:

Table 3: File name extensions
File name extension Description
.rfs Setup file of the selected application
.rfd Data file of the waveform (generic signal and ultra wide

band signal)
.smp Symbol file
.rfc Correction file
xxx

The software uses the following directories:

Table 4: Directory names
Directory Description
C:\Program Files\Tektronix\RFXpress\System Contains the application files and executables
C:\Program Files\Tektronix\RFXpress\Documentation Contains the related documentation as text and PDF files
C:\Program Files\Tektronix\RFXpress\Samples Contains sample waveform files
xxx
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Applications, Setup Files, and Data Files
An application is a module that you can use to create specific types of waveforms, for example Generic
Signal and UWB-WiMedia. Applications that are available but have not been purchased appear in the
Application list but are disabled.

You can only have one Setup File (.rfs) open at a time and only one application in use at a time. If you
change the application, you are prompted to save the open file.

Selecting an application: In the Select field, select an application from the list. When you select
an application (Generic Signal, UWB-WiMedia, or Radar), the default settings are displayed for the
currently selected application.

Setup File (.rfs): A Setup File is a collection of settings that describes a single or multiple waveforms.
Once you compile the setup file (using Waveform > Compile), you can save the file as a Data File (.rfd).
Compiled data files for the current session appear in the Waveform List. After you select the Application,
a default Setup File opens automatically. If a setup file is open with unsaved changes and you try to
create a new file or change applications, you are prompted to save the file. To open an existing setup
file, select File > Open Setup.

The rfs file content varies depending on the selected application (Generic or UWB-WiMedia). By default,
the name of the rfs file is derived from the application name.

Data File (.rfd): You can save a compiled Setup File as a Data File using File > Save Data or Save Data
As. Files that you import from other instruments become data files. Select File > Save or Save As to save
these data files. To open an existing data file, select File > Open Data.

NOTE. Each rfd file can store one of the three formats: IF/RF, I, and Q. An rfd file stores the version
information and sampling rate.
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Menu Bar
The RFXpress menu has the following items:

File

Use the File menu to:

Restore the default setup for the currently active application

Create new waveform setups

Open, close and save waveform setups (.rfs format)

Open, close and save data files (.rfd format)

Import data from a file (created by another software)

Import data from a Tektronix oscilloscope

Exit the software

View
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Use the View menu to:

View the Standard toolbar

View the Status toolbar

Configure

Use the Configure menu to:

Select an application: Generic Signal, UWB-WiMedia, Radar, OFDM, or Environment.
UWB-WiMedia, Radar, OFDM, and Environment are available only if they have been
purchased

Open the Find Instruments dialog box to make instrument connections

Waveform
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Use the Waveform menu to:

Compile the currently active Waveform Setup

Set Compilation options

Open the Graph Setup dialog box to select the graphs

System

Use the System menu to:

Run

Stop

Turn all channel outputs on or off

Open the Calibration wizard and set the parameters to calibrate the signal

Open the DUT Characterization wizard

Window
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Use the Window menu to:

View the Waveform List window

Preview the Graphs

Open Instrument Control window

Open the Overview window

Close all windows

Help

Use the Help menu to:

Open the online help

Display help specific to the currently active application

Display technical support on the Tektronix Web site

Display information about the application, such as version number

Standard Toolbar
The Standard toolbar is always displayed by default. Select View > Standard toolbar to hide or show
the toolbar.

The Standard toolbar has the following options that you can select:

Select Application (see page 22)

Signal Type (see page 22)

Configure IF (see page 49)

Calibration (see page 50) Calibration for Generic Signal
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Overview (see page 37)

Find Instruments (see page 29)

Graph (see page 30)

Compile (see page 22) and Compile Settings (see page 32)

Status Bar
The Status Bar is always displayed by default. Select View > Status Bar to hide or show the status bar.
The status bar shows the selected application, the AWG mode, and the active waveform names. The
status of calibration (On/Off) is also displayed.

Waveform List
Window > Waveform List

The Waveform List is a floating window and can be moved anywhere in the display area. By default it
opens in the leftmost area of the display window. The Waveform List window can be kept open by
pushing the pin in the top right corner, or closed and opened as you like. To view the waveform list,
from the menu select Window > Waveform List.

After you select a signal to generate and set the parameters for it, you must compile it to create the data.
Once you compile a signal (using Compile from the toolbar), waveform data is created and added to the
waveform list. The Waveform list displays the Name, Length, Sampling Rate and Format of the waveform
data. The maximum number of waveforms that can be displayed in the waveform list is 13,000. When
the number of waveforms exceeds this limit, a warning message appears: Number of waveforms is over
the maximum limit of 13,000.

To save a waveform that is available in the list, select the waveform and select File > Save Data or Save
Data As. You can also right-click the selected waveform and choose Save Data As. The compiled
waveform or data file is saved as a data file (.rfd) in the specified location. The data files are stored in the
path where the application is installed.

NOTE. If you close the software without saving the compiled waveform, the waveform is lost. You can
compile the waveform again from the setup, if you have saved the setup using File > Save Setup or Save
Setup As. The setup file is an rfs file.

You can select the following options from the shortcut menu:
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Table 5: Shortcut menu options
Selection Description
Send to AWG Enabled only if the AWG software is running and when a

waveform is selected. Sends the selected waveform data
to an Arbitrary Waveform Generator. Select the channel to
which to send the data.

Show Graph Enabled only when a waveform is selected. Plots a graph of
the selected type: Frequency Spectrum, Time Domain and
CCDF. You can also select Graph Settings... (see page 30)
and choose the graphs from those available.

Save Data As... Enabled only when a waveform is selected. Saves the
selected waveform data as a .rfd file in the specified name
and location.

Import from File... (see page 24) Imports data into the software from a file. Choose the file
and location from which to import data.

Import from Tektronix Oscilloscope... (see page 28) Imports data from a Tektronix oscilloscope that is connected
to the instrument on which the software is running.

Delete Enabled only when a waveform is selected. Deletes the
selected waveform.

Delete All Enabled only when a waveform or waveforms are available
in the Waveform List. Deletes all the waveforms shown in
the waveform list.

Rename... Enabled only when a waveform is selected. Opens a dialog
box that allows you to enter a waveform name.
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Table 5: Shortcut menu options (cont.)

Selection Description
Apply Calibration Enabled only when a waveform is selected. Opens a

browser window where you can specify the correction file
(.rfc) file to use for calibrating the selected waveform. The
correction file must be generated using a generic signal
with the same sampling rate as that of the signal you want
to calibrate. You can also apply calibration to an imported
waveform that was created using MATLAB.

Send to Environment plug-in Waveform List Enabled only when a waveform is selected. Sends
the selected waveform data to the Waveform list in the
Environment plug-in.

xxx

You can also drag and drop a waveform from the Waveform List to Instrument Control. When you drag
and drop a waveform, the sampling rate is automatically set in the instrument.

The Rename…, Save As… and Delete buttons appear at the bottom of the Waveform List. These buttons
are available only when a waveform is selected.

Table 6: Waveform list buttons
Selection Description
Rename... Opens a dialog box and allows you to rename the selected

waveform.
Save... Saves the selected waveform as an .rfd file.
Delete Deletes the selected waveform.
xxx

Generating Graphs

In the shortcut menu, from the Graph option you can select the following graphs: Time Domain, Spectrum,
and CCDF. Not all the graphs are available for all waveform formats and all applications. The following
table lists the availability of the graphs for various waveform formats.

Table 7: Waveform formats and available graphs
GraphsSelected waveform

format CCDF Spectrum Time domain
When both I and Q
waveforms are selected

Available Available Not available

When I waveform is
selected

Not available Not available Available

When Q waveform is
selected

Not available Not available Available

When IF/RF waveform is
selected

Not available Available Available

xxx

For the Radar application, the available graphs are Spectrum, Spectrogram, CPI, I Vs Time, and Q Vs time.
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Select Application
Configure > Select Application

Before you create a new Waveform Setup and Setup File, you must identify the application. Do this by
clicking on the Application field and selecting either Generic Signal, UWB-WiMedia, Radar, OFDM, or
Environment. The default settings for the currently selected application are displayed.

NOTE. The UWB-WiMedia, Radar, OFDM, and Environment are enabled only if you have purchased
the options.

Signal Type
Set the signal type from the drop-down list to either RF, IF, or IQ. Another way to select the signal type is
by using the Compile Settings (see page 32) dialog box.

Compile
Waveform > Compile

To compile a currently active waveform:

1. Click Compile in the Standard toolbar. The waveform is compiled and displayed in the Waveform List.

2. From the Waveform List (see page 19), you can select Send to AWG, Show Graph, Save Data
as, Delete, or Rename the waveform.
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On/Off

Click the On/Off button to turn on or turn off the arbitrary waveform generator (AWG)
channel output.

Run

Click the Run button to turn on or turn off the Run state of the arbitrary waveform generator
(AWG). If the application is running on an AWG or using an offline mode of the AWG software, the
compiled waveform is directly output to the channel. The channel is turned on and generates the signal.
The signal generation is indicated when the Run button changes to green.

Open Setup
File > Open Setup

You can open a setup file from the selected location. All files have the file name extension .rfs.

Open Data
File > Open Data

You can open a data file from the selected location. All files have the file name extension: .rfd.

Save Setup
File > Save Setup, File > Save Setup As...

You can save the setup file in any of the following formats: .rfs and .txt.

Use File > Save Setup to save an existing setup file with the same name. If you are saving the setup for the
first time, the Save Setup option works exactly as the Save Setup As... option.

Use File > Save Setup As... to save the setup file with another file name.
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Save Data
File > Save Data, File > Save Data As...

You can save the data file in either .rfd or .txt format. You must compile a setup before you can save the
data. If you try to save a setup as data without compiling, you are prompted to compile the setup.

Use File > Save Data to save an existing data file with the same name. If you are saving the data for the
first time, the Save Data option works exactly as the Save Data As... option.

Use File > Save Data As... to save the data file with another file name.

Import Data from a File
File > Import from File

You can import a waveform file created in another software, and import the resulting waveform into
RFXpress. To import data from a file, select File > Import from file. This dialog box is displayed. Navigate
to the directory of choice and select the file to import.

24 RFXpress RFX100 User Manual



Operating Basics Import Data from a File

You can import files of the following types:

.wfm from oscilloscopes and arbitrary waveform generators

.iqt from real-time spectrum analyzers (RSA3000 series)

.tiq from real-time spectrum analyzers (RSA6000 series)

.pat from arbitrary waveform generators

.isf from oscilloscopes

.csv (comma separated file)
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.txt (text file)

.mat (MATLAB) file

The following options are available:

Table 8: File import options
Selection Description Default value
Data Type: I Data, Q Data, IF/RF Data Select the data type to specify the type

of data contained in the file. Enabled
only when the file formats are .csv
and .txt.

I Data

CSV, Txt Format Specifies the parameters contained in
the csv or text file:
Time, Volt <cr><lf> (TDS CSV format)
Points, Volt <cr><lf>
Volt <cr><lf>
Volt <cr><lf>, AWG710 format
Time<tb>Volt<cr><lf>(ADS format)®

Volt, Volt<cr><lf> (VSA CSV format)®

Enabled only when the file format is
.csv or .txt.

Time, Volt <cr><lf> (TDS CSV format)

Resample waveform in list When selected, transforms the
imported waveform using the desired
sampling rate you provided. This
feature is available for all types of
imported files.

When the AWG is in the online mode,
the desired sampling rate must be
within limits. In the offline mode, the
sampling rate is restricted to within the
AWG7122B (option 1, 6, 8) limits.

Overwrite waveform in list When selected, overwrites the
waveform present in the waveform list
without any warning.

Disabled

Set as baseband signal When selected, replaces any existing
carriers with two carriers representing
the baseband signal. This option is
available only when an iqt or tiq file is
selected for import and the selected
application is Generic Signal.

Disabled

xxx

A MATLAB (.mat) file should meet the following conditions:

It should contain a sampling rate and a variable with ‘n’ sample points or values (n > 1).

The sampling rate should be of the format 1 x 1 and the points should be of the format 1 x n.

For example,

SamplingRate = 15e9

SamplePoints = [ 0.5 0.3 0.2 0.7 ….]
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Set Sampling Rate for Imported Waveforms
You can set the sampling rate for the waveform while importing it from a text file. This dialog box appears
only when the text file does not have the sampling rate of the waveform stored in it. The application uses
the default sampling rate (10 M S/s) if you do not enter a new sampling rate.

Resample Imported Waveform
You can use a different sampling rate while importing a waveform file created in another software.

1. Select File > Import from file.

2. Select the Resample waveform in list option. A dialog box appears.

The sampling rate and the number of samples (length) of the waveform being imported is displayed.

3. To change the sampling rate, click Turn On.

4. Enter the new sampling rate. As the sampling rate is changed, the Length is correspondingly changed.

When the AWG is in the online mode, the desired sampling rate must be within limits. In the offline
mode, the sampling rate is restricted to within the AWG7122B (option 1, 6, 8) limits.

5. Click OK. If you click Cancel, the waveform is imported without changing the sampling rate.
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Import from Tektronix Oscilloscope
File > Import from Tektronix Oscilloscope

You can import a waveform file from a Tektronix oscilloscope that is connected to your instrument into
RFXpress. To do this, select File > Import from Tektronix Oscilloscope. This dialog box is displayed.

A table displays a list of oscilloscopes on the network. Select an oscilloscope in the table and click
Connect to connect to it. You can connect to more than one oscilloscope at a time. Click Disconnect to
disconnect from an oscilloscope.

For a connected oscilloscope, you can set the following parameters:

Table 9: Waveform import options
Selection Description Default value
Data Source Select the data from which to acquire

the waveform data: Ch1 to Ch4,
Math1 to Math4, and Reference1 to
Reference4.

Ch1

Waveform Type Select the type of waveform: I, Q, or
RFIF.

I

Waveform Name Specify the waveform name. The
imported waveform is saved in the
specified name.

N/A
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Table 9: Waveform import options (cont.)

Selection Description Default value
Acquisition Mode Set the acquisition mode to one of

the following: Samples, Peak Detect,
Envelope, or Average.

Samples

Record Length Displays the record length of the
selected oscilloscope. Change the
record length by entering a new value
in the field.

N/A

xxx

Click Acquire to import the data. The specified waveform name is used to list the waveform in the
Waveform List.

Find Instruments
Configure > Find Instruments

You can find instruments on the network and connect to them.

1. Click Find Instruments to find other instruments on the network. The following dialog box opens. A
table lists the instruments found with the Name of the instrument, Model, Status (connected or not),
and the Connection type (Ethernet or GPIB).

2. Select an instrument from the table. Use the following buttons.
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Table 10: Find instruments options
Button Description
Connect Connect to the instrument selected in the table. Connect

is enabled by default if an instrument is highlighted in the
table; disabled if no instrument is highlighted.

Disconnect Disconnect the connected instrument. Enabled only if
highlighted instrument is connected.

Refresh Refresh the list of instruments.
Import... (see page 28) Open the Import from Tektronix Oscilloscope dialog box to

select a file to import.
xxx

3. Click Connect to connect to the selected instrument. The Status provides the current status during the
refresh operation: Searching Instruments or Ready.

Graph
Waveform > Show Graph or Graph Settings

The software allows you to select the types of graphs before creating them. The graphs are displayed in
two modes: as a set in a small window (for preview), and as individual graphs in large independent
windows. At any time, a maximum of three graphs can be displayed in the small view.

To specify the graphs to create, click Graphs in the toolbar or Waveform > Graph from the menu. The
Graph Setup dialog box opens.

Follow these steps to select the graphs to create:

1. Highlight a folder on the left. The graphs are grouped into the following folders: Frequency Domain,
I Vs. Q, Statistical, Time Domain, and Time vs Freq.

2. Highlight a graph from Available Graphs on the right. Click Add to add the graph to the Selected
Graphs area or drag and drop the graph to the Selected Graphs area.
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The following folders and graphs are available:

Frequency Domain: Spectrum

I Vs Q: Constellation

Statistical: CCDF and Eye Diagram

Time Domain: I & Q versus time, and Pulse shape

Time versus Frequency: Spectrogram and Coherent Pulse Interval

The Spectrum (Frequency Domain), I & Q versus time (Time Domain), and Spectrogram (Time versus
Frequency) graphs are available for the Generic, UWB-WiMEdia, and Radar applications. However,
the Coherent Pulse Interval is specific to the radar application.

NOTE. Once three graphs are added to Selected Graphs, the software will not allow you to add any more
graphs. You must remove a graph before you can add another graph.

To remove a graph, highlight a graph in Selected Graphs and click Remove.

3. Click OK to view the graphs. The graphs are displayed in the Graph Preview tab. If you have selected
fewer than three graphs, the other window (or windows) is empty.

You can also create graphs from the Waveform List (see page 19) as follows:

1. Select a waveform from the Waveform List.

2. Right-click to view the shortcut menu.

3. Select Show Graph and select the type of graph to generate. The graph is displayed in a large
independent window.

Graph Preview
Graph Preview is a tab in a window that is shared with Instrument Control. Click the Graph Window tab to
open it as a docked window.
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When RFXpress first launches, Graph Preview is closed by default.

Large Graph Windows
1. In the Graph Preview tab, click Maximize to view a graph in a larger window. The selected graph is

displayed in a larger window.

NOTE. When no graphs are selected, Maximize is not available.

The Zoom In and Zoom Out buttons are available in the following graphs: Spectrum, and I(t) Q(t).

Cursors, Cursor Readouts and the difference (Delta) between the cursors are available for the following
graphs: Spectrum, I(t) Q(t), and CCDF.

2. Click to close the graph and return to the small view.

Graphs from External Data
You can import data from a file (File > Import from File) and create graphs using the data. The imported
file is displayed in the Waveform List (see page 19). Select the file from the Waveform List, right-click,
and click Show Graph.

Compile Settings
Waveform > Compile Settings

To specify compilation settings for the currently active Waveform Setup, click Compile Settings. This
dialog box is displayed.
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RFXpress supports generation of two signal types. The number of waveforms generated varies depending
on the signal format selected.

Baseband signals (IQ format). When the IQ signal format is selected, two baseband waveforms I and
Q are generated. You must specify the names of each waveform.

RF signals (IF/RF format). When the RF signal format is selected, the baseband waveforms I and Q
are also generated. So after compiling, three different files are generated.

IF signals (IF+UP format). When the IF+UP signal format is selected, the output signal generated by
RFXpress is at IF frequency. The user gives RF frequency, Local oscillator frequency and the IF mode
as input. Based on this input the IF frequency is calculated and the output signal is generated at IF
frequency. This option is currently available only in Generic Signal plug-in.

For example, if the waveform name is Test, the generated waveforms are: Test_I, Test_Q, and Test.
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The Correction Files option is available only when the selected application is UWB-WiMedia and the
Compile Button Prefs option is available only when the AWG software is detected.

NOTE. The following table describes all the parameters. Not all the parameters are available in all
plug-ins.

Table 11: Compile settings options
Selection Description Range, default value
Waveform length (Symbols,
Samples) 1

Specifies the time domain length of
the resulting waveform. It can be
expressed in Samples or Symbols.

Determined by the maximum
waveform memory of the instrument.

Oversampling This is available only when Automatic
is disabled.

Automatic Automatically calculates the
oversampling based on the setup
parameters and the AWG model. To
enter the oversampling value, disable
this option.

Enabled

Signal Format
IF/RF Sets the signal format to IF/RF. N/A
IQ Sets the signal format to IQ. N/A
IF+UP Sets the signal format to IF. This

is used where an AWG is used
as an IF signal generator and an
external mixer/local oscillator is used
to upconvert IF to RF. This option is
available only in generic signal plug-in.

N/A

Oversampling 2 Specify the oversampling value. Automatic
Automatic Automatically calculates the

oversampling based on the setup
parameters and the AWG model. To
enter the oversampling value, disable
this option.

Enabled

RF Waveform Name Enter the name of the waveform to be
generated after compilation. Uses the
name entered here for the generated
RF waveform.

Waveform1

I Waveform Name Enter the name of the I waveform
to be generated after compilation.
Uses the name entered here for the
generated I waveform.

Waveform1_I

Q Waveform Name Enter the name of the Q waveform
to be generated after compilation.
Uses the name entered here for the
generated Q waveform.

Waveform1_Q

Compile Button Prefs
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Table 11: Compile settings options (cont.)

Selection Description Range, default value
Compiles and sends to Compiles the currently active

waveform setup and sends it to the
specified channel.

Ch1

Compile only Compiles the currently active
waveform setup.

N/A

Correction Files
When compiling, apply correction files
to these channels: Ch1, Ch2, Ch3,
Ch4.

Available and enabled for each
channel on the instrument. For
two-channel instruments, only Ch1
and Ch2 are visible. When a channel
is selected, the corrections are applied
from the file during compilation. If
no file exists, you are prompted to
either create a correction file in the
Calibration window, or compile without
applying correction files.

Disabled

Normalization
Mode Select the normalization mode from

the following: Auto, Manual.
You can normalize a waveform such
that all points on it lie between +1
and –1.

Auto

Division factor Enabled when the Normalization
Mode is Manual. Specify the division
factor to use to divide the waveform
values.

0.01 to 100, 1

Adjust for Wrap-Around When selected, adjusts the waveform
for wrap around during oversampling.
When cleared, the following message
appears: The signal generated from
the AWG might have wrap-around
artifacts in continuous mode.

Enabled

Overwrite waveform in list When selected, overwrites any
existing waveform of the same name
in the waveform list. When this option
is disabled, you are prompted to enter
a waveform file name.

Enabled

I Invert When selected, inverts the phase of
the I signal.

Disabled

Q Invert When selected, inverts the phase of
the Q signal.

Disabled

xxx

1 If the Waveform Length is expressed in symbols, the number of samples is approximately given by the product of the number of symbols and the
sampling rate divided by the symbol rate.

2 For IF/RF signals, the sampling rate is approximately the product of the maximum carrier frequency and the oversampling. For IQ signals, the
sampling rate is approximately the product of the anchor carrier symbol rate and the oversampling. For UWB-WiMedia signals, sampling rate is
approximately the product of the highest band group centre frequency and the oversampling.
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Click Compile to compile the waveform. A progress bar is displayed during compilation. You can abort
the compilation by clicking Cancel.

NOTE. When Adjust for Wrap-Around is enabled and the waveform length is set in samples, the symbol
rate of the compiled waveform may be close to, and not exactly the same as, the value specified in the
Setup tab. Similarly, when the waveform length is set in symbols, the carrier frequency of the compiled
waveform may be close to, and not exactly the same as, the value specified in the Setup tab.

Option Installation
System > Option Installation...

You can use the RFXpress application to generate waveforms but you cannot transfer the waveform unless
you enable the function with a option (license) key.

Click System > Option Installation.... This dialog box is displayed.
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Table 12: Option installation information
Selection Description
User Name Enter the user name.
Serial Number Enter the serial number that is provided with the software.
Option Key String Enter the option key string that is provided with the software.
Option Information The option information is displayed in the table.
xxx

Click Copy Option Info to copy the information in the table to the clipboard. Click Apply to apply the
entered values.

Overview
Window > Overview

Click Window > Overview to open the overview window. A block view of the active waveform appears
in a new window. This window is a floating window and can be moved around the screen. Each larger
grouping in the diagram corresponds to a tab.

The On/Off button in the upper right corner of each block in a block corresponds to the Turn On check
box in the appropriate group.

If the group does not have a Turn On check box, then no On/Off button appears on the block.

If the check box is cleared, the button text is Off (red), and the block appears dimmed.

If the check box is selected, the button text is On (green) and the block appears active. The button on
the block and the check box in the group box are linked; if you change one, the change is reflected in
the other. The on/off values for each block correspond to the currently selected carrier or packet group.

For a Generic signal, you must select a carrier before you select the Overview option. The Overview
window for a carrier has the following blocks:
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Setup includes Base Data, Modulation, and Filter/Window

Hopping

Power Ramping

I/Q Impairments includes Carrier Leakage, Nonlinear Distortions, I/Q Swap, Quad Error, and I/Q
Imbalance

Distortion Addition includes Amplifier Distortion

Multi-Path includes Define Path

Interference Addition includes Signal addition, Offset, Sinusoidal Interference, and Noise Interference

Subcarrier modulation

S-Parameter

Hardware Skew

NOTE. When no carriers are selected in the Carrier table, selecting Overview will open the Overview
Window with all the On/Off buttons set to Off (default). Clicking the On/Off buttons will not have any effect.

For a UWB signal, you must select a packet group before you select the Overview option. The Overview
window has the following blocks:
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Setup includes Packet Group, Packet Definitions, and Hopping

I/Q Impairments includes Carrier Leakage, Nonlinear Distortions, I/Q Swap, Quad Error, and I/Q
Imbalance

Distortion Addition includes Amplifier Distortion

Multi-Path includes Define Path

Interference Addition includes Signal Addition, Offset, Gated Noise, Sinusoidal Interference, and
Real World Signal

Hardware Skew

Clicking a block (even if dimmed) brings the File window forward with the corresponding tab at front.
Within the tab, the first setting in the group box that corresponds to the block is highlighted.

To turn on or turn off the calibration corrections, click Configure > Calibration (see page 50).

For a Radar signal, you must select a pulse before you select the Overview option. The Overview window
has the following blocks:
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Pulse includes Envelope, Amplitude Deviation, Staggered PRI, Jitter, Modulation, Hopping, and
Frequency Offset

I/Q Impairments includes Carrier Leakage, Quad Error, I/Q Imbalance, and I/Q Swap

Multi-Path

Antenna

Interference Addition includes Noise and Signal Addition

Hardware Skew

For an OFDM signal, you must select a carrier before you select the Overview option. The Overview has
the following blocks:

Basic Setup includes Base Data, Reed Solomon, Scrambler, and Convolution Encoder

Symbol Setup includes Symbol Definition and Tone Nulling

Packet Setup includes Define Packet, Hopping, and Gated Noise
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Frame Setup includes Define Frame, Multipath, and Phase Noise

Distortion Addition includes Quantization

PRBS Editor
This dialog box is displayed upon clicking PRBS Editor when PRBS is set to User Defined in the Base
Data field (Setup tab).

This data source can generate different pseudo-random binary sequences. You can select PRBS 7, PRBS 9,
PRBS 15, PRBS 16, PRBS 20, PRBS 21 and PRBS 23 in the field to the right of the PRBS button.

PRBS sequences are generated by a feedback shift register. The number (#) following PRBS indicates the
length of the generating shift register. For instance, a shift register with 16 memory cells is required to

RFXpress RFX100 User Manual 41



Operating Basics Data Source Values

generate a PRBS 16 sequence. The pseudo-random sequence of a PRBS generator is determined by the
number of registers and the feedback.

Table 13: PRBS editor options
Selection Description Default value
Use different PRBS at beginning of segment Allows you to define a PRBS polynomial

expression. The polynomial that you define
is used at the beginning of every sequence.
The value of X ranges between 1 and 31.

Disabled

Initial PRBS polynomial expression Enter an expression in the format
Xn1+Xn2+1 to add to the initial part of the
PRBS polynomial expression. The value of
Xn ranges between 1 and 31. Enabled when
Use different PRBS at beginning of segment
is disabled.

X31+X30+1

PRBS polynomial expression Enter an expression in the format
Xn1+Xn2+1 to generate the pseudo-random
sequence. The value of Xn ranges between
1 and 31.

X31+X30+1

Shift register initial value D1– D31 Enter values in the shift registers to create
the sequence. The registers D1 through D31
can take the values 0 and 1.

D1– D31

xxx

Click Apply to effect the changes. Click Reset to Default to restore the editor to the default values. Refer
to the Appendix for more information on the taps and the seed (starting values).

See also:

PRBS Editor Starting Values (see page 224)

Data Source Values
This dialog box is displayed when you set the Base Data selection to File and browse for the file. The file
formats supported are .txt and .dat. Once you select a file, the data values are taken from that file.
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The following conditions must be met for a valid file:

Any ASCII file, delimited or not, can be used as the data source.

The next bit is generated by reading the file until a 0, 1, x, or X character is found. 0 and 1 will add the
corresponding bit to the sequence; the x and X character add a new random bit.

Any other intermediate character is ignored.

When the end of the file is reached, the file is read again from the beginning based on the record length.

The data can be organized by columns or rows.

Any number of space, tab, or comma characters can be used as a delimiter.

Empty lines or invalid lines at the beginning and end of the file are ignored.

Modulation File1(Samples)
This dialog box is displayed when File1(Samples) is selected in the Modulation field (Setup tab).

RFXpress RFX100 User Manual 43



Operating Basics Modulation File1(Samples)

Table 14: Modulation File1(Samples) options
Selection Description Default value
External Select External to specify an external file taken from a specified

path.
External

Internal Select Internal to specify a file to be taken from the Waveform
List. Click the icon next to the File field and a list of waveforms
appears.

N/A

File Select the modulation file to be used by entering the path or
browsing to the file. The file formats supported are: .txt, .dat,
and .bin.

N/A

Data Org Specify the organization of data within the selected file: I/Q, Q/I, I
Only, or Q Only. When Internal is selected, the available options
are I Only and Q Only.

I Only

Format Specify the format of the selected file: ASCII, Binary(float), or
Binary(double). This option is not available when External is
selected.

ASCII

xxx

The Data Org field is used to indicate the organization of data as follows within the selected file:

I/Q. The first value of data (until a delimiter) read is considered as I and the next as Q. This will
continue to the end of the file.

Q/I. The first value of data read (until a delimiter) is considered as Q and the next as I. This will
continue to the end of the file.

I Only. All the data read are considered as I, and Q is assigned to zero.

Q Only. All the data read are considered as Q, and I is assigned to zero.

NOTE. If you have defined different files for the I and Q components, then you must define two carriers in
the list with the same basic parameters and select the corresponding component in the Data Organization
field.

The Format field is used to specify the file format. The following conditions must be met for a selected
file format:

When the file format is ASCII, the data should be in floating point precision. Spaces and tabs are
ignored. Any other characters are considered invalid. RFXpress stops reading data when it encounters
invalid data.

When the file format is Binary(float), the data should be in binary format with floating point precision.

When the file format is Binary(double), the data should be in binary format with double point precision.

When the end of the file is reached, the file is read again from the beginning, based on the Record Length.

NOTE. The external file should contain signals with average power of 1 VRMS. You should scale the data
appropriately to ensure that the file contains signals with an average power of 1 VRMS.
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Modulation File2(Symbols)
This dialog box is displayed when File2(Symbols) is selected in the Modulation field (Setup tab).

Table 15: Modulation File2(Symbols) options
Selection Description Default value
File Select the modulation file to be used by entering the path or

browsing to the file. The file formats supported are: .txt, .dat,
and .bin.

N/A

Data Org Specify the organization of data within the selected file: I/Q, Q/I,
I Only, or Q Only.

I Only

Format Specify the format of the selected file: ASCII, Binary(float), or
Binary(double).

ASCII

xxx

The Data Org field is used to indicate the organization of data as follows within the selected file:

I/Q. The first value of data read (until a delimiter) is considered as I and the next as Q. This will
continue to the end of the file.

Q/I. The first value of data read (until a delimiter) is considered as Q and the next as I. This will
continue to the end of the file.

I Only. All the data read are considered as I, and Q is assigned to zero.

Q Only. All the data read are considered as Q, and I is assigned to zero.

NOTE. If you have defined different files for the I and Q components, then you must define two carriers in
the list with the same basic parameters and select the corresponding component in the Data Organization
field.
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The Format field is used to specify the file format. The following conditions must be met for a selected
file format:

When the file format is ASCII, the data should be in floating point precision. Spaces and tabs are
ignored. Any other characters are considered invalid. RFXpress stops reading data when it encounters
invalid data.

When the file format is Binary(float), the data should be in binary format with floating point precision.

When the file format is Binary(double), the data should be in binary format with double point precision.

When the end of the file is reached, the file is read again from the beginning, based on the Record Length.

NOTE. The external file should contain signals with average power of 1 VRMS. You should scale the data
appropriately to ensure that the file contains signals with an average power of 1 VRMS.

Symbol Map
This dialog box is displayed when File3(Map) is selected in the Modulation field (Setup tab).

46 RFXpress RFX100 User Manual



Operating Basics Symbol Map

Use the symbol map editor to create user defined modulation schemes. The Symbol Map created is stored
in a binary format. This is useful for unsupported modulation schemes and to introduce impairments
with the simulated waveform.

Table 16: Symbol map options
Selection Description Range, default value
Total symbols Displays the total number of symbols

entered.
2 to 512, 4

Modulation mode Select the modulation mode: Normal,
Diff (Continuous), Diff (Alternate).
Sets the selected modulation mode.

Normal

Rotation angle Specify the rotation angle between I
and Q.

–180° to +180°, 0°

Offset modulation Indicates whether to apply offset
modulation or not: Yes, No. Selecting
Yes applies offset modulation.

No

Predefined map Causes a dropdown list to appear with
the following selections: None, BPSK,
QPSK, QAM16, QAM32, QAM64,
QAM128, and QAM256.

QPSK

Add/Edit Symbols
I component Specify the I component of the

modulation.
–100 to +100, 1

Q component Specify the Q component of the
modulation.

–100 to +100, 1

Magnitude 1 Specify the magnitude of the
modulation.

0 to 141.421, 1.414214

Phase 1 Specify the phase of the modulation. –180° to +180°, 45°
Map - Settings apply to all symbols
Offset I Specify the offset for the I component. –100 to +100, 0
Offset Q Specify the offset for the Q component. –100 to +100, 0
Rotation I/Q phase Specify the phase rotation between I

and Q.
–180° to +180°, 0°

Scale I axis (%) Specify the scale factor for the I
component.

0% to 500%, 100%

Scale Q axis (%) Specify the scale factor for the Q
component.

0% to 500%, 100%

xxx

1 The Magnitude and Phase parameters depend on the value of the I and Q components. If you change the value of the I and Q components, the
Magnitude and Phase values are recalculated and updated. Similarly, if you change the Magnitude and Phase values, the values of the I and Q
components are recalculated and updated.

Clicking Apply Offset, Apply Rotation, and Apply Phase applies the values to the Map Settings
parameters. The table is updated according to the newly applied values.
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The following buttons work as listed:

Table 17: Symbol map buttons
Selection Description
Circle... Defines a circular constellation with equal magnitude.

Opens a dialog box with the following parameters: Number
of Symbols, Radius, Phase offset.

Add Adds I, Q, Magnitude, and Phase values to the table.
Update Updates the selected row from the table.
Delete Deletes the selected row from the table.
Default Settings Clears all the symbol map information and resets to default

values. This is equivalent to opening the Symbol Map
dialog box.

Preview... Previews the table values as a plot.
Load Loads a previously saved symbol file (.smp) and displays

the values in the fields.
Save As Saves all the parameters in a user-specified file (.smp) and

location.
xxx

Circle

Click Circle to define a constellation window that allows you to create equally spaced symbols in a
circle of a specified radius. You can define an offset angle to rotate the constellation. The Circle dialog
box has the following options:

Table 18: Circle options
Selection Description Range, Default
Number of symbols Enter the number of symbols to use

while creating the constellation.
2 to 512, 4

Radius Enter the radius of the circle. –5.0 to +5.0, 1
Phase offset Enter the phase offset. –180° to +180°, 0°
Reset Phase Offset
0 degrees Select this option to set the phase

offset to zero.
Press Reset to set the phase to 0
degrees.

Selected

Half the angle between consecutive
signals

Select this option to set the phase
offset to half the angle between
consecutive signals.
Press Reset to set the phase to
half the angle between consecutive
signals.

N/A

Reset Resets the phase offset to 0 or 90
depending on the selected phase
offset.

N/A

xxx
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NOTE. The external file should contain signals with average power of 1 VRMS. You should scale the data
appropriately to ensure that the file contains signals with an average power of 1 VRMS.

Configure IF
This dialog box is displayed when selecting Configure IF in the toolbar. Configure IF is only available for
Generic signal and when IF + UP signal type is selected.

Table 19: Configure IF options
Selection Description Default value
IF Mode Specifies the IF mode. Upper Side Band, Lower

Side Band - High
side injection, Lower
Side Band - Low side
injection,
Upper Side Band

LO Frequency Specifies the frequency of the local oscillator. The local oscillator
is the external hardware used to up-convert the IF signal to an
RF signal.

0 to 30 GHz, 1 GHz

xxx

IF frequency calculation for different IF modes is base on the following equations.

Upper Side band: RF Frequency = IF Frequency + Local Oscillator Frequency

Lower Side band - High Side Injection: RF Frequency = IF Frequency – Local Oscillator Frequency

Lower Side band - Low Side Injection: RF Frequency = Local Oscillator Frequency – IF Frequency.
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Calibration for Generic, Radar, and OFDM Signals
Click Calibration from the toolbar. The Calibration Wizard opens. The wizard helps you create a
correction file that can be applied on a generated signal. The RF, IF, and IQ signals are supported and the
steps are similar.

RF calibration requires an AWG5000 or AWG7000 series instrument and an oscilloscope or RSA. Set
up the equipment as follows:

IF calibration requires an AWG5000 or AWG7000 series instrument, an oscilloscope or RSA, and devices
to change the frequency range generated by the AWG. Set up the equipment as follows:

IQ calibration requires an AWG5000 or AWG7000 series instrument, an oscilloscope or RSA, and IQ
modulator to upconvert the IQ signal to RF.
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IQ calibration can be done in one of the two ways:

Calibration using an IQ modulator. The I and Q signals generated from the AWG is upconverted to RF
using an IQ modulator. In this case, the software provides the total system calibration up to RF output.

Direct calibration. The I and Q signals generated from the AWG is directly calibrated without
upconversion.

NOTE. Direct IQ calibration can be done only on an oscilloscope.

Set up the equipment as follows:

NOTE. To calibrate the RF, IF, and IQ signals using RSA, replace the Tektronix oscilloscope with RSA.

To calibrate the signal:

1. Select and connect to an oscilloscope. A table displays a list of instruments on the network. The
instrument model, status, connection type, and instrument name (alias) are shown but they are not
editable. The following buttons are available:

Table 20: Instrument setup buttons
Button Description
Connect Connects to the instrument selected in the table and updates the status to Connected in

the table.
Disconnect Disconnects the instrument selected in the table and updates the status in the table.
Test Connection Returns the current status of the instrument selected in the table and displays the status as

Connected (in green) or Not Connected (in red).
Refresh List Refreshes the list of connected instruments.
xxx

2. Enter the AWG and calibration parameters.

For an RF signal, enter the AWG parameters like sampling rate, select the Interleave/Zeroing
modes, DAC resolution, and the channel (Ch1 or Ch2). Interleave and Zeroing (see page 221)
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Select the signal or signal image to calibrate. Calibrate the Signal Image (see page 226)

Enter frequency parameters like Start Frequency, End Frequency, Frequency Resolution, Average
iterations, and the name of the correction file.

For an IF signal, enter the AWG parameters like sampling rate, select the Interleave/Zeroing
modes, DAC resolution, and the channel (Ch1 or Ch2). Enter frequency parameters like IF Start
Frequency, IF End Frequency, Frequency Resolution, LO Frequency, and Average iterations.
Select the lower or upper side band to calibrate and enter the name of the correction file.

For an IQ signal, enter the AWG parameters like sampling rate, select the I channel and Q
channels, and enter the amplitude of the I and Q signals. Enter the Bandwidth, Baseband Offset,
Frequency Resolution, Average iterations, Carrier frequency, and the name of the correction file.

Table 21: Calibration setup options
Selection Description Range, default value
Calibration Setup
Sampling rate (samples/sec) Displays the sampling rate of the

instrument. If you change the
sampling rate, it is updated in the
instrument.

N/A

Ch1, Ch2, Ch3, Ch4 Applies corrections to the selected
channels when you click Compile.
If the corrections file is not found,
you are warned. However, you can
continue without applying calibration.

Ch1

DAC Res (bits): 8, 10 Selects the DAC resolution 8
Interleave (see page 221) Enabled if the signal type is either RF

or IF.
N/A

Zeroing Enabled only when Interleave is
available on the instrument.

N/A

Start Frequency Enter the start frequency of the signal. 10 MHz to Sampling Rate*0.49 Hz,
10 MHz

End Frequency Enter the end frequency of the signal. 10 MHz to Sampling Rate*0.49 Hz,
Sampling Rate*0.49 Hz

LO Frequency Enter the low oscillator frequency of
the signal.

N/A

Lower Side Band/Upper Side Band Select the frequency band which is to
be calibrated.

Upper Side Band

Average (iterations) Enter the number of times the software
sends and captures the signal through
the user defined configuration to
create an average.

1 to 100, 1

Frequency Resolution Enter the frequency resolution of the
signal. This is used to pick the number
of samples between start and end
frequencies.

N/A

Calibrate the Signal Select this to correct the actual signal. N/A
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Table 21: Calibration setup options (cont.)

Selection Description Range, default value
Bandwidth Enter the bandwidth of the signal. 10 MHz to Sampling rate/2, 10 MHz
Baseband Offset Enter the baseband offset of the

signal. This is the offset of the signal
from the center frequency.

0 MHz to Sampling rate/2

Carrier Frequency Enter the carrier frequency of the
signal. The carrier signal is generated
by the IQ modulator instrument.

N/A

Calibrate the Signal Image (see
page 226)

Select this to correct the image of the
signal.

Disabled

Select the correction file Browse and select the correction file.
Only one correction file (rfc) is created;
information on all the channels stored
in it.

N/A

xxx

3. Select the instrument on which to perform calibration (oscilloscope and RSA).

To perform calibration using oscilloscope, select the oscilloscope channel(s) to which the AWG
channels are connected.

4. Proceed with the calibration. When the calibration is complete, the amplitude and phase plots are
displayed.

Use the correction file in the Compile Settings dialog box to calibrate the signal.

DUT Characterization Wizard
RFXpress allows you to get the characteristics of your DUT. The DUT indicates a Mixer or Amplifier,
not receivers or IQ Modulators. From the toolbar, select Calibration > DUT Characterization. The DUT
Characterization wizard opens and guides you through the process.

DUT Characterization is a two-step process. The first step calibrates the AWG and the creates the
correction file. The second step determines the characteristics of the DUT and stores them in a file that is
later used as an input to the S-parameter feature.

To calibrate the AWG:

1. Select and connect to an oscilloscope.

2. Enter the setup parameters. Enter the AWG parameters like sampling rate, select the Interleave/Zeroing
modes, DAC resolution, and the channel (Ch1 or Ch2). Enter frequency parameters like Start
Frequency, End Frequency, Frequency Resolution, and Average iterations.

3. Select the oscilloscope channel(s) to which the AWG is connected.

4. Proceed with the calibration (see page 50).
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To determine the characteristics of the DUT:

5. Enter the DUT setup parameters. Enter the DUT Center Frequency, Upper or Lower Side Band, and
select the output file.

6. Connect the DUT between the AWG and the oscilloscope.

7. Proceed with the characterization. During DUT characterization, the correction file from the
calibration process is used to send a clean signal from AWG.

Once the characterization is complete, the wizard displays the Amplitude and Phase plots of the DUT.

Calibration for UWB-WiMedia Signal
System > Calibration

To calibrate the signal, click System > Calibration. A set of parameters called Calibration Settings are
common across channels. Channel-specific settings are provided in each channel tab. Before you start
calibration, compile your setup so that the sampling rate is automatically set in the Calibration dialog box.
You are prompted with a message to compile your setup before you proceed with calibration. If you choose
not to compile the setup, you must enter the sampling rate manually.

This dialog box is displayed. The calibration settings are as follows:
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Table 22: Instrument setup option
Selection Description Default value
Instrument Setup
Signal Type Select the signal type for calibration: RF, IF IF
xxx

The table displays a list of instruments on the network. The instrument model, status, connection type, and
instrument name (alias) are shown but they are not editable. The following buttons are available:

Table 23: Instrument setup buttons
Button Description
Connect Connects to the instrument selected in the table and updates the status to Connected in

the table.
Disconnect Disconnects the instrument selected in the table and updates the status in the table.
Test Connection Returns the current status of the instrument selected in the table and displays the status as

Connected (in green) or Not Connected (in red).
xxx
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The Calibration Settings and Channel-specific settings are as follows. All the calibration settings that are
set in RFXpress are updated on the connected instrument.

Table 24: Calibration setup options
Selection Description Range, default value
Calibration Setup
Sample rate (samples/sec) Displays the sampling rate of the

instrument. If you change the
sampling rate, the same is updated in
the instrument.

N/A

Interleave (see page 221) Enabled if the signal type is either RF
or IF.

N/A

Zeroing Enabled only when Interleave is
available on the instrument.

N/A

Band Group Select the band group of the signal
from the following options: User
defined, BandGroup1, BandGroup2,
BandGroup3, BandGroup4,
BandGroup5, and BandGroup6.
For direct RF generation, the
available options are: User Defined,
BandGroup1 and BandGroup2.

BandGroup1

Calibration Reminder Select a reminder to create calibration
files periodically: Once a day, Once a
week, Once a month, and Never.

Never

Average (iterations) Enter the number of times the software
sends and captures the signal through
the user defined configuration to
create an average.

1 to 100, 10

Generator Center Freq (MHz) Enter the center frequency for the
generated signal. This should
be same as Band Group Center
Frequency when the signal type is RF.
Enabled only for signal type IF with
the range of 800 MHz to 10 GHz. Not
available for signal types RF and IQ.

N/A

Bandgroup Center Freq (MHz) Enter the center frequency for the
user defined band group. Enabled
only when Bandgroup is set to
User Defined for RF and IQ signals in
the range of 500 kHz to 10 GHz and
for IF signals in the range of 1 GHz to
20 GHz.

N/A

Sideband: Lower, Upper Set the sideband value to the lower
or the upper limit. Enabled only for IF
signals.

Lower
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Table 24: Calibration setup options (cont.)

Selection Description Range, default value
When compiling, apply corrections to
these channels: Ch1, Ch2, Ch3, Ch4.
Bands: Band1, Band2, Band3

Applies corrections to the selected
channels and bands (within the
selected Bandgroup) when you click
Compile. If the corrections file is not
found, you are warned. However,
you can continue without applying
calibration.

N/A

Channel-specific parameters
Amplitude (Vpp) Displays the amplitude of the channel.

To change it, set a new value for the
amplitude.

N/A

Offset (V) Displays the offset of the channel.
To change it, set a new value for the
offset.

N/A

Use the same amplitude and offset for
all channels.

Uses the amplitude and offset set for
a channel for all available channels.

N/A

Select the Correction file Specify the correction file to create.
The correction file that you specify is
used when you compile the signal.

N/A

xxx

The Calibration dialog box has an option to plot each band id. The amplitude and phase plot of the
calibration file is plotted only for a valid rfc file. You can plot any of the three bands by selecting the band.

Click Calibrate to create the correction files. The correction file that is created can be used to pre-distort
the signal so that the final signal that is generated is an ideal signal.

Click OK to set the correction file and parameters that are used during compile. In Compile Settings (see
page 32) if the option "When compiling apply correction files to these channels" is selected, the correction
file specified in the Calibration dialog box is used to apply corrections.

NOTE. Interleave and Zeroing are available only on the AWG7000 series of instruments with Option 06.

Marker Mapping
This dialog box is displayed when you click Marker Mapping... in the Setup tab (UWB-WiMedia) in both
Custom and Conformance modes. The markers M1 and M2 are tightly coupled to the band ID. Marker
mapping is used to provide hopping information to the external RF hopper. The marker information is
transferred with IF/RF, I, and Q data. You can use marker information from any channel where analog
data is generated.
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You can set the following options for markers M1 and M2. The marker pattern generated, based on the
following settings, can be used for triggering an external device.

Table 25: Marker mapping options
Selection M1, M2 Description Default value
Band 1 Enter M1 and M2 values. The values

can be 0 or 1
Sets the marker pattern for Band 1 0, 1

Band 2 Enter M1 and M2 values. The values
can be 0 or 1

Sets the marker pattern for Band 2 1, 0

Band 3 Enter M1 and M2 values. The values
can be 0 or 1

Sets the marker pattern for Band 3 1, 1

Marker delay (ns) N/A Enter the marker delay in
nanoseconds. It defines the
delay in marker transition with
respect to the symbols.

Range: –312.5 to
+ 312.5 ns
Default: 0.0 ns

xxx

NOTE. The Marker Mapping dialog box shows a warning message when the AWG is set with 10-bit
DAC resolution.
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Tone Nulling
This dialog box is displayed when you click Tone Nulling... in the Setup tab (UWB-WiMedia) in both
Custom and Conformance modes. For the selected Band Group, the tone nulling table shows the carrier
number, the amplitudes, and the phases of Band 1, Band 2, and Band 3 in dB. The amplitude and phase
fields are editable. Double-click the field and enter a new amplitude for the selected carrier and band.

The amplitude values are relative to the amplitudes specified for each band. The tone nulling value ranges
between –40 dB and +20 dB. For example, if a carrier or tone value is set to –40 dB, the amplitude of
the tone is 40 dB less than that specified for the band to which it belongs. The phase value ranges from
–180 degrees to +180 degrees.

Click Default to restore the band values to their default values.
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Hopping Pattern
This dialog box is displayed when you set the TF Code and click Hopping... in the Setup tab in the Custom
Mode (UWB-WiMedia). The hopping pattern for the selected Band Group and TF Code is displayed. The
X-axis (horizontal) shows Time and the Y-axis (vertical) shows the Center Frequencies for the selected
Band Group. The hopping pattern is not editable.

To customize a hopping pattern, set the TF Code to User Defined. You can define a hopping pattern by
clicking the black squares in each column. This sets the frequency at which a packet is transmitted for
each band in a band group. After you have defined the hopping pattern, assign a TFC number (between
1 to 15) to the pattern and click OK.

Process Preferences
This dialog box is displayed when you click Process Preferences in the Setup tab (UWB-WiMedia) in
the custom mode. The dialog box displays several parameters. In the custom mode, all these parameters
can be set for each PPDU or packet listed in the PPDUs in Group table. The fields corresponding to the
parameters are editable and take either Binary or Hexadecimal values. You can change these values and
use your values when the packet is processed. When the parameters are enabled, the software uses your
values while processing the packet. When the parameters are disabled, the software uses calculated values
while processing the packet.

60 RFXpress RFX100 User Manual



Operating Basics Process Preferences

Table 26: Process preferences
Selection Description Default value
FCS If selected, processes the FCS value

set in the field. If cleared, the default
value for FCS value is used.

Enabled

HCS If selected, processes the HCS value
set in the field. If cleared, the default
value for HCS value is used.

Enabled

Reed-Solomon If selected, processes the
Reed-Solomon value set in the
field. If cleared, the default value for
Reed-Solomon value is used.

Enabled

PHY header tail bits If selected, processes the PHY header
tail bits value set in the field. If cleared,
the default value for PHY header tail
bits is used.

Enabled

Pad bits If selected, processes the Pad tail bits
value set in the field. If cleared, the
default value for Pad bits is used.

Enabled

FCS tail bits If selected, processes the FCS header
tail bits value set in the field. If cleared,
the default value for FCS header tail
bits is used.

Enabled

HCS tail bits If selected, processes the HCS tail
bits value set in the field. If cleared,
the default value for HCS header tail
bits is used.

Enabled
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Table 26: Process preferences (cont.)

Selection Description Default value
Reed-Solomon tail bits If selected, processes the

Reed-Solomon tail bits value set
in the field. If cleared, the default
value for Reed-Solomon tail bits is
used.

Enabled

Reserved bits If selected, processes the Reserved
bits value set in the field. If cleared,
the default value for Reserved bits
value is used.

Enabled

xxx

When you click Process This Packet in the custom mode, the software processes the packet and displays
the output in the fields.

Custom Settings
This dialog box is displayed when you click Rate (Selected PPDU Details) in the Setup tab
(UWB-WiMedia) in the Custom mode. It displays the custom settings that directly affect the data rate
of the selected PPDU.

The settings in the custom mode are as follows:

Table 27: Custom settings
Selection Description Default value
Modulation Select the modulation to QPSK or

DCM.
QPSK

Convolution encoder Select the convolution encoder and
set it to one of the following selections:
1/3, 1/2, 5/8, 3/4.

Enabled, 5/8
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Table 27: Custom settings (cont.)

Selection Description Default value
Interleaver Select or clear interleaver. Enabled
Conjugate symmetry Select or clear conjugate symmetry. Disabled
Time domain spreading Select or clear time domain spreading. Enabled
xxx

The following table lists the PSDU data rate-dependent modulation parameters.

Table 28: PSDU data rate-dependent modulation parameters
Data rate (Mb/s) Modulation Coding rate Conjugate

symmetry
TDS

53.3 QPSK 1/3 Yes Yes
80 QPSK 1/2 Yes Yes
106.7 QPSK 1/3 No Yes
160 QPSK 1/2 No Yes
200 QPSK 5/8 No Yes
320 DCM 1/2 No No
400 DCM 5/8 No No
480 DCM 3/4 No No
xxx

NOTE. If you select one of the standard settings that results in a standard data rate, the MAC for the data
rate takes the bits from the standard. If the setting results in a nonstandard data rate, the bit setting
is "11111".
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Frame Payload
This dialog box is displayed when you click Frame Payload (Selected PPDU Details) in the Setup tab
(UWB-WMedia) in the Custom mode.

Table 29: Frame payload options
Selection Description
Source Select the source for the data to be transmitted from the

following selections: WiMedia Spec Example, All 0, All 1,
PRBS 7, PRBS 9, PRBS 15, PRBS 16, PRBS 20, PRBS
21, PRBS 23, and From File.

File Select the file to be used by entering the path or browsing to
the file. Uses the specified file (.txt or .dat) as the source of
data to be transmitted.

Packet Data Length Displays the packet data length. Used with the payload data
length and the number of packets to calculate the data to
be sent in one packet.

xxx

The following conditions must be met for a valid file:

Any ASCII file, delimited or not, can be used as the data source.

The next bit is generated by reading the file until a 0, 1, x, or X character is found. 0 and 1 will add the
corresponding bit to the sequence while the x and X character will add a new random bit.

Any other intermediate character is ignored.

When the end of the file is reached, the file is read again from the beginning, based on the Record
Length.

The data can be organized in columns or rows.

Any number of space, tab, comma characters can be used as a delimiter.

Empty lines or invalid lines at the beginning and end of the file are ignored.
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Compile Settings for the Radar Application
Waveform > Compile Settings

To specify compilation settings for the currently active Waveform Setup, click Compile Settings. This
dialog box is displayed.

RFXpress supports generation of two signal types. The number of waveforms generated varies depending
on the signal format selected.

Baseband signals (IQ format). When the IQ signal format is selected, two baseband waveforms I and
Q are generated. You must specify the names of each waveform.

RF signals (IF/RF format). When the RF signal format is selected, the baseband waveforms I and Q
are also generated. So after compiling, three different files are generated.
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For example, if the waveform name is Test, the generated waveforms are: Test_1_I, Test_1_Q, and
Test_1_RF, where the number indicates the pulse index.

The Correction Files option is available for all applications and the Compile Button Prefs option is
available only when the AWG software is detected.

Table 30: Compile settings options for radar
Selection Description Range, default value
Compile Button Preferences
Compiles and sends to Compiles the currently active

waveform setup and sends it to the
specified channel.

Ch1

Compile only Compiles the currently active
waveform setup.

N/A

Signal Format
IF/RF Sets the signal format to IF/RF. N/A
IQ Sets the signal format to IQ. N/A
Pulse Name Enter the name of the pulse to be

generated after compilation. Uses the
name entered here for the generated
RF waveform.

Waveform1

Sampling Rate Specify the sampling rate. Automatic
Oversampling This is available only when Automatic

is disabled.
Automatic Automatically calculates the

oversampling based on the setup
parameters and the AWG model. To
enter the oversampling value, disable
this option.

Enabled

Adjust Pulse Time/Frequency
Parameters

Adjust the pulse parameters (Time
parameters or Frequency parameters)
of the signal to meet the AWG
requirements like granularity,
minimum sequence waveform length,
coherency, and so on.

Time parameters

AWG Run Mode
Continuous When selected, the application

uses the Continuous mode during
compilation.
For the AWG B-series instruments
without Option 08, the Continuous
mode is the default setting. Override
the default setting by selecting the
AWG Run Mode Option.

Enabled
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Table 30: Compile settings options for radar (cont.)

Selection Description Range, default value
Sequence When selected, the application

uses the Sequence mode during
compilation.
If Option 08 is present, by default the
application uses Sequence mode. You
can override the default by selecting
the AWG Run Mode option.

Disabled

Overwrite waveform in RFXpress list When selected, overwrites any
existing waveform of the same name
in the waveform list. When this option
is disabled, you are prompted to enter
a waveform file name.

Enabled

I Invert When selected, inverts the phase of
the I signal.

Disabled

Q Invert When selected, inverts the phase of
the Q signal.

Disabled

xxx

Click Compile to compile the waveform. A progress bar is displayed during compilation. You can abort
the compilation by clicking Cancel.

Add Pulse Groups
The Radar module allows to add two or more pulse groups. The time window of the largest pulse group
in the list will have all the pulses added together.

NOTE. Dead time is not a part of the added pulse groups.

In the radar module, click the Pulse tab and click Add Pulse Groups. This dialog box is displayed.

A table displays the pulses that make the pulse train. In the Check to add pulse column, select the pulse
groups to add together. You can use the Check All button to select all pulse groups and Uncheck All
to deselect all pulse groups.

Compile Settings for OFDM
Waveform > Compile Settings

To specify compilation settings for the currently active Waveform Setup, click Compile Settings.

RFXpress RFX100 User Manual 67



Operating Basics Compile Settings for OFDM

RFXpress supports generation of two signal types. The number of waveforms generated varies depending
on the signal format selected.

Baseband signals (IQ format). When the IQ signal format is selected, the waveforms are generated
based on various parameters. If the AWG Run mode is set to Continuous, then two or three waveforms
are generated. If phase noise and multipath are not specified, then a waveform is created for each
packet. Spacing waveforms are also generated.

RF signals (IF/RF format). When the RF signal format is selected, the baseband waveforms I and Q
are also generated. So after compiling, three different files are generated.

The Correction Files option is available for all applications and the Compile Button Prefs option is
available only when the AWG software is detected.

Table 31: Compile settings options for OFDM
Selection Description Range, default value
Signal Format
IF/RF Sets the signal format to IF/RF. N/A
IQ Sets the signal format to IQ. N/A
Waveform Name Enter the name of the pulse to be

generated after compilation. Uses the
name entered here for the generated
RF waveform.

Waveform1

Sampling Rate You can specify either the Sampling
Rate or Oversampling by disabling
Automatic.

Automatic

Oversampling This is available only when Automatic
is disabled.

Automatic Automatically calculates the
oversampling based on the setup
parameters and the AWG model. To
enter the oversampling value, disable
this option.

Enabled

Compile Button Prefs
Compiles and sends to Compiles the currently active

waveform setup and sends it to the
specified channel.

Ch1–Ch4 (depending on the
instrument)

Compile only Compiles the currently active
waveform setup.

N/A

AWG Run Mode
Continuous When selected, the application

uses the Continuous mode during
compilation.
For the AWG B-series instruments
without Option 08, the Continuous
mode is the default setting. Override
the default setting by selecting the
AWG Run Mode Option.

Enabled
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Table 31: Compile settings options for OFDM (cont.)

Selection Description Range, default value
Sequence When selected, the application

uses the Sequence mode during
compilation.
If Option 08 is present, by default the
application uses Sequence mode. You
can override the default by selecting
the AWG Run Mode option.

Disabled

Overwrite waveform in RFXpress list When selected, overwrites any
existing waveform of the same name
in the waveform list. When this option
is disabled, you are prompted to enter
a waveform file name.

Enabled

I Invert When selected, inverts the phase of
the I signal.

Disabled

Q Invert When selected, inverts the phase of
the Q signal.

Disabled

xxx

Click Compile to compile the waveform. A progress bar is displayed during compilation. You can abort
the compilation by clicking Cancel.

Reed Solomon Coding
Reed Solomon (RS) codes are a block-based error-correcting mechanism in a wide range of applications
in digital transmission and storage. The Reed Solomon encoder takes a block of data and adds extra
redundant bits. A block of Reed Solomon codes shown in the following figure consists of “K” information
symbols added by “2t” parity symbols to make an N symbol codeword. The RS decoder can correct
up to “t” symbols that contain errors in the codeword, and specified as RS(N,K). For a symbol size of
m-bits, the maximum codeword length is N=2m-1.

RFXpress uses a generic Reed-Solomon encoder, whose characteristics can be altered by modifying
the parameters. They are: Number of symbols (K), length of parity symbol (2t), number of bits per
symbol (m), primitive polynomial p(x), and the initial power of the primitive element (b). The generator
polynomial P(x) is automatically generated by RFXpress.

A Reed Solomon code is constructed by forming the code generator polynomial g(x), consisting of 2t
(or N–K) factors.
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Generator polynomial g(x)= g(x)= (x–αb) (x-αb+1 )(x–αb+2 )…… (x-αb+2t–1)

where alpha is the primitive element.

Based on the application, b can take different values, and thus starting roots with different power. The
starting value of b can be set using initial power of the primitive element which is provided as an input to
RFXpress.

To use Reed Solomon coding:

1. Click the Basic Setup tab and define the base data.

2. For each base data, you can set Reed Solomon coding. Select Reed Solomon Coding and click
Turn On. Set the following parameters:

Table 32: Reed-Solomon coding options
Selection Description Range, default value
Bits per Symbol Enter the number of bits in a symbol (m in the equation). 1 to 16, 8
Input number of
Symbols

Enter the number of symbols (K in the equation). 1 to 100000, 17

Encoded number of
Symbols

Enter the encoded number of symbols.
N, N=K+2t, where 2t is the number of parity symbols. Note the
number of parity symbols has to be even, thus N-K has to be even.

1 to 50000, 23

Primitive Polynomial Enter the primitive polynomial. None, X8+X4+X3+X2+1
Initial power of the
primitive element (b)

Enter the power (index) of the primitive polynomial. 0 to 100, 1

Generator Polynomial Displays the polynomial based on the inputs provided. X6+126X5+4X4+
158X3+58X2+49X1+117

xxx

3. Click Apply.
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Scramble Editor
You can apply scrambling on the defined data. The initial seed and the polynomial expression are required
for the scrambling to be applied.

Scramblers are used in wireless standards to randomize the bits. This is done to avoid long sequence of
ones and zeros.

1. Click the Basic Setup tab, and select Scramble Editor. Set the following parameters

Table 33: Scramble editor options
Selection Description Default value
Scramble polynomial
express

Enter an expression in the format Xn1+Xn2+1 to generate the
scramble sequence. The value of Xn ranges between 1 and 31.

X31+X30+ =0

Shift register initial value Enter values in the shift registers to create the sequence. The
registers D1 through D31 can take the values 0 and 1.

D1–D31

xxx

2. Click OK.
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Convolution Coding
The Convolution Coding dialog box is displayed when you click Frequency Hopping in the Packets
tab (OFDM).

Convolutional code is a type of error-correcting code in which:

Each m-bit information symbol (each m-bit string) to be encoded is transformed into an n-bit symbol,
where m/n is the code rate (n ≥ m). So in a 1/2 mother rate, for every bit we have two bit output.

The transformation is a function of the last k information symbols, where k is the constraint length of
the code. The number of stages k is defined in the shift register.

1. Click the Basic Setup tab, and define the base data.

2. For each base data, you can set Convolution coding. Select Convolution Coding and click Turn On.
Set the following parameters:

Table 34: Convolution coding options
Selection Description Range, default value
Constraint Enter the length of the constraint. 1 to 10, 1
Mother Rate Select from the following: 1/2, 1/3. 1/4, 1/5. 1/2
Polynomial Value (Octal) Enter the values (in Octal) in the table. The number of rows in

the table depends on the selected Mother Rate.
Puncturing Scheme Define the puncturing scheme by changing the values in the

table to 0.
xxx

Puncturing is a process of omitting some of the encoded bits in the transmitter, thereby reducing the
number of transmitted bits. This is done to obtain higher data rates.

3. Click Apply.
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Tone Nulling
The Tone Nulling dialog box is displayed when you click Tone Nulling in the Symbol tab (OFDM). For the
selected symbol, the tone nulling table shows the carrier index, the amplitude (dB), and the phase (degrees).

Click Turn On. The amplitude and phase fields are editable. Double-click the field and enter a new
amplitude for the selected carrier. The amplitude values range from –40 dB to +20 dB, with the default
at 0 dB. The phase values range from –180° to +180°, with the default at 0°. If a user-defined file is the
input (specified in User-defined Frequency Weight), the number of carriers shown depends on the I
and Q values in the file.

Frequency Hopping
The Frequency Hopping dialog box is displayed when you click Frequency Hopping in the Packets
tab (OFDM).

1. Click the Packets tab.

a. Add the number of packets required. At least one packet is present in the table by default.

b. Specify the packet parameters.

2. For each packet, you can set frequency hopping.

a. Select Frequency Hopping and click Turn On.

b. Set the following parameters:

Table 35: Frequency hopping options
Selection Description Range, default value
Start Symbol ID Enter the symbol at which to start hopping. The start symbol

cannot be greater then the end symbol.
N/A

End Symbol ID Enter the symbol at which to end hopping. N/A
Frequency Offset (±
MHz)

Enter the relative frequency at which to hop. The frequency
offset can be positive or negative.

Depends on the
instrument and options,
0 kHz

Relative Amplitude (±
dB)

Enter the relative amplitude at which to hop. The amplitude can
be positive or negative.

–60 to 0 dB, 0 dB

xxx

3. Enable Repeat frequency/amplitude hopping to repeat the frequency offset and relative amplitude
values for all the pulses. When disabled, the frequency offset and relative amplitude values are used
for only those symbols and 0 is used for all other symbols.

4. Click OK.
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Gated Noise
The Gated Noise dialog box is displayed when you click Gated Noise in the Packets tab (OFDM).

You can apply gated noise to either certain segments of the packets or through a range of symbols. You can
define a range of symbols to which to apply noise.

A negative signal-to-noise value indicates that the noise added will be greater than the signal amplitude.
Conversely, a positive signal-to-noise value indicates that the noise added will be smaller than the signal
amplitude.

1. Click the Packets tab.

a. Add the number of packets required. At least one packet is present in the table by default.

b. Specify the packet parameters.

2. For each packet, set gated noise.

a. Select Gated Noise and click Turn On.

b. Set the following parameters:

Table 36: Gated noise options
Selection Description Range, default value
Start Symbol ID Enter the symbol at which to apply noise. The start symbol

cannot be greater than the end symbol.
N/A

End Symbol ID Enter the symbol at which to end the noise. N/A
S/N (dB) Enter the signal-to-noise ratio to be applied. The value can be

positive or negative.
–60 to +60 dB, 20 dB

xxx

3. Select Repeat gated noise to repeat the S/N (signal-to-noise ratio) values for all the symbols. When
disabled, the S/N values are used for only those symbols and 0 is used for all other symbols.

4. Click OK.

Compile Settings for Environment Signals
Waveform > Compile Settings

To specify compilation settings for the currently active Waveform Setup, click Compile Settings.

RFXpress supports generation of two signal types. The number of waveforms generated varies depending
on the signal format selected:
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Baseband signals (IQ format). When the IQ signal format is selected, the waveforms are generated
based on various parameters. If AWG Run Mode is set to Continuous, then two waveforms are
generated.

RF signals (IF/RF format). When the RF signal format is selected, the baseband waveforms I and Q
are also generated. After compiling, three different files are generated.

Table 37: Compile settings options for environment
Selection Description Range, default value
Waveform length Specifies the time domain length of

the resulting waveform. It can be
expressed as Time only.

Determined by the maximum
waveform memory of the instrument

Automatic Automatically calculates the waveform
length based on the setup parameters.
To enter the waveform length, disable
this option.

Enabled

Signal Format
IF/RF Sets the signal format to IF/RF. N/A
IQ Sets the signal format to IQ. N/A
Waveform Name Enter the name of the pulse to be

generated after compilation. Uses the
name entered here for the generated
RF waveform.

Waveform1

Periodically repeat for integer
multiples only

This option works with the
Periodically Extend check box
in the configuration box for each
Environment signal element. (For
more information, see Configuring
Basic Settings (see page 167).)
If you select this option and
Periodically Extend, the waveform is
repeated X number of times (where X
is an integer) until the total duration of
the waveform is less than or equal to
the final waveform duration.

Disabled

Sampling Rate Specify either the Sampling Rate
or Oversampling by disabling
Automatic.

Automatic

Automatic Automatically calculates the sampling
rate based on the setup parameters.
To enter the sampling rate value,
disable this option.

Enabled

Compile Button Preferences
Compiles and sends to Compiles the currently active

waveform setup and sends it to the
specified channel.

Ch1–Ch4 (depending on the
instrument)

Compile only Compiles the currently active
waveform setup.

N/A
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Table 37: Compile settings options for environment (cont.)

Selection Description Range, default value
AWG Run Mode
Continuous When selected, the application uses

Continuous mode during compilation.
Continuous mode is the default
compilation mode for the Environment
plug-in.

Enabled

Sequence When selected, the application uses
Sequence mode during compilation.
Continuous mode is the default
compilation mode for the Environment
plug-in.

Disabled

Overwrite waveform in RFXpress list When selected, overwrites any
existing waveform of the same name
in the waveform list. When this option
is disabled, you are prompted to enter
a waveform file name.

Enabled

I Invert When selected, inverts the phase of
the I signal.

Disabled

Q Invert When selected, inverts the phase of
the Q signal.

Disabled

xxx

Click Compile to compile the waveform. A progress bar is displayed during compilation. You can abort
the compilation by clicking Cancel.

Radar Configure
The Radar Configure dialog box lets you configure interference parameters for a Radar signal that you add
to an Environment signal. Follow these steps to configure the signal:

1. Click Environment from the toolbar.

2. Double-click Radar in the list of signal types.

3. In the Radar configuration box, click Configure.

4. Set the following parameters:
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Table 38: Radar Configure options
Item Description Range, default value
Pulse Width Enter the pulse width. Based on the instrument

and options installed,
1 μs

Pulse Offtime Enter the offtime. Based on the instrument
and options installed,
10 μs

Pulse Repetition Enter the number of repetitions. Based on the instrument
and options installed, 1

xxx

5. To configure more advanced options for the Radar signal, click Advanced.

The advanced Radar Configure window opens. For information on this window, see Carrier Setup
(see page 135).

RFXpress RFX100 User Manual 77



Operating Basics Radar Configure

78 RFXpress RFX100 User Manual



Creating a Generic Signal Single Carrier

Single Carrier
In the Setup tab (Generic Signal) by default, Single Carrier is selected in the Carriers field. A carrier is
displayed in the carrier table and is selected. When Single Carrier is selected, you cannot add another
carrier; you must switch to Multi Carrier to add another carrier.

IF/RF Signal
When the signal type is IF/RF, the table displays the following: Carrier number, Frequency (MHz),
Amplitude (dBm), Symbol rate (MHz), Modulation, Filter, Alpha/B*T parameter, and State (ON by
default).

The Single Carrier group options show Frequency in Hz and Amplitude in dBm in 50 Ω load.

Table 39: Single carrier group options for IF/RF signal
Selection Description Range, default value
Signal type: IF/RF
Frequency (Hz) Enter the carrier frequency in Hz. Depends on the instrument bandwidth, 10M
Amplitude (dBm) Enter the amplitude of output signal in dB. –100.00 dBm to +30 dBm, 0
xxx

IQ Signal
When the signal type is IQ, the table displays the following: Carrier number, Offset (MHz), Amplitude
(VRMS), Symbol rate (MHz), Modulation, Filter, Alpha/B*T parameter, and State (ON by default).

The Single Carrier group options show Baseband Offset in Hz and Amplitude in VRMS.

Table 40: Single carrier group options for IQ signal
Selection Description Range, default value
Signal type: IQ
Baseband Offset (MHz) Enter the carrier frequency offset in Hz. Depends on the instrument bandwidth, 0
Amplitude (VRMS) Enter the amplitude of output signal in VRMS. 0 to 5 VRMS, 1
xxx
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NOTE. None of the items in the shortcut menu are available in the single carrier table.

Multi Carriers
In the Setup tab (Generic Signal), select Multi Carrier in the Carriers field. An anchor carrier is displayed
in the table. To add a carrier, in the Add Carrier field, type the number of carriers to add. The maximum
number of carriers you can have in the table is 1024. Each row in the table corresponds to one carrier. If
you try to enter more than 1024 carriers, you are reminded that the maximum number of carriers is 1024.

A signal must be repeated to obtain a continuous output for AWGs. To avoid discontinuities at the
transition between the end and the beginning of any pair of segments, the application takes care to avoid
all the “wrap-around” artifacts. For a modulated carrier, to have a signal free of wrap-around artifacts, a set
of conditions must be met by the signal:

An integer number of carrier cycles must be available in the segment for any given carrier.

An integer number of symbols must be available in the segment for any given carrier.

In general, it is difficult to meet these criteria for any given set of carriers if the record length in the target
instrument is a finite and integer number. This means that some rounding must be performed. You can
select one of the carriers as an anchor carrier to act as a reference. The application calculates the output
clock (sampling rate) to preserve some of the frequency characteristics of the anchor carrier. If record
length is expressed in samples, the carrier frequency is preserved. If record length is expressed in symbols,
the symbol rate is the preserved. The actual clock output is also influenced by the maximum carrier
frequency in the carrier table and the oversampling factor. The actual values for carrier frequencies and
symbol rates are shown in the carrier table after compilation.

NOTE. For each carrier, you can define the parameters in each of the tabs: Setup, Hopping, Power
Ramping, I/Q Impairments, Distortion Addition, Multi-Path, and Interference Addition.

IF/RF Signal
When the signal type is IF/RF, the table displays the following: Carrier number, Frequency (MHz),
Amplitude (dBm), Symbol rate (MHz), Modulation, Filter, Alpha/B*T parameter, and State (ON by
default).

Select the Base Data (see page 83) and set the Amplitude in dBm in 50-ohm load. The Multi Carrier
group options allow you add carriers based on:

Center frequency, where you must provide the Center frequency and Bandwidth.

Range, where you must provide the Base Frequency and Carrier Spacing.
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Table 41: Multi carrier group options for IF/RF signal
Selection Description Range, default value
Signal type: IF/RF
Center
Center Frequency (Hz) Enter the center frequency of the

carrier.
1 Hz to the maximum supported by
the AWG, 50 MHz

Bandwidth (Hz) Enter the bandwidth of the carrier. 1 Hz to the maximum supported by
the AWG, 100 MHz

Range
Base frequency (Hz) Enter the base frequency of the

carriers.
1 Hz to the maximum supported by
the AWG, 10 MHz

Carrier spacing (Hz) Enter the spacing between carriers. 1 Hz to the maximum supported by
the AWG, 10 MHz

Phase shift Enter the phase shift between the
carriers (degrees). Disabled when
Random is selected.

–180° to +180°, 0°

Random When selected, uses a random phase
shift value.

Disabled

xxx

IQ Signal
When the signal type is IQ, the table displays the following: Carrier number, Offset (MHz), Amplitude
(VRMS), Symbol rate (MHz), Modulation, Filter, Alpha/B*T parameter, and State (ON by default).

Select the Base Data (see page 83) and set the Amplitude in VRMS. The Multi Carrier group options allow
you to enter the Initial Offset (Hz) and Carrier Spacing (Hz).

Table 42: Multi carrier group options for IQ signal
Selection Description Range, default value
Signal type: IQ
Initial Offset (Hz) Enter the initial offset of the carriers. Depends on the instrument bandwidth
Carrier Spacing (Hz) Enter the frequency spacing between

carriers.
1 Hz to the maximum supported by
the AWG, 10 MHz

xxx

Editing Carrier Details
If you have more than one carrier and you select a carrier in the table, the Multi Carrier options change
to Selected Carrier options. You can set the options for each selected carrier. To edit carrier parameters,
highlight the carrier in the table, and then do one of the following:
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Change the values directly in the fields for the selected carrier. As you change the values in the
fields, the new values are committed immediately.

In the table, double-click the parameter that you want to change and directly enter new values. If you
select File1 (samples), File2 (Symbols) or File3 (Maps), the corresponding dialog boxes open for you to
edit the values. Changing the State to ON or OFF includes or excludes the carrier during compilation.

The Add, Delete and Set Anchor buttons work as follows:

Table 43: Carrier editing options
Selection Description State
Add Adds one or more carriers to the table. All of

the carrier parameters use default states.
Add is always enabled.

Delete Deletes the selected carrier from the table.
Select multiple carriers using the Shift or
Control keys and dragging the pointer. The
carriers are renumbered when you delete a
carrier from within the sequence.

Delete is disabled when an empty row or no
carrier is selected in the table.

Set Anchor Sets the selected carrier as the anchor carrier.
By default, the first carrier in the table is the
anchor carrier.

Set anchor is disabled when an empty row or
no carrier is selected in the table.

xxx

NOTE. When you add more than one carrier at a time, the Setup tab automatically shows options to
allow adding multiple carriers.

If you change from Multi Carrier to Single Carrier, the following message appears: The current anchor
carrier will become the single carrier. Do you want to continue? You can click Continue and make the
anchor carrier the only carrier in the single carrier mode. You can click Cancel to cancel the operation.

Edit operations are available in the shortcut menu (when you right-click a selected carrier in the table).
The available operations are: Cut, Copy, Paste, Delete, Delete All, and Set Anchor.

Table 44: Editing options in the shortcut menu
Selection Description State
Cut Cuts the current selected row

(carrier) and copies the contents to
clipboard.

Enabled when a carrier is selected.

Copy Copies the current selected row
(carrier) and copies the contents to
clipboard.

Enabled when a carrier is selected.

Paste Pastes the contents from memory
on to the selected row or carrier
(replaces the selected row).

Enabled only after a cut or copy operation.

Delete Deletes the selected row (carrier). Enabled when a carrier is selected.
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Table 44: Editing options in the shortcut menu (cont.)

Selection Description State
Delete All Deletes all the rows (carriers) in the

table.
Always enabled.

Set Anchor Sets the currently selected row’s
frequency as anchor frequency.

Enabled when a carrier is selected.

xxx

Selecting the Base Data
Follow these steps to select the base data for a signal:

1. Select the Setup tab.

2. Select a carrier from the table.

3. In the Base Data field, select the data source. The following table lists the choices for the Base Data
field:

Table 45: Multi carrier options for IF/RF signal
Selection Description Default value
Base data Select the data source from the following: All 0, All 1, PRBS, Pattern, File. PRBS
All 0 Sends a sequence of binary 0 symbols. An example is a data sequence

with the length ten {d} = {0, 0, 0, 0, 0, 0, 0, 0, 0, 0}.
N/A

All 1 Sends a sequence of binary 1 symbols. An example is a data sequence
with the length ten {d} = {1, 1, 1, 1, 1, 1, 1, 1, 1, 1}.

N/A

PRBS Select the PRBS type from the following: 7, 9, 15, 16, 20, 21, 23, and
User Defined.
To edit the bit sequence, select User Defined in the PRBS dropdown menu.
This causes the PRBS Editor… (see page 41) button to appear.

9

Pattern Enter a pattern of 0s and 1s up to a maximum of 80 digits in the text field
that appears.

N/A

File Select the base data file to be used by entering the path or browsing to
the file. The supported formats are .txt and .dat.

N/A

xxx

NOTE. If you try to compile the signal without specifying a base data file, the following message appears:
RFXpress cannot compile. You must select a file for base data first or change the selection.
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Modulation for Carriers
Follow these steps to select the modulation parameters for a signal:

1. Select the Setup tab.

2. Select a carrier from the table.

3. Set the following modulation parameters:

Table 46: Modulation options for carriers
Selection Description Range, default value
Modulation Select a modulation type from the following:

No Mod, QPSK, PI/2 QPSK, BPSK, PI/4
QPSK, OQPSK, 8-PSK, O-8PSK, QAM-16,
PI/2 QAM16, QAM-32, QAM-64, QAM-128,
QAM-256, QAM-512, QAM-1024, GMSK,
2-FSK, 4-FSK, 8-FSK, 16-FSK, 32-FSK,
ASK, AM, PM, FM, nDPSK, OOK, Pi/2
BPSK, and Gaussian Noise, File1(Samples)
(see page 43), Modulation File2(Symbols)
(see page 49), File3(Maps) (see page 46).

No Mod

FSK Peak Deviation (Hz) Enter the FSK peak deviation value. Defined
only when the modulation type is set to FSK.

Depends on the instrument bandwidth,
1000 kHz

ASK Mod Index (%) Enter the ASK modulation index. Defined
only when modulation type is set to ASK.

0 to 200%, 1%

AM Mod Index (%) Enter the AM modulation index. Defined only
when modulation type is set to AM.

0 to 200%, 50%

Phase Deviation
(degrees)

Enter the phase deviation. Defined only
when modulation type is set to PM.

0° to +180°, 10°

Phase Rotation Set the phase in degrees for the Differential
PSK Modulation. Defined only when the
modulation type is set to n-DPSK.

0° to +180°, 45°

n Set the n value of n-DPSK modulation. n can
be only power of 2.

4

Frequency
Deviation (Hz)

Enter the frequency deviation. Defined only
when modulation type is set to FM.

0 kHz to 10 GHz, 100 kHz

Coding Specify the coding parameter: None, Gray,
Differential, Gray differential, NADC, TFTS,
and MSAT. Defined when the modulation type
is set to n-DPSK, PI/2 BPSK, PI/2 QPSK,
PI/2 8-PSK, and PI/2 QAM16.

None
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Table 46: Modulation options for carriers (cont.)

Selection Description Range, default value
Symbol rate (Hz) Enter the symbol rate for modulation.

Defined when the modulation type is set to
n-DPSK, OQPSK, PI/2 BPSK, PI/2 QPSK,
PI/2 8-PSK and PI/2 QAM16.

Depends on the instrument bandwidth
Default: 1 MHz

Bandwidth Enter the bandwidth for the modulation. this
appears only when the modulation type is
Gaussian Noise.

1 Hz to 3.5 GHz, 1 MHz

xxx

When the Modulation parameter is set to File1 (Samples), Base Data, Coding and Filter parameters are
not available. The Symbol Rate parameter changes to Input File Sample Rate. When the Modulation
parameter is set to File 2 (Symbols), Base Data and Coding parameters are unavailable. When Modulation
is set to AM, FM, or PM, the Symbol Rate parameter changes to Modulating Frequency.

You can edit the Modulation parameters from the table by selecting the values in the dropdown list for
the parameter. If you select File1 (samples), File2 (Symbols), or File3 (Maps), the corresponding dialog
boxes open for you to edit the values.

NOTE. When the modulation type is Gaussian Noise, the Power Ramping, I/Q Impairments, Distortion
Addition, Multi-Path, and Interference Addition features are not available.

Filter for Carriers
Follow these steps to select the filter and window parameters for a signal:

1. Select the Setup tab.

2. Select a carrier from the table.

3. Set the following Filter/Window parameters. The Filter/Window parameters are not available when
the modulation type is Amplitude Modulation, Frequency Modulation or Phase Modulation.
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Table 47: Filter options for carriers
Selection Description Range, default value
Filter Select the filter from the following options:

Rectangular, Raised Cosine, Root Raised
Cosine, Gaussian (Dirac Delta), Gaussian
(Rectangular, Triangular, Edge), User defined,
Half-Sine, and No Filter.

No Filter

Alpha/B*T Enabled for Raised Cosine, Root Raised
Cosine, Gaussian, and Gaussian-2.

Raised Cosine: 0.0 to 1, 0.35
Root Raised Cosine: 0.0 to 1, 0.35
Gaussian Filter B*T: 0.1 to 3.0, 0.5

Convolution length
(symbols)

Enter the convolution length. Convolution length
is used to calculate the FIR filters impulse
response. To keep the pulse shape symmetric,
the convolution length has to be given in odd
number.

3 to 201, 21 (odd numbers only)

Window 1 Select the window type from the following:
None, Rectangular, Triangular, Hamming,
Hanning, Blackman, Kaiser, Blackman-Harris,
Exact Blackman, Flat Top, Tapered Cosine, and
Chebyshev Ripple.
Enabled for Raised Cosine, Root Raised
Cosine, Gaussian, Gaussian-2, Triangular, and
Edge.

None

Kaiser Parameter (dB) Enter the Kaiser parameter. Appears only when
Window is set to Kaiser.

1 to 10, 2.2

Chebyshev ripple Enter the Chebyshev Ripple. Appears only
when Window is set to Chebyshev.

10 dB to 80 dB, 40 dB

xxx

1 The window parameter is available only for Chebyshev and Kaiser Windows.
4. When Filter is set to User Defined, a dialog box appears where you can select a file. The supported file

name extensions are .txt, .dat and .bin. The Format field is used to specify the file format. Ensure
that the following conditions are met for a selected file format:

When the file format is ASCII, the data should be in floating point precision. Spaces and tabs
are ignored. Any other characters are considered invalid. RFXpress stops reading data when
it encounters invalid data.

When the file format is Binary(float), the data should be in binary format with floating point
precision.

When the file format is Binary(double), the data should be in binary format with double point
precision.

Filters must be defined with 50 samples per symbol time as the software will take care of
resampling and interpolate these values to the resolution required by any specific settings.

Filter coefficients must be in columns.

You can edit the Filter parameters from the table by selecting the values in the dropdown list for the
parameter.
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Hopping Parameters
Hopping allows you to add frequency and amplitude hopping for a selected carrier.

Follow these steps to define frequency/amplitude hopping:

1. Select a carrier and click Turn On.

2. Define the Hop Frequency parameters. Select the pattern from the following: Custom Table,
Pseudo-Random (Range), Pseudo-Random (List), and Pseudo-Random (Avoid List). The default
pattern is Custom Table.

If you select Custom Table, you must directly enter the values into the table. Click Add to add
a row to the table and edit the values. You can enter values as Absolute Frequency (MHz) or
as Frequency Offset (±MHz). The table columns change depending on the selected Hop Time
Method. You can add up to 500 hops for a carrier.

The relative amplitude takes only negative values (0 to –60 dB) and frequency offset takes positive
and negative values.

NOTE. If the hop frequency is not defined for a time interval, then the application sets the hop
frequency during that time interval to a frequency offset of 0 Hz with a relative amplitude of 0 dB.

If you select Pseudo-Random (Range), the signal will hop using the specified interval within the
frequency range specified. Enter the following:

Table 48: Hop frequency parameters for Pseudo-Random Range
Selection Description Range, default value
Minimum Frequency/Minimum
Frequency Offset

Enter the frequency range within
which to hop. Specify the start
frequency for the range.

For IF/RF: 100 Hz to the maximum
supported by the instrument and
installed options, 10 MHz
For IQ: Depends on the instrument
and installed options, –10 MHz

Maximum Frequency/Minimum
Frequency Offset

Specify the end frequency for the
range.

For IF/RF: 100 Hz to the maximum
supported by the instrument and
installed options, 100 MHz
For IQ: Depends on the instrument
and installed options, +10 MHz

Channel Spacing (Hz) Specify the minimum frequency
intervals for hopping. The signal will
hop in this interval or at multiples of
this interval.

100 Hz to (Max freq–Min Freq),
10 MHz

PRBS Select the PRBS pattern for hopping:
7, 9, 15, 16, 20, 21, 23, User-defined.

7 (default)

xxx

RFXpress RFX100 User Manual 87



Creating a Generic Signal Hopping Parameters

The signal will hop in the specified frequency range.

If you select Pseudo-Random (List), the signal will hop randomly using the frequencies specified
in the table. Click Add to add a row to the table and edit the frequency values. All frequency
values are in absolute terms.

If you select Pseudo-Random (Avoid List), the signal will avoid hopping in the frequencies
specified in the table. Click Add to add a row to the table and edit the frequency values. Enter
the following:

Table 49: Hop frequency parameters for Pseudo-Random Avoid
Selection Description Range, default value
Minimum Frequency/Minimum
Frequency Offset

Enter the frequency range within
which to hop. Specify the start
frequency for the range.

For IF/RF: 100 Hz to the maximum
supported by the instrument and
installed options, 10 MHz
For IQ: Depends on the instrument
and installed options, –10 MHz

Maximum Frequency/Minimum
Frequency Offset

Specify the end frequency for the
range.

For IF/RF: 100 Hz to the maximum
supported by the instrument and
installed options, 100 MHz
For IQ: Depends on the instrument
and installed options, +10 MHz

Channel Spacing (Hz) Specify the minimum frequency
intervals for hopping. The signal
will hop avoiding the frequencies
specified in the table in this interval
or at multiples of this interval.

100 Hz to (Max freq–Min Freq),
10 MHz

PRBS Select the PRBS pattern for hopping:
7, 9, 15, 16, 20, 21, 23, User-defined.

7 (default)

xxx

3. Define how the values are entered – Absolute Frequency (MHz) or Frequency Offset (±MHz).
Both options are available for Custom Table. Only Absolute Frequency (MHz) is available for
Pseudo-Random (List), and Pseudo-Random (Avoid List) for IR/RF signals and Frequency Offset
(±MHz) for IQ signals.

4. Define the Hop Time parameters. Select the Method from the following: Symbols per hop (fixed),
Hops per second (fixed), Symbol Index (each hop), and Time in hop (variable). All options are
available for Custom Table. Only Symbols per hop (fixed) and Hops per second (fixed) are available
for Pseudo-Random (Range), Pseudo-Random (List), and Pseudo-Random (Avoid). For the selected
method, specify the Symbols per hop (fixed) or Hops per second (fixed).
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Table 50: Hop time methods and parameters
Selection Description Range, default value
Method Select the hop time method from the

following: Symbols per hop (fixed),
Hops per second (fixed), Symbol
Index (each hop), and Time in hop
(variable).

Symbols per hop, fixed

Symbols per hop (fixed) Select this method to define the
symbols per hop.

N/A

Symbols per hop Enabled when the method is set to
Symbols per hop (fixed).

1 to 5000000, 100

Hops per second (fixed) Select this method to define the hops
per second.

N/A

Hops per second Enabled when the method is set to
Hops per second (fixed).

1 to 1000000000, 1600

Symbol Index (each hop) Provide start index in the table for
each hop.

1 to the maximum supported by the
instrument, 1

Time in hop, (variable) For each hop, enter the Time in Hop
(μsecs) in the table.

10 nsec to 1 sec, 10e-6 sec

xxx

The hop duration in each of the methods is calculated as follows.

Duration for each hop when Symbols per Hop is selected is:

Symbols per hop/Symbol rate

Duration for each hop when Hops per second is selected is:

1/Hops per second

Duration for nth hop when Symbol Index is selected is:

(Start Index(n+1)-Start Index(n))/Symbol rate

Duration for nth hop when Time in Hop is selected is:

Time in Hop(n)

Power Ramping Parameters
Power ramping allows you to define the power ramping profile for the signal to be transmitted. Follow
these steps to define power ramping for a signal:

1. Select the Power Ramping tab.

2. Select a carrier from the table.

3. Select Turn On to include power ramping parameters. (Select Turn On again to exclude power
ramping parameters for the carriers. By default, Turn On is set to off.)
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4. Set the following power ramping parameters:

Table 51: Power ramping parameters for carriers
Selection Description Range, default value
Ramp
Function Select the power ramping function

from the following: None, Linear and
Cosine.

None

Time (secs) Enter the duration of ramp. 1 ns to 1 sec, 0.1 μsec
Position
Symbol Enter the location of the power

ramping.
0 to depends on the instrument model
and option installed, 0

Level / dB Enter the level of the power ramping. –60 dB to +20 dB, 0
Periodically extended power ramping When selected, the time characteristic

of the power ramping is continued
periodically until the end of the signal.

Disabled

xxx

5. Click Add to add the power ramping parameters to the table and Delete to delete the power ramping
parameters from the table. The table contains the Symbol and Level/dB values that you entered.

Carrier Leakage for Single Carrier
Follow these steps to define carrier leakage for a signal:

1. Select the I/Q Impairments tab.

2. Select a carrier from the table.

3. Select Turn On to include carrier leakage (I and Q) impairments to the carrier. (Select Turn On again
to exclude carrier leakage (I and Q) impairments. By default, Turn On is set to off.)

4. Set the carrier leakage for I and Q modulator signal in percentage.

Table 52: Carrier leakage parameters for carriers
Selection Description Range, default value
I (%) Enter the carrier leakage for the I

signal.
–50% to +50%, 0%

Q (%) Enter the carrier leakage for the Q
signal.

–50% to +50%, 0%

xxx

Quadrature Error for Carriers
Quadrature Error allows you to control the phase angle between the I and Q signals. Follow these steps
to define quadrature error for a signal:
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1. Select the I/Q Impairments tab.

2. Select a carrier from the table.

3. Select Turn On to include quadrature error for the carrier. (Select Turn On again to exclude quadrature
error. By default, Turn On is set to off.)

4. Quadrature error is defined in degrees. A positive value indicates that the phase angle is greater
than 90 degrees. Set the following parameter:

Table 53: Quadrature error parameters for carriers
Selection Description Range, default value
Degrees Enter the phase angle between the I

and Q signals.
–30° to +30°, 0°

xxx

I/Q Imbalance for Carriers
I/Q Imbalance allows you to create gain imbalance between I and Q. Follow these steps to define I/Q
imbalance for a signal:

1. Select the I/Q Impairments tab.

2. Select a carrier from the table.

3. Select Turn On to include I/Q imbalance for the carrier. (Select Turn On again to exclude I/Q
imbalance. By default, Turn On is set to off.)

4. I/Q imbalance is defined in percentage. Set the following parameter:

Table 54: I/Q imbalance parameters for carriers
Selection Description Range, default value
Percentage Enter the imbalance between the I

and Q signals.
–30% to +30%, 0%

xxx
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Nonlinear Distortions for Carriers
Nonlinear Distortions allow you to simulate the nonlinearity of IQ modulators. Follow these steps to
define nonlinear distortions for a signal:

1. Select the I/Q Impairments tab.

2. Select a carrier from the table.

3. Select Turn On to include nonlinear distortions for the carrier. (Select Turn On again to exclude
nonlinear distortions. By default, Turn On is set to off.)

4. Set the following AM/AM and AM/PM parameters:

The variation of the signal amplitude with respect to the original amplitude is called AM/AM
conversion.

Table 55: AM/AM parameters for carriers
Selection Description Range, default value
k2 dB Enter the second order coefficient for the

magnitude.
–3 dB to +3 dB, 0 dB

k3 dB Enter the third order coefficient for the
magnitude.

–3 dB to +3 dB, 0 dB

xxx

The variation of the phase with respect to the original amplitude is called AM/PM conversion.

Table 56: AM/PM parameters for carriers
Selection Description Range, default value
k2 degrees Enter the second order coefficient for the

phase.
–30° to +30°, 0°

k3 degrees Enter the third order coefficient for the phase. –30° to +30°, 0°
xxx

See also:

Nonlinear Impairments (see page 225)
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Hardware Skew for Carriers
Hardware skew is common for all carriers. The number of channels shown depends on the AWG model
being used. Follow these steps to define hardware skew for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include hardware skew for the carrier. (Select Turn On again to exclude hardware
skew. By default, Turn On is set to off.)

3. Set the following parameters:

Table 57: Hardware skew parameter for carriers
Selection Description Range, default value
Channel N (ps) Enter a value for each channel.

Adjusting the skew dynamically
updates the dialog box display. The
adjustment applies to analog output
and marker output.

AWG7000: –100 ps to +100 ps, 0 ps
AWG5000: –5 ns to +5 ns, 0 ns

xxx

I/Q Swap for Carriers
1. Select the I/Q Impairments tab.

2. Enable I/Q Swap to interchange I and Q signal outputs.

Amplifier Distortion for Carriers
Amplifier Distortion simulates the nonlinearity in the amplifier. You can set the amplifier distortion
to Non-Linear, Hardlimiting, or Softlimiting. Hardlimiting and softlimiting amplifiers affect only the
amplitude of the output signal. The phase of the output signal is not affected.

Follow these steps to define amplifier distortion for a signal:

1. Select the Distortion Addition tab.

2. Select a carrier from the table.

3. Select Turn On to include amplifier distortion for the carrier. (Select Turn On again to exclude
amplifier distortion. By default, Turn On is disabled.)

4. Set the following parameters:
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Table 58: Amplifier distortion parameters for carriers
Selection Description Range, default value
Amplifier Select the amplifier distortion from the following: Non-Linear,

Hardlimiting, and Softlimiting.
Non-Linear

Operating point Enter the operating point of the nonlinear amplifier. 0.01 to 1000, 0.01
Limiting Level Enter the limiting level for the Hardlimiting and Softlimiting

amplifiers.
0.1 to 1000, 0.1

xxx

The following AM/AM parameters are available for a nonlinear amplifier:

Table 59: AM/AM parameters for amplifier distortion
Selection Description Range, default value
k3 (dB) Enter the third order coefficient for the magnitude. –3 dB to +3 dB, 0 dB
k5 (dB) Enter the fifth order coefficient for the magnitude. –3 dB to +3 dB, 0 dB
xxx

The following AM/PM parameters are available for a nonlinear amplifier:

Table 60: AM/PM parameters for amplifier distortion
Selection Description Range, default value
k3 (degrees) Enter the third order coefficient for the phase. –30° to +30°, 0°
k5 (degrees) Enter the fifth order coefficient for the phase. –30° to +30°, 0°
xxx

See also:

Amplifier Distortions (see page 224)

Multipath Parameters for Carriers
Follow these steps to set multipath parameters for a signal:

1. Select the Multi-Path tab.

2. Select a carrier from the table.

3. Select Turn On to define the path for the carrier. (Select Turn On again to exclude multipath
parameters. By default, Turn On is disabled.)

4. Set the following parameters:
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Table 61: Multipath parameters for carriers
Selection Description Range, default value
Delay (symbols) Enter the delay in symbols from the

reference path. The delay can be
positive or negative. The delay values
cannot be repeated.

–80 to +80 symbols, 0 symbols

Amplitude (dB) Enter the amplitude in dB from the
reference path. The amplitude is
always negative.

–60 to 0 dB, 0 dB

Phase (deg) Enter the phase in degrees from the
reference path. The phase can be
positive or negative.

–180 to +180 degrees, 0 degree

xxx

5. Click Add to add the parameters to the table. Select one or more rows and click Delete to delete it
from the table.

You can define a maximum of ten multipaths, including the reference path that has the delay, amplitude
and phase values set to zero. You can neither delete the reference path with a delay of 0 symbols nor
change the delay value. However, you can change the amplitude and phase values. No two paths can
have the same delay value. The table rows are automatically sorted in the ascending order of the delay
value. The table contains the Delay, Amplitude, and Phase that you entered.

Signal Addition for Carriers
NOTE. When the modulation type is Gaussian Noise, all the options in the Interference Addition tab
are disabled.

Follow these steps to define signal interference for a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include signal interference for the carrier. (Select Turn On again to exclude signal
interference. By default, Turn On is disabled.)

3. Set the following parameters:

Table 62: Signal addition parameters for carriers
Selection Description Default value
Format
I/Q Specifies the signal format of the file to be added. I/Q
IF/RF Specifies the signal format of the file to be added. N/A
Add Interference via:
Software Specifies that the interference addition is through software. Software
Hardware Specifies that the interference addition is through hardware. N/A
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Table 62: Signal addition parameters for carriers (cont.)

Selection Description Default value
Waveform_I Click the icon next to the Waveform_I field and a list of waveforms

appears. Select the I waveform to use.
N/A

Waveform_Q Click the icon next to the Waveform_Q field and a list of waveforms
appears. Select the Q waveform to use.

N/A

Waveform_RF Click the icon next to the Waveform_RF field and a list of waveforms
appears. Select the RF waveform to use.

N/A

xxx

When the Signal format is IQ, two interference channels are required, which means that an
AWG5000 series with four channels is required. If you do not have a 4-channel AWG, the message
appears: AWG has only X channels, cannot send interference data to channel.

When the Signal format is IF/RF, at least one channel should be available for interference, otherwise a
message appears indicating that interleave mode cannot be used.

4. If you set Add Interference via to Hardware, the interference should go to Ch2 and you need to
connect Ch1 output to Ch2 external signal addition input.

NOTE. The AWG7000 series does not support external signal addition via hardware.

Signal Addition via Software
The following table shows the combinations of the signal you want to generate after compilation and the
interference signal that you want to add.

Table 63: Valid combinations of signal addition via software
Compilation format Add signal format Remarks
IQ IQ Valid combination.
IF/RF IF/RF Valid combination.
IF/RF IQ Valid combination. I/Q interference signals

are added before modulation.
IQ IF/RF Not a valid combination.
xxx

Signal Addition via Hardware

The following table shows the combinations of the signal you want to generate after compilation and the
interference signal that you want to add.

Table 64: Valid combinations of signal addition via hardware
Compilation format Add signal format Remarks
IQ IQ Valid combination.
IF/RF IF/RF Valid combination.
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Table 64: Valid combinations of signal addition via hardware (cont.)

Compilation format Add signal format Remarks
IF/RF IQ Not a valid combination.
IQ IF/RF Not a valid combination.
xxx

Offset for Carriers
NOTE. When the modulation type is Gaussian Noise, all the options in the Interference Addition tab
are disabled.

Follow these steps to add frequency offsets to a signal:

1. Select the Interference Addition tab.

2. Select a carrier from the table.

3. Select Turn On to include frequency offsets for the carrier. (Select Turn On again to exclude frequency
offsets. By default, Turn On is set to off.)

4. Enter the frequency (in Hz) offset to add. Refer to the following table for the instrument model
and range:

Model Option Range
AWG7101, AWG7102 Standard

02/06
–5 GHz to 5 GHz
–10 GHz to 10 GHz

AWG7051, AWG7052 Standard
02/06

–2.5 GHz to 2.5 GHz
–2.5 GHz to 2.5 GHz

AWG7061B, AWG7062B Standard
02/06

–3 GHz to 3 GHz
–3 GHz to 3 GHz

AWG7121B, AWG7122B Standard
02/06

–6 GHz to 6 GHz
–12 GHz to 12 GHz

AWG5002, AWG5004,
AWG5002B, AWG5004B

Standard –300 MHz to 300 MHz

AWG5012, AWG5014,
AWG5012B, AWG5014B

Standard –600 MHz to 600 MHz

xxx
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Sinusoidal for Carriers
NOTE. When the modulation type is Gaussian Noise, all the options in the Interference Addition tab
are disabled.

Follow these steps to add sinusoidal interference to a signal:

1. Select the Interference Addition tab.

2. Select a carrier from the table.

3. Select Turn On to include sinusoidal interference for the carrier. (Select Turn On again to exclude
sinusoidal interference. By default, Turn On is set to off.)

4. Set the following parameters:

Table 65: Sinusoidal parameters for carriers
Selection Description Range, default value
C/I (dB) Enter the carrier-to-interference ratio. –40 dB to 40 dB, 20 dB
Offset from Carrier (Hz) Enter the offset from the carrier frequency. Refer to the following table for the

instrument model and range.
xxx

Model Option Range
AWG7101, AWG7102 Standard

02/06
–5 GHz to 5 GHz
–10 GHz to 10 GHz

AWG7051, AWG7052 Standard
02/06

–2.5 GHz to 2.5 GHz
–2.5 GHz to 2.5 GHz

AWG7061B, AWG7062B Standard
02/06

–3 GHz to 3 GHz
–3 GHz to 3 GHz

AWG7121B, AWG7122B Standard
02/06

–6 GHz to 6 GHz
–12 GHz to 12 GHz

AWG5002, AWG5004,
AWG5002B, AWG5004B

Standard –300 MHz to 300 MHz

AWG5012, AWG5014,
AWG5012B, AWG5014B

Standard –600 MHz to 600 MHz

xxx

Additive Noise for Carriers
NOTE. When the modulation type is Gaussian Noise, all the options in the Interference Addition tab
are disabled.
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You can simulate additive Gaussian noise by defining the noise in terms of Signal to Noise Ratio (SNR)
or bit Energy per Noise power (Eb/No). You can also define the bandwidth of the noise. A rectangular
filter of bandwidth is applied on the noise signal.

Eb/No is converted to SNR using the following equation:

SNR = Eb/No (dB) + 10 log (Symbol rate* bits per symbol/Noise Bandwidth).

Bits per symbol is based on the Modulation used for the carrier.

Follow these steps to include additive noise to a signal:

1. Select the Interference Addition tab.

2. Select a carrier from the table.

3. Select Turn On to include additive noise for the carrier. (Select Turn On again to exclude additive
noise. By default, Turn On is set to off.)

4. Select either SNR or Eb/No. Set the following parameters:

Table 66: Additive noise parameters for carriers
Selection Description Range, default value
SNR Select this to specify the signal to noise

ratio.
–40.00 dB to +40 dB, 20.00 dB

Eb/No Select this to specify the energy or Noise
power.

–40.00 dB to +40 dB, 20.00 dB

Bandwidth Enter the bandwidth of the noise to be
added.

1 Hz to the maximum supported by the
AWG, 1 MHz

xxx

NOTE. The graphs will not show the added noise.

EVM Measurement

For a given SNR or Eb/No, EVM on the RTSA can be calculated using following equation:

EVM ~= -SNR-10*log(Noise Bw/Symbol Rate)

EVM ~= -(Eb/No + 10log(symbol rate * bits per symbol/Noise bandwidth) + 10*log(Noise Bw/Symbol
Rate) )

Generating Noise from 0 to Fs/2

To generate white noise (from 0 to Sampling Rate/2) using Gaussian Noise set Carrier = Bandwidth. In the
Compile Settings dialog box, set Oversampling to 1.
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Subcarrier Modulation
You can set the sub carrier frequency and modulate the signal using AM by giving the modulation index
(in percentage) or FM by giving the frequency deviation (in Hertz) or PM by giving the phase deviation (in
degrees) as the input.

Follow these steps to specify the modulation for an already modulated signal:

1. Click the Sub-Carrier Modulation tab.

2. Select Turn On to apply modulation on the signal. (Select Turn On again if you do not want to apply
modulation. By default, Turn On is set to off.)

3. Set the following parameters:

Table 67: Subcarrier modulation parameters
Selection Description Range, default value
Modulation Select the modulation to apply: AM, FM,

or PM.
AM

Carrier frequency Enter the carrier frequency. 500 kHz to 12 GHz, 1.00000 Hz
AM Modulation index (%) Enter the AM modulation index. This field

is available only when the modulation type
is AM.

0% to 200%, 50%

Frequency deviation (Hz) Enter the frequency deviation. This field is
available only when the modulation type
is FM.

0 kHz to the maximum supported by the
instrument, 100 kHz

Phase deviation (degrees) Enter the phase deviation. This field is
available only when the modulation type
is PM.

0° to +180°, 10°

xxx

NOTE. Subcarrier modulation is not available for IQ signals.

S-Parameters
Follow these steps to specify the scattering parameter for the signal:

1. Click the S-Parameters tab.

2. Select Turn On to include the scattering parameter for the carrier. (Select Turn On again to exclude the
scattering parameter. By default, Turn On is set to off.)

3. Select the mode: Non-Cascading or Cascading. In the non-cascading mode, you can apply S-parameter
characteristics on the signal from only one S-parameter file. In the cascading mode, you can cascade
up to six S-parameter files and apply the characteristics on the signal. You can select the files to apply
them by turning on or turning off the corresponding blocks shown in the display.
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When the selected mode is cascading, all the selected files should be of the same type. The settings
depends on the selected type of file (*.s1p, *.s2p or *.s4p). The settings are common to all the files
(in cascading).

The default mode is Non-Cascading.

4. Select the bandwidth of the filter. Set it to Auto, Full Bandwidth, or Manual. In Manual, enter the
bandwidth in Hz. A bandwidth limit filter is applied to the response of the Touchstone file to limit the
bandwidth of the filter. The cutoff frequency of this bandwidth limit filter is calculated depending
on the selection.

5. Select Apply Inversion to invert magnitude and phase response given in S-parameter file. By default,
the Apply Inversion check box is disabled.

6. In the non-cascading mode, from the Read From File field, browse and select the file from which to
read the filter. The files supported are s1p, s2p, and s4p. In the cascading mode, select the files by
clicking inside the boxes and browsing to the file. Click On/Off to include or exclude the file.

7. Select the Touchstone 4-Port Data Type: Single-ended or Differential.

Files with data for four ports may contain single-ended or differential data. These are Touchstone
4-port files (s4p). By default, the application assumes the file to be single-ended data type. If the data
is single-ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21
parameter (for transmission of a differential signal) from the appropriate four S-parameters measured
using single-ended data.

8. Select the port for both transmitter and receiver from the drop-down list. Each drop-down list has ports
from 1 to 4. The default port number assignment is as follows:

Type Default port
Tx+ 1
Tx– 3
Rx+ 2
Rx– 4
xxx

9. If the data is differential, you must select the data layout in the file: Typical or Alternate. By default,
RFXpress assumes the file to use the Typical data location format.
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Conformance Mode
For a selected signal type (IF/RF or IQ), you can generate a signal in either of these modes:

Conformance Mode

Custom Mode

In the conformance mode, all packet group settings conform to those defined in the standard. However,
you can change some of the parameters for a packet group conforming to the standard.

1. In the Select Setup field, select one of the following standard setups or select My Setup to create
your own setup:

WiMedia Spec Example Packet

53.3, 80, and 106 Mbps Packets

480 Mbps Burst Mode Packets

When you change the setup selection from one standard to another selection, any changes that you
may have made are lost unless you save the setup. The following message is displayed: All altered
settings will be lost. Do you wish to continue?

However, when you change the setup selection from My Setup to another, changes to My Setup
are saved.

2. In the Add Number of Packet Groups field, type the number of packet groups to add. The maximum
number of packets is 100. Click Add to Table to add the packet group to the table. The newly added
packet group can be renamed by clicking the field and typing new text. Use the Up and Down arrow
buttons to move the packet group up or down.

Select a packet group from the table and click Delete to delete it. The subsequent packet groups
in the table are renumbered.

3. Click Marker Mapping... (see page 57) to set the marker (M1 and M2) levels to On (1) or Off (0) for
each packet group. Keeping M1 and M2 on indicate when symbols in each frequency hopping band
are being output. If the signal format is RF/IF, then M1 and M2 (of the channel where the RF/IF
signal is output) are used. If the signal format is IQ, then M1 and M2 (of the channel where the
I signal is output) are used.

Custom Mode
For a selected signal type (IF/RF or IQ), you can generate a signal in either of these modes:

Conformance Mode

Custom Mode
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In the custom mode, you can define packet parameters for a packet group. Most packet group settings are
carried from the packet group parameters defined in the conformance mode.

1. In the Select Setup field, select one of the following standard setups or select My Setup to create
your own setup:

WiMedia Spec Example Packet

53.3, 80, and 106 Mbps Packets

480 Mbps Burst Mode Packets

When you change the setup selection from one standard to another selection, any changes that you
may have made are lost unless you save the setup. The following message is displayed: All the altered
settings will be lost. Do you wish to continue?

However, when you change the setup selection from My Setup to another, changes to My Setup
are saved.

2. In the Add Number of Packet Groups field, type the number of packet groups to add. The maximum
number of packets is 100. Click Add to Table to add the packet group to the table. The newly added
packet group can be renamed by clicking the field and typing new text. The newly added packet
group will have one packet (or PPDU).

Select a packet group from the table and click Delete to delete it. The subsequent packet groups in the
table are renumbered. Use the Up and Down arrow buttons to move the packet group up or down.

For a selected packet group, the packets or PPDUs are displayed in a table.

3. In the Add Number of Packets field, type the number of packets to add. The maximum number of
packets in a packet group is 30. Click Add to Table to add the packets to the table. Use the Up and
Down arrow buttons to move the PPDUs up or down.

For a selected packet, the PPDU details (see page 110) are displayed graphically. You can set or edit
these values, process a selected packet, or set process preferences.

4. Click Marker Mapping... (see page 57) to set the marker (M1 and M2) levels to On (1) or Off (0) for
each packet group. Keeping M1 and M2 on indicate when symbols in each frequency hopping band
are being output. If the signal format is RF/IF, then M1 and M2 (of the channel where the RF/IF
signal is output) are used. If the signal format is IQ, then M1 and M2 (of the channel where the
I signal is output) are used.

5. Click Restore All to Compliance to restore all the settings as set in the conformance mode.

6. Click Process Preferences (see page 60) to set the processing preferences for the selected packet.

NOTE. When you switch to the Custom mode, settings from the Conformance mode are carried over. If you
switch back to Conformance mode, the settings are the same as when you left the Conformance mode.
All the custom mode settings are lost.
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Packet Group Details for Conformance Mode
The packet group details in the conformance mode are as follows:

Table 68: Packet group details for conformance mode
Selection Description Range, default value
Repeat this group (times) Enter the number of times the group

is repeated.
1 to 100, 1

Group start delay (symbols) Enter the delay in symbols at the start
of a group.

0 to 200, 32 symbols

Group end delay (symbols) Enter the delay in symbols at the end
of a group.

0 to 200, 0 symbols

Number of packets in group Enter the number of packets in a
group. The maximum number is
limited by the memory size of AWG
that is the number of samples. This
depends on the oversampling, signal
format (RF or IQ) and the center
frequency.

1 to 30, 1
The maximum number is limited by
the memory size of AWG (the number
of samples). The number of samples
depends on the oversampling, signal
format (RF or IQ) and the center
frequency.

Spacing between packets Enter the distance between the
packets to the specified value in
symbols, pMIFS, or pSIFS. The value
defines the time between packets.

Standard Mode: 6 to 200, 6 symbols
Burst Mode: 6 symbols
If Payload length is zero, the Packet
separation is fixed to 32 symbols (1
pSIFS).

Payload data source Enter the source for the packet group
from the following selections: WiMedia
Spec Example, All 0 (Zeros), All 1
(Ones), PRBS 7, PRBS 9, PRBS 15,
PRBS 16, PRBS 20, PRBS 21, PRBS
23, and User Defined.

WiMedia Spec Example

File Select the payload data file (.txt or
.dat) to be used by entering the path
or browsing to the file. Enabled when
payload data source is set to User
Defined.

N/A

xxx

Click Tone Nulling (see page 73) to set the amplitudes for the bands in each packet group.
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The following conditions must be met for a valid file:

Any ASCII file, delimited or not, can be used as the data source.

The next bit is generated by reading the file until a 0, 1, x, or X character is found. 0 and 1 will add the
corresponding bit to the sequence; the x and X character will add a new random bit.

Any other intermediate character is ignored.

When the end of the file is reached, the file is read again from the beginning, based on the Record
Length.

The data can be organized in columns or rows.

Any number of space, tab, or comma characters can be used as a delimiter.

Empty lines or invalid lines at the beginning and end of the file are ignored.

NOTE. When a packet group is repeated many times, the end delay of one packet group and the start
delay of the next packet group are added.

NOTE. If Payload length is zero, the Packet separation is fixed to 32 symbols (1 pSIFS).

Packet Details for Conformance Mode
The packet details in the conformance mode are as follows:
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Table 69: Packet details for conformance mode
Selection Description Default value
MAC header Select the MAC header type from the

following: WiMedia Spec Example, All
Zeros, All Ones, PRBS 7, PRBS 9,
PRBS 15, PRBS 16, PRBS 20, PRBS
21, PRBS 23, User Defined Data (in
Hex), and User Defined File.

The maximum length of the MAC
header is 10 bytes. If you enter
values less than 10 bytes, the rest are
padded with zeros.
A user specified file has the path
C:\Program Files\Tektronix\RFX-
press\System\Samples\Mac.txtby
default.

Data (HEX) Enter the MAC Header data in
hexadecimal. Enabled when MAC
Header is set to User Defined Data
(in Hex).

Maximum length is 10 bytes.

Packet mode Select the transmission mode for the
packet from the following: Standard,
Burst.

The default value depends on the
selected setup.

Data rate (Mbps) Select the data rate for the packet
from the following: 53.3, 80, 106.7,
160, 200, 320, 400, and 480 Mbps.

The default value depends on the
selected setup.

Preamble type Select the preamble type from
the following: Standard, Burst. A
Standard preamble has 24 symbols
and a Burst preamble has 12 symbols.

When the Packet mode is set to
Standard, the preamble type is always
Standard.
When the Packet mode is set to Burst
and the data rate ≤200 Mbps, the
preamble type is always Standard.
When the Packet mode is set to
Burst and the data rate > 200 Mbps,
preamble type can be Standard or
Burst.

Packet size (bytes) Enter the size of the packet in bytes. Standard Mode: 0 to 4095
Burst Mode: 1 to 4095
The default values depend on the
selected setup.

xxx

NOTE. If Payload length is zero, the Packet separation is fixed to 32 symbols (1 pSIFS).

A user defined file must meet the following conditions:

Input files are ASCII files with .txt extension.

The data should contain hexadecimal values and arranged in a single row (with no spaces or tabs).
Any other characters are invalid (including tab and space). The application stops reading data when it
encounters invalid data.

The maximum length of the file is 600 hex characters.
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Hopping Details for Conformance Mode
The hopping details in the conformance mode are as follows:

Table 70: Hopping details for conformance mode
Selection Description Range, default value
Band group Select a band group from the

following: BandGroup 1, BandGroup
2, BandGroup 3, BandGroup 4,
BandGroup 5, and BandGroup 6. Sets
the band group to use for transmission
for the select packet or PPDU.

1 to 6. The default values depend on
the quick setup selected. For a newly
added packet group, the default value
is 1.

TF code Select the TF code from the following:
TFC 1, TFC 2, TFC 3, TFC 4, TFC
5, TFC 6, TFC 7, TFC 8, TFC 9, and
TFC 10. Sets the time frequency code
to use to define the hopping sequence
of the packet group.

1 to 10. The default values depend on
the quick setup selected. For a newly
added packet group, the default value
is 1.

Band group center frequency (MHz) Displays the center frequency for
the selected band group. You can
change the center frequency to your
requirement.

The center frequency is restricted
by the sampling rate set for the
instrument and oversampling.

xxx
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For a selected combination of Band Group and TF Code, the software displays the channel number. For
example, for Band Group 4 and TFC 8, the channel number is 96. The hopping pattern is dynamically
shown in the Time Vs Centre frequency table. The hopping pattern is as shown:

Packet Group Details for Custom Mode
The packet group settings in the custom mode are as follows:

Table 71: Packet group details for custom mode
Selection Description Range, default value
Repeat this group (times) Enter the number of times the group

is repeated.
1 to 100

Group start delay (symbols) Enter the delay in symbols at the start
of a group.

0 to 200 symbols, 32

Group end delay (symbols) Enter the delay in symbols at the end
of a group.

0 to 200 symbols, 0

Number of packets in group Enter the number of packets in a
group.

1 to 100
The maximum number is limited by
the memory size of AWG (the number
of samples). The number of samples
depends on the oversampling, signal
format (RF or IQ) and the center
frequency.

Spacing between packets (symbols) Enter the distance between the
packets to the specified value in
symbols, pMIFS, or pSIFS. Indicates
the time between packets.

Standard Mode: 6 to 200, 6 symbols.
Burst Mode: 6 symbols.
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Table 71: Packet group details for custom mode (cont.)

Selection Description Range, default value
Band group Select a band group from the

following: BandGroup 1, BandGroup
2, BandGroup 3, BandGroup 4,
BandGroup 5, and BandGroup 6. Sets
the band group to use to transmit the
selected packet or PPDU.

N/A

TF code Select the TF code from the following:
User defined, TFC 1, TFC 2, TFC
3, TFC 4, TFC 5, TFC 6, TFC 7,
TFC 8, TFC 9, and TFC 10. Sets
the time frequency code to use to
define the hopping sequence of the
packet group. For Band Group 5, the
selections are TFC 5, TFC 6, TFC 8,
and User Defined.

When User defined TFC is selected,
you can set your own hopping pattern
with TFC number ranging between 0
to 15. For standard TFCs, TFC 1 to
TFC 10, the hopping sequence cannot
be changed.

No hopping Select this option to generate signals
for the selected TF code without
hopping. However, markers still
continue to hop based on the TFC
pattern.

Disabled

Band group center frequency (MHz) Displays the center frequency for
the selected band group. You can
change the center frequency to your
requirement. The changed frequency
is updated in the Hopping Pattern
dialog box.

N/A

xxx

NOTE. When a packet group is repeated many times, the end delay of one packet group and the start
delay of the next packet group are added.

NOTE. If you change the TF Code, the change is not reflected in the Packet Sync Sequence (Base Time
Domain Sequence and the Cover Sequence).

When the TF Code is set to User Defined, the Hopping Pattern (see page 60) dialog box is displayed.
You can define the hopping pattern by clicking on the frequency bands. Assign a TFC number for the
pattern and click OK to save the hopping pattern.

Setting PPDU Details
The packet parameters for a selected packet are displayed graphically.
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For a packet, you can set the PLCP Preamble (see page 111), PLCP Header (see page 112) and PSDU (see
page 113) parameters. Many parameters have either a dropdown list to select values from, or a text box to
enter values (in hexadecimal or binary). Other parameters open the next level of choices or a dialog box.

Click Process Preferences (see page 60) to set your preferences for the selected parameters. When you
select a particular parameter in the process preferences, your input for that parameter is used (instead of
the computed values).

When you clear a particular parameter in the process preferences, your input for that parameter is ignored.
The software will use the computed values.

You can include the PLCP Header and PSDU while processing the packet. By default they are enabled. To
exclude the PLCP Header, disable it. The resulting packet after processing will not include PLCP Header
information. Similarly, to exclude the PSDU, disable it. The resulting packet after processing will not
include PSDU Header information. Both you disable both, then resulting packet will not include PLCP
Header and PSDU Header information.

When you click Process This Packet, the PPDU frame is formed according to your preferences. After
processing, the packet value is displayed at the lower end of the box.

PLCP Preamble
You can view the PLCP Preamble parameters by clicking the + sign in the PLCP box. The following
options can be set the PLCP Preamble parameters:

Table 72: PLCP preamble options for custom mode
Selection Displays
Packet Sync Sequence (see page 114) Opens a dialog box with two tabs: Base Time Domain

Sequence and Cover Sequence.
Channel Estimation Sequence Displays the default channel estimation sequence value.

Enter a value between 1 and 1000.
xxx
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PLCP Header
You can choose whether to include the PLCP Header in the packet. Select the check box to include the
PLCP Header in the packet. Clear the check box to exclude the PLCP Header in the packet.

The following options are available to set the PLCP Header parameters:

Table 73: PLCP header options for custom mode
Selection Displays Default value
PHY Header (see page 117) Displays a set of parameters. N/A
Tail Bits Displays the current value of the tail

bits. Use the text box to set another
value.

000000 bits

MAC Header (see page 118) Opens a dialog box where you can set
there MAC Header from the following:
WiMedia Spec Example, All Zeros, All
Ones, PRBS 7, PRBS 9, PRBS 15,
PRBS 16, PRBS 20, PRBS 21, PRBS
23, User Defined Data (in Hex), and
User Defined File.

The maximum length of the MAC
header is 10 bytes. If you enter
values less than 10 bytes, the rest are
padded with zeros.
The Mac header can be set for
individual packets by giving separate
files.

HCS Displays the current HCS value.
HCS is either a calculated value or is
determined by the inputs. Use the text
box to set another value.

HCS depends on Non-Scrambled
MAC Header and PHY Header.

Tail Bits Displays the current value of the tail
bits. Use the text box to set another
value.

000000 bits

Reed-Solomon Parity Bits Displays the current value of
the Reed-Solomon Parity bits.
Reed-Solomon Parity is either a
calculated value or is determined by
the inputs. Use the text box to set
another value.

Reed-Solomon Parity bits depends
on Scrambled MAC Header+ HCS +
PHY Header.

Tail Bits Displays the current value of the tail
bits. Use the text box to set another
value.

0000 bits

xxx

You can set the following parameters in Process Preferences (see page 60) to take your input: Tail Bits,
HCS Tail Bits, Reed Solomon Parity Bits, and Tail Bits.
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A user defined file MAC header must meet the following conditions:

Input files are ASCII files with .txt extension.

The data should be hexadecimal values and arranged in a single row (with no spaces or tabs). Any
other characters are invalid (including tab and space). The application stops reading data when it
encounters invalid data.

The maximum length of the file is 600 hex characters.

PSDU
You can choose whether to include the PSDU in the packet. Select the check box to include the PLCP
Header in the packet. Clear the check box to exclude the PSDU in the packet.

The following options are available to set the PSDU. PSDU is enabled only if the Length field in PHY
header is not zero.

Table 74: PSDU options for custom mode
Selection Displays
Frame Payload Displays the current value of the frame payload (data

source). Click within the box to open a dialog box where
you can choose the payload data source from the following:
WiMedia Spec Example, All Zeros, All Ones, PRBS 7,
PRBS 9, PRBS 15, PRBS 16, PRBS 20, PRBS 21, PRBS
23, and User Defined.

File Select the payload data file (.txt or .dat) to be used by
entering the path or browsing to the file. Enabled when
payload data source is set to User Defined.

FCS Displays the current value of the FCS. Use the text box to
set another value. FCS is either a calculated value or is
determined by the inputs. FCS is calculated on the Payload
data.

Tail Bits Displays the current value of the tail bits. Use the text box
to set another value.

Pad Bits Displays the current value of the pad bits. Use the text box
to set another value.

xxx

You can set the following parameters in Process Preferences (see page 60) to take your input: FCS,
Tail Bits, and Pad Bits.

The length of payload for each packet is taken from the Length field in the PHY header.
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Packet Sync Sequence
The Packet Sync Sequence dialog box has two tabs: Base Time Domain Sequence and Cover Sequence.
The Packet Sync File consists of the Base time domain sequence. It consists of 128 values, which are
used as the preamble.
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The parameters that can be set are as follows:

Table 75: Packet sync sequence parameters for custom mode
Selection Displays Default value
Base Time Domain Sequence
TF Code Select the TF Code from the following

selections: User defined, TFC 1 (Normal),
TFC 2 (Normal), TFC 3 (Normal),
TFC 4 (Normal), TFC 5 (Normal),
TFC 6 (Normal), TFC 7 (Normal),
TFC 8 (Normal), TFC 9 (Normal),
TFC 10 (Normal), TFC 1 (Alternate),
TFC 2 (Alternate), TFC 3 (Alternate),
TFC 4 (Alternate), TFC 5 (Alternate),
TFC 6 (Alternate), and TFC 7 (Alternate).
If you set the TF code to User Defined, browse
and select the file from which to take values.

TFC 1 (Normal)

Cover Sequence
TF Code Select the TF Code from the following

selections: User defined, TFC 1, TFC 2, TFC 3,
TFC 4, TFC 5, TFC 6, TFC 7, TFC 8, TFC 9,
and TFC 10.
When you set the TF code to User Defined, you
can set the total synchronization length.

TFC 1
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Table 75: Packet sync sequence parameters for custom mode (cont.)

Selection Displays Default value
Preamble type Select the preamble type: Standard or Burst.

Depending on the preamble type, the index will
change to 24 or 12.

Standard

Total synchronization sequence length Displays the value of the synchronization
sequence length. For Standard Preamble,
the synchronization length is 24 and for Burst
Preamble the synchronization length is 12. If
you set the TF Code to User Defined, you can
set the synchronization value between 1 and
24.

1 to 24, 1

xxx

The Alternate TFC information is available in Appendix D of the latest release of MultiBand OFDM
Physical Layer Specification.

NOTE. The number of symbols in the time domain synchronization sequence is equal to the length of the
cover sequence.

The Time Domain Sequence table displays the Index and standard SBase values for the selected TF Code.
You can double-click the SBase value in any row and edit it. When the TF Code is set to User Defined,
you must specify a file from which to take data.

The following conditions must be met for a valid file:

The file name extensions are .txt and .dat. The file consists of the Base Time Domain sequence
of 128 values which are used as the preamble.

Time domain sequence values must be stored in columns. The file with the Base Time Domain
sequence should contain 128 data values. If the file contains more than 128 values, the other values are
ignored. If it contains less than 128 values, zeros are added to make up the 128 values.

The data should be in floating point precision. Spaces and tabs are ignored. Any other characters,
including blank lines, are considered invalid. RFXpress stops reading data when it encounters invalid
data.

The Cover Sequence table displays the Index and standard SCover values for the selected TF Code. You
can double-click the SCover value in any row and edit it. The total sequence synchronization length is
displayed. When the values are taken from an ASCII file, if file contains more than 128 values, the
rest are ignored.

Click Reset to Default to restore the SCover and SBase values to their default values.
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PHY Header
The PHY Header parameters that can be set are as follows:

Table 76: PHY header parameters for custom mode
Selection Displays
Rsvd Displays the current value in the text box. Use this box to

set another value.
Rate (see page 62) Displays the data rate of the PHY header. Click Rate to

display a dialog box to set the Modulation to DCM or QPSK,
Convolution Encoder to 1/3, 1/2, 5/8, or 3/4, Interleaver,
Conjugate Symmetry, and Time Spreading.

Length Displays the length of the PHY header in bytes between 0
to 4095. Use this field to set another length.

Rsvd Displays the current value in the text box. Use this box to
set another value.

Scrambler INIT Displays the initial value for scrambling. To change this,
select from Seed 00, Seed 01, Seed 10, and Seed 11.

Rsvd Displays the current value in the text box. Use this box to
set another value.

Burst Mode Displays the Burst Mode for the next packet. In each
packet, the next packet can be configured to: Standard and
Burst. The first packet is always Standard.

Preamble Type Displays the Preamble Type. To change this, select from
Standard and Burst.

TX TFC Displays the TX TFC number.
Band Group Displays the Band Group.
Rsvd Displays the current value in the text box. Use this box to

set another value.
xxx

You can set the Rsvd bits in Process Preferences (see page 60) to take your input.
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MAC Header
This dialog box is displayed when you click MAC Header (Selected PPDU Details) in the Setup tab
(UWB-WiMedia) in the Custom mode. The MAC Header parameters that can be set are as follows:

Table 77: MAC header parameters for custom mode
Selection Displays Default value
MAC Header Displays the default MAC Header. To

change this, select from the following:
WiMedia Spec Example, All Zeros, All
Ones, PRBS 7, PRBS 9, PRBS 15,
PRBS 16, PRBS 20, PRBS 21,
PRBS 23, and User Defined Data (in
Hex).

The maximum length of the MAC
header is 10 bytes. If you enter
values less than 10 bytes, the rest are
padded with zeros.

Field Enter the MAC Header data in
hexadecimal. Enabled when MAC
Header is set to User Defined Data
(in Hex).

D3C2368C8F360DBBEDBA

xxx
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Carrier Leakage for UWB-WiMedia
Follow these steps to define carrier leakage for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include carrier leakage (I and Q) impairments to a packet group. (Select Turn On
again to exclude carrier leakage (I and Q) impairments. By default, Turn On is disabled.)

3. Set the carrier leakage for I and Q modulator signal in percentage.

Table 78: Carrier leakage parameters for UWB-WiMedia
Selection Description Range, default value
I (%) Enter the carrier leakage for the I

signal.
–50% to +50%, 0%

Q (%) Enter the carrier leakage for the Q
signal.

–50% to +50%, 0%

xxx

Quadrature Error for UWB-WiMedia
Quadrature Error allows you to control the phase angle between the I and Q signals. Follow these steps
to define quadrature error for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include quadrature error for a packet group. (Select Turn On again to exclude
quadrature error. By default, Turn On is disabled.)

3. Quadrature error is defined in degrees. A positive value indicates that the phase angle is greater
than 90 degrees. Set the following parameter:

Table 79: Quadrature error parameters for UWB-WiMedia
Selection Description Range, default value
Degrees Enter the phase angle between the I

and Q signals.
–30° to +30°, 0°

xxx
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I/Q Imbalance for UWB-WiMedia
I/Q Imbalance allows you to create gain imbalance between I and Q. Follow these steps to define I/Q
imbalance for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include I/Q imbalance for a packet group. (Select Turn On again to exclude I/Q
imbalance. By default, Turn On is disabled.)

3. I/Q imbalance is defined in percentage. Set the following parameter:

Table 80: I/Q imbalance parameters for UWB-WiMedia
Selection Description Range, default value
Percentage Enter the imbalance between the I

and Q signals.
–30% to +30%, 0%

xxx
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Nonlinear Distortion for UWB-WiMedia
Nonlinear Distortions allow you to simulate the nonlinearity of IQ modulators. Follow these steps to
define nonlinear distortions for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include nonlinear distortions for a packet group. (Select Turn On again to exclude
nonlinear distortions. By default, Turn On is disabled.)

3. Set the following AM/AM and AM/PM parameters:

The variation of the signal amplitude with respect to the original amplitude is called AM/AM
conversion.

Table 81: AM/AM parameters for UWB-WiMedia
Selection Description Range, default value
k2 dB Enter the second order coefficient for

the magnitude.
–3 dB to +3 dB, 0 dB

k3 dB Enter the third order coefficient for the
magnitude.

–3 dB to +3 dB, 0 dB

xxx

The variation of the phase with respect to the original amplitude is called AM/PM conversion.

Table 82: AM/PM parameters for UWB-WiMedia
Selection Description Range, default value
k2 degrees Enter the second order coefficient for

the phase.
–30° to +30°, 0°

k3 degrees Enter the third order coefficient for the
phase.

–30° to +30°, 0°

xxx

See also:

Nonlinear Impairments (see page 225)
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Hardware Skew for UWB-WiMedia
The number of channels shown depends upon the AWG being used. Follow these steps to define hardware
skew for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include hardware skew for a packet group. (Select Turn On again to exclude
hardware skew. By default, Turn On is disabled.)

3. Set the following parameters:

Table 83: Hardware skew parameters for UWB-WiMedia
Selection Description Range, default value
Channel N (ps) Enter a value for each channel.

Adjusting the skew dynamically
updates the dialog box display. The
adjustment applies to analog output
and marker output.

AWG7000: –100 ps to +100 ps, 0 ps
AWG5000: –5 to +5 ns, 0 ns

xxx

I/Q Swap for UWB-WiMedia
1. Select the I/Q Impairments tab.

2. Enable I/Q Swap to interchange I and Q signal outputs.

Amplifier for UWB-WiMedia
Amplifier Distortion simulates the nonlinearity in the amplifier. You can set the amplifier distortion
to Non-Linear, Hardlimiting, or Softlimiting. Hardlimiting and softlimiting amplifiers affect only the
amplitude of the output signal. The phase of the output signal is not affected.

Follow these steps to define amplifier distortion for a signal:

1. Select the Distortion Addition tab.

2. Select a carrier from the table.

3. Select Turn On to include amplifier distortion for a packet group. (Select Turn On again to exclude
amplifier distortion. By default, Turn On is disabled.)

4. Set the following parameters:

122 RFXpress RFX100 User Manual



Creating a UWB-WiMedia Signal Multipath Parameters for UWB-WiMedia

Table 84: Amplifiers parameters for UWB-WiMedia
Selection Description Range, default value
Amplifier Select the amplifier distortion from the following: Non-Linear,

Hardlimiting, and Softlimiting.
Non-Linear

Operating point Enter the operating point of the nonlinear amplifier. 0.01 to 1000, 0.01
Limiting Level Enter the limiting level for the Hardlimiting and Softlimiting

amplifiers.
0.1 to 1000, 0.1

xxx

The following AM/AM parameters are available for a nonlinear amplifier:

Table 85: AM/AM parameters for UWB-WiMedia
Selection Description Range, default value
k3 (dB) Enter the third order coefficient for the magnitude. –3 dB to +3 dB, 0 dB
k5 (dB) Enter the fifth order coefficient for the magnitude. –3 dB to +3 dB, 0 dB
xxx

The following AM/PM parameters are available for a nonlinear amplifier:

Table 86: AM/PM parameters for UWB-WiMedia
Selection Description Range, default value
k3 (degrees) Enter the third order coefficient for the phase. –30° to +30°, 0°
k5 (degrees) Enter the fifth order coefficient for the phase. –30° to +30°, 0°
xxx

See also:

Amplifier Distortions (see page 224)

Multipath Parameters for UWB-WiMedia
Follow these steps to set multipath parameters for a signal:

1. Select the Multi-Path tab.

2. Select Turn On to define the path. (Select Turn On again to exclude multipath parameters. By default,
Turn On is disabled.)

3. Set the following parameters:
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Table 87: Multipath parameters for UWB-WiMedia
Selection Description Range, default value
Delay (symbols) Enter the delay in symbols from the

reference path. The delay can be
positive or negative. The delay values
cannot be repeated.

–2 to +2 symbols, 0 symbols

Amplitude (dB) Enter the amplitude in dB from the
reference path. The amplitude is
always negative.

–60 to 0 dB, 0 dB

Phase (deg) Enter the phase in degrees from the
reference path. The phase can be
positive or negative.

–180 to +180 degrees, 0 degree

xxx

4. Click Add to add the parameters to the table. Select a row and click Delete to delete it from the table.

You can define a maximum of ten multipaths, including the reference path that has the delay, amplitude
and phase values set to zero. You can neither delete the reference path with a delay of 0 symbols nor
change the delay value. However, you can change the amplitude and phase values. No two paths can
have the same delay value. The table rows are automatically sorted in the ascending order of the delay
value. The table contains the Delay, Amplitude, and Phase that you entered.

Depending on the entered delay value, the application might have to recompute the convolution length.
This happens if convolution length provided is not enough for the given multipaths. In this case, the
following message appears: Convolution length will be adjusted to take care of multipaths. Do you
want to adjust? You can choose to adjust or not adjust the convolution length.

Multipath is created by applying the right algorithm to the baseband I and Q signals. The application
generates a new complex isolated pulse by convolving the direct isolated pulse and the channel impulse
response (it is a complex impulse response at the baseband level). This implies that to have the right
convolution, the total length of the resulting process must be long enough to accommodate the new
isolated pulse.

Signal Addition for UWB-WiMedia
Follow these steps to define signal interference for a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include signal interference for a packet group. (Select Turn On again to exclude
signal interference. By default, Turn On is disabled.)

3. Set the following parameters:

Table 88: Signal addition parameters for UWB-WiMedia
Selection Description Default value
Format
I/Q Specifies the signal format of the file to be added. I/Q
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Table 88: Signal addition parameters for UWB-WiMedia (cont.)

Selection Description Default value
IF/RF Specifies the signal format of the file to be added. N/A
Add Interference via:
Software Specifies that the interference addition is through software. Software
Hardware Specifies that the interference addition is through hardware. N/A
Waveform_I Click the icon next to the Waveform_I field and a list of waveforms

appears. Select the I waveform to use.
N/A

Waveform_Q Click the icon next to the Waveform_Q field and a list of
waveforms appears. Select the Q waveform to use.

N/A

Waveform_RF Click the icon next to the Waveform_RF field and a list of
waveforms appears. Select the RF waveform to use.

N/A

xxx

When the Signal format is IQ, two interference channels are required, which means that an
AWG5000 series with four channels is required. If you do not have a 4-channel AWG, then the
warning message appears: AWG has only X channels, cannot send interference data to channel.

When the Signal format is IF/RF, at least one channel should be available for interference, otherwise a
message appears indicating that the interleave mode cannot be used.

4. If you set Add Interference via to Hardware, the interference should go to Ch2 and you need to
connect Ch1 output to Ch2 external signal addition input.

NOTE. The AWG7000 series does not support external signal addition via hardware.

Signal Addition via Software

The following table shows the combinations of the signal you want to generate after compilation and the
interference signal that you want to add.

Table 89: Valid combinations of signal addition via software for UWB-WiMedia
Compilation format Add Signal format Remarks
IQ IQ Valid combination.
IF/RF IF/RF Valid combination.
IF/RF IQ Valid combination. I/Q interference

signals are added before modulation.
IQ IF/RF Not a valid combination.
xxx
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Signal Addition via Hardware

The following table shows the combinations of the signal you want to generate after compilation and the
interference signal that you want to add.

Table 90: Valid combinations of signal addition via hardware for UWB-WiMedia
Compilation format Add Signal format Remarks
IQ IQ Valid combination.
IF/RF IF/RF Valid combination.
IF/RF IQ Not a valid combination.
IQ IF/RF Not a valid combination.
xxx

Offset for UWB-WiMedia
Follow these steps to add frequency offsets to a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include frequency offsets for a packet group. (Select Turn On again to exclude
frequency offsets. By default, Turn On is disabled.)

3. Enter the frequency (in Hz) offset to add. Refer to the following table for the instrument model
and range:

Model Option Range
AWG7101, AWG7102 Standard

02/06
–5 GHz to 5 GHz
–10 GHz to 10 GHz

AWG7051, AWG7052 Standard
02/06

–2.5 GHz to 2.5 GHz
–2.5 GHz to 2.5 GHz

AWG7061B, AWG7062B Standard
02/06

–3 GHz to 3 GHz
–3 GHz to 3 GHz

AWG7121B, AWG7122B Standard
02/06

–6 GHz to 6 GHz
–12 GHz to 12 GHz

AWG5002, AWG5004,
AWG5002B, AWG5004B

Standard –300 MHz to 300 MHz

AWG5012, AWG5014,
AWG5012B, AWG5014B

Standard –600 MHz to 600 MHz

xxx

Gated Noise for UWB-WiMedia
You can apply gated noise to either certain segments of the packets or through a range of symbols. The
packet segments that you can apply noise to are: Preamble, PLCP Header, or the Payload. You can
define a range of symbols to which to apply noise.
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A negative signal to noise value indicates that the noise added will be greater than the signal amplitude.
Conversely, a positive signal to noise value indicates that the noise added will be smaller than the signal
amplitude.

Follow these steps to add gated noise to a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include gated noise for a packet group. Select Turn On again to exclude gated
noise. By default, Turn On is disabled.

3. Set the following parameters:

Table 91: Gated noise parameters for UWB-WiMedia
Selection Description Range, default value
Packets Select Packets to define the packet

parameters.
Enabled

Preamble (S/N) (dB) Enable the option and enter the signal
to noise ratio for the preamble.

–40 to +20 dB, 0

PLCP Header (S/N) (dB) Enable the option and enter the signal
to noise ratio for the PLCP header.

–40 to +20 dB, 0

Payload (S/N) (dB) Enable the option and enter the signal
to noise ratio for the payload.

–40 to +20 dB, 0

Symbols Select Symbols to define the symbol
parameters.

Disabled

Packet range Enter the range of packets from the
start packet through the end packet.

From: 0 to 59039, 0
To: 0 to 59039, 0

S/N (dB) Enter the signal to noise ratio. –40 to +20 dB, 0
xxx

The following figure shows an example of a signal with gated noise.

The following figure shows an example of a signal without gated noise.
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The following figure shows an example of a gated noise applied to a range of symbols.

Sinusoidal for UWB-WiMedia
Follow these steps to add sinusoidal interference to a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include sinusoidal interference for a packet group. (Select Turn On again to exclude
sinusoidal interference. By default, Turn On is set to off.)

3. Set the following parameters:
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Table 92: Sinusoidal parameters for UWB-WiMedia
Selection Description Default value
C/I (dB) Enter the carrier-to-interference ratio. –60 dB to 60 dB
Offset from Carrier (Hz) Enter the offset frequency of the interferer

sample.
Refer to the following table for the instrument
model and range.

xxx

Model Option Range
AWG7101, AWG7102 Standard

02/06
–5 GHz to 5 GHz
–10 GHz to 10 GHz

AWG7051, AWG7052 Standard
02/06

–2.5 GHz to 2.5 GHz
–2.5 GHz to 2.5 GHz

AWG7061B, AWG7062B Standard
02/06

–3 GHz to 3 GHz
–3 GHz to 3 GHz

AWG7121B, AWG7122B Standard
02/06

–6 GHz to 6 GHz
–12 GHz to 12 GHz

AWG5002, AWG5004,
AWG5002B, AWG5004B

Standard –300 MHz to 300 MHz

AWG5012, AWG5014,
AWG5012B, AWG5014B

Standard –600 MHz to 600 MHz

xxx

Real-World Signal Interference
Follow these steps to add real-world interference to a signal:

1. Select the Interference Addition tab.

2. Select Turn On to include real-world interference for a packet group. (Select Turn On again to exclude
real-world interference. By default, Turn On is set to off.)

3. Set the following parameters:

Table 93: Real world signal parameters for UWB-WiMedia
Selection Description Range, default value
Add WiMax signal Enable this option to add WiMax interference to the UWB signal. Disabled
Frequency (Hz) Enter the frequency of the WiMax signal to add. Depends on the

instrument bandwidth,
2.5 GHz

Amplitude (dB) Enter the amplitude of the WiMax signal to add. –60 dB to + 60 dB, 0 dB
Add WiFi signal (MIMO) Enable this option to add WiFi (MIMO) interference to the UWB

signal.
Disabled
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Table 93: Real world signal parameters for UWB-WiMedia (cont.)

Selection Description Range, default value
Frequency (Hz) Enter the frequency of the WiFi (MIMO) signal to add. Depends on the

instrument bandwidth,
2.4 GHz

Amplitude (dB) Enter the amplitude of the WiFi (MIMO) signal to add. –60 dB to + 60 dB, 0 dB
Add WiFi signal
(802.11a)

Disabled

Frequency (Hz) Enter the frequency of the WiFi (802.11a) signal to add. Depends on the
instrument bandwidth,
2.4 GHz

Amplitude (dB) Enter the frequency of the WiFi (802.11a) signal to add. –60 dB to + 60 dB, 0 dB
Add radar signal Enable this option to add radar interference to the UWB signal. Disabled
Frequency (Hz) Enter the frequency of the radar signal to add. Depends on the

instrument bandwidth,
1 GHz

Amplitude (dB) Enter the amplitude of the radar signal to add. –60 dB to +60 dB, 0 dB
Add IQ Interference
signal

Enable this option to add IQ interference to the UWB signal. Disabled

Waveform_I Select an I waveform then the waveform list. N/A
Waveform_Q Select a Q waveform then the waveform list. N/A
Frequency (Hz) Enter the frequency of the IQ signal you want to add.
Amplitude (dB) Enter the amplitude of the IQ signal you want to add.
xxx

The radar signal that the application adds has the following properties:

Modulation: LFM (Linear Frequency Modulated) Pulse.

Pulse width: 5 μsec

Frequency sweep: 20 MHz

PRI: 800 μsec

S-Parameters
Follow these steps to specify the scattering parameter for the signal:

1. Click the S-Parameters tab.

2. Select Turn On to include the scattering parameter for the carrier. (Select Turn On again to exclude the
scattering parameter. By default, Turn On is set to off.)

3. Select the mode: Non-Cascading or Cascading. In the non-cascading mode, you can apply S-parameter
characteristics on the signal from only one S-parameter file. In the cascading mode, you can cascade
up to six S-parameter files and apply the characteristics on the signal. You can select the files to apply
them by turning on or turning off the corresponding blocks shown in the display.
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When the selected mode is cascading, all the selected files should be of the same type. The settings
depends on the selected type of file (*.s1p, *.s2p or *.s4p). The settings are common to all the files
(in cascading).

The default mode is Non-Cascading.

4. Select the bandwidth of the filter. Set it to Auto, Full Bandwidth, or Manual. In Manual, enter the
bandwidth in Hz. A bandwidth limit filter is applied to the response of the Touchstone file to limit the
bandwidth of the filter. The cutoff frequency of this bandwidth limit filter is calculated depending
on the selection.

5. Select Apply Inversion to invert magnitude and phase response given in S-parameter file. By default,
the Apply Inversion check box is disabled.

6. In the non-cascading mode, from the Read From File field, browse and select the file from which to
read the filter. The files supported are s1p, s2p, and s4p. In the cascading mode, select the files by
clicking inside the boxes and browsing to the file. Click On/Off to include or exclude the file.

7. Select the Touchstone 4-Port Data Type: Single-ended or Differential.

Files with data for four ports may contain single-ended or differential data. These are Touchstone
4-port files (s4p). By default, the application assumes the file to be single-ended data type. If the data
is single-ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21
parameter (for transmission of a differential signal) from the appropriate four S-parameters measured
using single-ended data.

8. Select the port for both transmitter and receiver from the drop-down list. Each drop-down list has ports
from 1 to 4. The default port number assignment is as follows:

Type Default port
Tx+ 1
Tx– 3
Rx+ 2
Rx– 4
xxx

9. If the data is differential, you must select the data layout in the file: Typical or Alternate. By default,
RFXpress assumes the file to use the Typical data location format.
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Using Calibration for IF/RF Signals
Calibration is available only when the software is running on an AWG7000 series instrument with
option 06.

For IF/RF signals connect the arbitrary waveform generator and oscilloscope as follows:

Creating Correction Files
1. Select Calibration from the toolbar.

2. Select the Signal Type.

3. From the list of instruments, highlight an oscilloscope and click Connect.

4. Set the Calibration parameters. The calibration parameters are: Sampling Frequency, Interleave,
Zeroing, Calibration Reminder, Average, Generator Center Frequency, Band Group Center Frequency,
and Sideband. You can leave these parameters with their default values or set them as you like.

However, you must set the following parameters: Band Group, Bands, and Channels to which
correction files apply.

NOTE. Interleave and Zeroing are available on the AWG7000 series with Option 06.

The following table lists the Band Groups and their center frequencies for IF and RF signals.

NOTE. Refer to the tables in the UWB-WiMedia (see page 219) section on BandGroups availability
for the AWG models.

Table 94: Band groups and center frequencies for IF and RF signals
Band Group RF Center Frequency IF Center Frequency
1 3960 MHz 1000 MHz
2 5544 MHz 1000 MHz
3 7128 MHz 1000 MHz
4 8712 MHz 1000 MHz
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Table 94: Band groups and center frequencies for IF and RF signals (cont.)

Band Group RF Center Frequency IF Center Frequency
5 10296 MHz 1000 MHz
6 8184 MHz 1000 MHz
User Defined Band Group Center Frequency is enabled

when user defined band group is selected. You
can enter any frequency value within the range
of 500 kHz to 10 GHz.

Band Group Center Frequency is enabled
when user defined band group is selected. You
can enter any frequency value within the range
of 1 GHz to 20 GHz.

xxx

5. For each channel, set the path and file name of the correction file. The correction files are created in
the specified location.

6. Click Calibrate. A status message displays the status of processing. The AWG creates a signal
averaged (the number of iterations) as specified by Average field and sends it to the oscilloscope.

The reference signal is generated using the oscilloscope parameters.

NOTE. The difference between the generated signal and the reference signal is calculated for each
iteration.

7. The corrections files (.rfc) created contain both Magnitude and Phase information specific for the
selected channel, band group and bands.

Applying Correction Files During Compilation
To apply the correction files creation by calibration, follow these steps:

1. Click Compile > Compile Settings from the toolbar.

2. In the Compile Settings (see page 32) dialog box, select the When compiling apply correction files to
these channels option and select the channels depending on the AWG model.

3. Click Compile. The correction files are applied while compiling the signal. The signal is displayed
in the Waveform List.
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Carrier Setup
The carrier may or may not be a coherent carrier. A coherent carrier is a continuous wave signal, the
frequency and phase of which have a fixed relationship to the frequency and phase of the reference signal.
Set the following carrier parameters:

Table 95: Radar carrier parameters
Selection Description Range, default value
Carrier Magnitude
(Peak)/Amplitude (Vpp)

For an If/RF signal, enter the peak amplitude of the carrier in
dBm. For an IQ signal, enter the amplitude in volts.

Based on the instrument
and the options installed,
0.00 dBm

Carrier Frequency (Hz) Enter the frequency of carrier in Hz, kHz, MHz, and GHz. This is
not available for an IQ signal.

Based on the instrument
and the options installed,
100 MHz

Coherent Carrier Select this to make the carrier as a coherent carrier. This is not
available for an IQ signal.

Available and enabled
for signal type IF/RF

xxx

Pulse Setup
Define the Pulse Train by selecting Pulse or Dead Time from the drop-down list and clicking Add. When
you select a pulse, all tabs containing pulse-related parameters are available.

A pulse group is a group of pulses. The pulses may be one or more depending on the number of times the
pulse is repeated (repeat value).

A pulse train is a set of pulse groups and the dead times within a pulse group.

Dead time is the time (equivalent to off time) between pulse groups.

The relationship between pulse train, pulse group, and dead time is as follows:

The following buttons are available:

Add. Click Add to add the pulse or dead time to the pulse train table.

Insert. Click Insert to insert a pulse below a selected row.

Delete. Click Delete to delete a selected pulse or pulses.

NOTE. You cannot delete all the rows (pulses) in the table. The table must contain at least one pulse.

For each of the pulses, you can define the parameters in each of the tabs: Pulse Envelope, Staggered
PRI, Modulation, Hopping and Pulse Impairments.
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Up and Down Arrows. Use the arrow buttons to move a selected pulse up or down the table.

Add Pulse Groups. Click this button to open a dialog box where you can select the pulse groups
to add in time.

The maximum number of pulses that can be added to the Pulse Train table is 4096. You can make any
pulse be an anchor. There can be only one anchor in the pulse train. You cannot make dead time be an
anchor. If you cut or delete an anchor pulse, the first pulse of the train is made the anchor. You can set the
anchor pulse using the shortcut menu.

The Pulse Graph is a visual representation of a pulse and the properties that define it. The display changes
dynamically based on the parameters.

Pulse Envelope
This tab has controls that define the envelope of a selected pulse. Pulse Envelope parameters define the
Pulse Shape, Start Time, Rise Time, Pulse Width, Fall Time, Off Time, Amplitude Relative to Carrier,
Offset from Carrier Frequency, and the number of times to Repeat a pulse. When you select Dead Time,
only Dead Time (Toff) is available.

Select a pulse from the table and set the following parameters:

NOTE. The available Pulse Envelope parameters will depend on the selected pulse shape. Not all
parameters are available for a selected pulse shape.

Table 96: Pulse envelope parameters
Selection Description Range, default value
Pulse Shape Select the pulse shape from the following: Trapezoidal, Raised

Cosine, Exponential, Rectangular, Saw tooth, and Custom.
Rectangular

Start Time Enter the initial off time (start of the pulse from the reference) for
the pulse in ps, ns, μs, ms, or seconds.

The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.

Rise Time Enter the rise time for the pulse. Define the rise time between
0–100%, 10–90% or 20–80% of the voltage level. Available only
for Trapezoidal, Raised Cosine, Exponential, and Saw Tooth
pulse shapes.

The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.
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Table 96: Pulse envelope parameters (cont.)

Selection Description Range, default value
Fall Time Enter the fall time for the pulse. Define the fall time between

0–100%, 10–90% or 20–80% of the voltage level. Available for
all pulse shapes except Saw Tooth and Custom.

The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.

Pulse Width Enter the pulse width. Define the width at 50% or 100% voltage.
Available for all pulse shapes except Saw Tooth and Custom.

The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.

Off Time/Dead time Enter the off time after the fall time. The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.

Sampling Rate Available only when the pulse shape is Custom. Enter the
sampling rate at which the custom pulse has been generated in
kHz, MHz, GHz, or Hz.

The range depends
on the instrument and
options installed. The
default values will change
based on the pulse
shape.

Amplitude Relative
to Carrier/Relative
Amplitude

For an IF/RF signal, enter the amplitude relative to the carrier
magnitude. For an IQ signal, enter the relative amplitude.

0

Offset from Carrier
Frequency/Baseband
Offset

For an IF/RF signal, enter the offset from the carrier frequency.
For an IQ signal, Enter the offset from the baseband. If you have
repeated this pulse, then all the pulses will have the same offset.

0

Repeat Enter the number of times to repeat a pulse. 1
PRF The Pulse Repetition Frequency (PRF) value is automatically

generated based on the pulse envelope parameters and is
displayed to a resolution of six decimal places in kHz. The
PRF value is updated whenever the values of any of the pulse
envelope parameters are changed.

N/A

xxx

A custom pulse shape file must meet the following conditions:

Input files are ASCII files (.txt) or MATLAB files (.mat).

Only positive numbers are allowed. All other characters are invalid (including tab and space). The
application stops reading data when it encounters invalid data.

The maximum length of the file is 1M samples.
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In case of an ASCII file, the data should be in floating point and the values should be arranged in a
single column and several rows with one value in each row.

A MATLAB file should contain a variable with ‘n’ sample points or values of the format 1 x n.
For example,

SamplePoints = [ 0.5 0.3 0.2 0.7 ….]

Staggered PRI
Use Staggered PRI to create multiple PRIs and define pulse-to-pulse staggering in the Staggered PRI tab.

Follow these steps to specify multiple PRIs for a pulse group:

1. Click Turn on.

2. Set the following parameters for the selected pulse:

Table 97: PRI/PRF parameters
Options Description Range, default value
Staggered PRI Type Select from Ramp and User Defined.

If you select Ramp, you must specify
the PRI Deviation Slope.

None

PRI Deviation Slope (degrees) Enter the deviation slope in degrees.
Available only when the Staggered
PRI Type is Ramp.

–180° to +180°, 0°

Repeat PRI Deviations When enabled, the application repeats
the PRI deviation values for all the
pulses. When disabled, PRI deviation
values are used for only those pulses
and 0 is used for all others pulses.

Disabled

xxx

NOTE. If the Staggered PRI type is Ramp, the deviation ΔT is calculated as follows:

ΔT=(y*PRI*(i-1)), where y=tan(slope) in radians and i=1 to Repeat value

3. If you have selected User Defined, click Add to add a row to the table. Edit the deviation values
directly in the table. The number of rows in the table is limited to the value in the Repeat pulse
envelope parameter
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Staggered PRI Type Ramp is shown as follows:

Staggered PRI Type User Defined is shown as follows:
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Modulation
The Pulse Modulation tab allows you to provide the different modulation schemes that can be applied
to the pulse width for a selected pulse. The available modulation schemes are: No Modulation, Linear
Frequency Modulation (LFM), Up Down Chirp Modulation, Biphase Coded pulse-Barker, Polyphase
Codes, Frank Code, P1 Polyphase Code, P2 Polyphase Code, P3 Polyphase Code, P4 Polyphase Code,
User Defined Step PM AM, Step Frequency Modulation, Non Linear FM, User Defined Step FM AM,
BPSK, QPSK, and Custom Modulation. By default, the modulation scheme is No Modulation. For more
information on modulation types, refer to the topic Types of Modulation (see page 227).

NOTE. No Modulation is the same as continuous modulation.

Modulation parameters for Linear Frequency Modulation (LFM)

Table 98: Linear frequency modulation parameters
Selection Description Range, default value
Sweep Range Enter the sweep range in Hz, kHz, MHz, or GHz. Range is dependent on

the instrument, 10 MHz
Frequency Sweep Enter the frequency sweep: High to Low, or Low to High. Low to High
xxx

Up-Down Chirp Modulation

Table 99: Up-down chirp modulation parameters
Selection Description Range, default value
Sweep Range Enter the sweep range in Hz, kHz, MHz, or GHz. Range is dependent on

the instrument, 10 MHz
Number of Up-Downs Enter the number of peaks (ups) and troughs (downs) in the

modulation.
1 to 12, 1

Invert Select (enable) to create Down-Up chirp. Disabled
xxx

Biphase Coded Pulse

Table 100: Biphase coded pulse parameters
Selection Description Range, default value
Barker Code Enter the length of the Barker code. The options are: 2, 3, 4,

5, 7, 11, and 13.
2

xxx

Polyphase Codes
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Table 101: Polyphase codes parameters
Selection Description Range, default value
Number of Steps Enter the number of phase entries. 1 to 200, 2
Initial Offset Enter the initial offset in degrees. –180° to +180°, 45°
Phase Offset Enter the phase offset in degrees. –180° to +180°, 90°
xxx

Frank Code

Table 102: Frank code parameter
Selection Description Range, default value
Code Length Enter the length of the code. 1 to 10, 1
xxx

P1 Polyphase Code

Table 103: P1 polyphase code parameter
Selection Description Range, default value
Code Length Enter the length of the code. 1 to 10, 1
xxx

P2 Polyphase Code

Table 104: P2 polyphase code parameter
Selection Description Range, default value
Code Length Enter the length of the code. 1 to 10, 1
xxx

P3 Polyphase Code

Table 105: P3 polyphase code parameter
Selection Description Range, default value
Code Length Enter the length of the code. 1 to 10, 1
xxx

P4 Polyphase Code

Table 106: P4 polyphase code parameter
Selection Description Range, default value
Code Length Enter the length of the code. 1 to 10, 1
xxx

User Defined Step PM AM
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Table 107: User-defined step PM AM parameters
Selection Description Range, default value
Step Enter the number of steps. 1 to 200, 1
Duration (ns) Enter the duration of the subpulse width in ns. Cannot be greater than

the pulse duration
Duration (%) Automatically calculated based on the pulse width and the

duration of the subpulse.
N/A

Phase (deg) Enter the phase offset in degrees for the subpulse. –180° to +180°, 90°
Amplitude (dB) Enter the amplitude in dB for the subpulse. -60 dB to 0 dB, 0 dB
xxx

NOTE. Duration in percentage is calculated automatically up to three decimal places. This can cause
rounding of the actual duration entered.

Step Frequency Modulation

Table 108: Step frequency modulation parameters
Selection Description Range, default value
Number of Steps Enter the number of phase entries. 1 to 200, 4
Initial Step Enter the initial step of the phase in Hz, kHz, MHz, or GHz. Based on the instrument

and the installed options,
10 MHz

Step Size Enter the step size of the phase in Hz, kHz, MHz, or GHz. Based on the instrument
and the installed options,
10 MHz

xxx

Nonlinear Frequency Modulation

Non Linear FM uses the coefficients to create the instantaneous frequencies for modulation.

F(t) = 2*pi*C(t)*t, where C(t) is the instantaneous frequency

Instantaneous frequency C(t) can be defined by the following polynomial:

C(t) = c0+c1*t+c2*t*t +c3*t*t*t..., where c0, c1, and c2 and others are the coefficients with order 0,
1, 2, and others.
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To provide a constant instantaneous frequency and an offset, enter the offset value in the 0th order and rest
of the coefficients as zeros.

Table 109: Nonlinear frequency modulation parameters
Selection Description Range, default value
Order Enter the order of the polynomial. 0 to 100, 0
Coefficients Enter the coefficient of the polynomial. –10e100 to +10e100,

1e–10
xxx

User Defined Step FM AM

Add the number of steps. Once the number of steps are entered then the user will have the option to
enter the duration (in ns) and frequency for each of the step. The duration will indicate a percentage of
the pulse width.

Table 110: User-defined step AM FM parameters
Selection Description Range, default value
Step Enter the number of steps. 1 to 200, 1
Duration (ns) Enter the duration of the subpulse width in ns. Cannot be greater than

the pulse duration
Duration (%) Automatically calculated based on the pulse width and the

duration of the subpulse.
N/A

Frequency Offset (±
MHz)

Enter the phase offset in degrees for the subpulse. Based on the instrument
and the installed options,
10 MHz

Amplitude (dB) Enter the amplitude in dB for the subpulse. -60 dB to 0 dB, 0 dB
xxx

NOTE. Duration in percentage is calculated automatically up to three decimal places. This can cause
rounding of the actual duration entered.

QPSK Modulation

Enter the number of symbols for the pulse. Enable the option Same symbols for all pulses to have the same
number of symbols for all the pulses in the pulse group.

Table 111: QPSK parameters
Selection Description Range, default value
Number of Symbols Enter the number of symbols in the pulse. 1 to 200, 4
Same symbols for all
pulses

Enable this to use the same number of symbols for all the pulses
in the modulation. This option is available only when the Repeat
parameter (in the Pulse Envelope tab) is greater than 1.

Disabled

xxx

BPSK Modulation
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Enter the number of symbols for the pulse. Enable the option Same symbols for all pulses to have the same
number of symbols for all the pulses in the pulse group.

Table 112: BPSK parameters
Selection Description Range, default value
Number of Symbols Enter the number of symbols in the pulse. 1 to 200, 4
Same symbols for all
pulses

Enable this to use the same number of symbols for all the pulses
in the modulation. This option is available only when the Repeat
parameter (in the Pulse Envelope tab) is greater than 1.

Disabled

xxx

Custom Modulation

Select a MATLAB file or text file. This file should contain Time versus Phase values. in the specified
format.

A custom modulation file must meet the following conditions:

Input files are ASCII files (.txt) or MATLAB (.mat).

Both positive and negative numbers are allowed. All other characters are invalid (including tab and
space). The application stops reading data when it encounters invalid data.

The maximum length of the file is 1M samples.

When ASCII file is chosen, the data should be in floating point format and the values should be
arranged in a single column and several rows with one value in each row.

A MATLAB file (*.mat) should contain a variable with ‘n’ sample points or values of the format 1 x n.

For example, SamplePoints = [ 0.5 0.3 0.2 0.7 ….]

Hopping
This tab allows you to define the hopping pattern from pulse-to-pulse. You can provide frequency offset
and amplitude deviation only if the pulse is repeated more than once.

Frequency hopping can used to create frequency agile waveforms. Frequency is changed from one pulse
to another pulse. Frequency hopping is used in electronic counter measures by rapidly switching the
frequency of the transmitted energy, and receiving only that frequency during the receiving time window.

Amplitude hopping can be used to create different amplitudes from one pulse to another. Amplitude
hopping can be used to create different swirling models.

Hopping Parameters
Hopping allows you to add frequency and amplitude hopping for a selected pulse.
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Follow these steps to define frequency/amplitude hopping:

1. Select a pulse and click Turn On.

2. Define the Hop Frequency parameters. Select the pattern from the following: Custom Table,
Pseudo-Random (Range), Pseudo-Random (List), and Pseudo-Random (Avoid List). The default
pattern is Custom Table.

If you select Custom Table, you must directly enter the values into the table. Click Add to add a
row to the table and edit the values. You can enter values as Frequency Offset (±MHz). The table
columns change depending on the selected Hop Time Method. The maximum number of hops for
a pulse is limited by the pulse repeat count or 500 hops, whichever is less.

The relative amplitude takes only negative values (0 to –80 dB). Frequency Offset takes positive
and negative values.

NOTE. If the hop frequency is not defined for a pulse, then the application sets the hop frequency
during that time interval to a frequency offset of 0 Hz with a relative amplitude of 0 dB.

If you select Pseudo-Random (Range), the signal will hop using the specified interval within the
frequency range specified. Enter the parameters from the table.

Table 113: Hop frequency parameters for Pseudo-Random (Range) and (Avoid)
Selection Description Range, default value
Minimum Frequency Offset Enter the frequency range within

which to hop. Specify the start
frequency for the range.

For IF/RF: 100 Hz – Carrier
Frequency to the maximum
supported by the instrument and
installed options, –10 MHz
For IQ: Depends on the instrument
and installed options, –10 MHz

Maximum Frequency Offset Specify the end frequency for the
range.

For IF/RF: Greater than Minimum
Frequency to the maximum
supported by the instrument and
installed options, +10 MHz.
For IQ: Depends on the instrument
and installed options, +10 MHz

Channel Spacing (Hz) Specify the minimum frequency
intervals for hopping. The signal will
hop in this interval or at multiples of
this interval.

100 Hz to (Max freq–Min Freq),
10 MHz

PRBS Select the PRBS pattern for hopping:
7, 9, 15, 16, 20, 21, 23, User-defined.

7 (default)

xxx
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The signal will hop in the specified frequency range.

If you select Pseudo-Random (List), the signal will hop randomly using the frequencies specified
in the table. Click Add to add a row to the table and edit the frequency values. All frequency
values are in absolute terms.

If you select Pseudo-Random (Avoid List), the signal will avoid hopping in the frequencies
specified in the table. Click Add to add a row to the table and edit the frequency values. Enter the
parameters from the table.

3. Define the Hop Time parameters. Select the Method from the following: Pulse per hop (fixed) is
available for Custom Table Pseudo-Random (Range), Pseudo-Random (List), and Pseudo-Random
(Avoid). The Maximum number of pulses per hop is equal to the number of pulse repeat. The pulses
per hop defines that each hop frequency consists of how many consecutive pulses (or that it defines
how many consecutive pulses will have the same hop frequency).

Table 114: Hop time methods and parameters
Selection Description Range, default value
Pulses per hop (fixed) Select this method to define the pulses

per hop.
1 to number of pulse repeat, 1

xxx

The hop duration is the same as PRI.
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Pulse Impairments
This tab allows you to set the impairments for the selected pulse. Two groups are available: Jitter and
Amplitude Deviation.

Follow these steps to add jitter impairments:

1. Click Turn on.

2. Set the following jitter parameters to apply jitter on the pulse:

Table 115: Jitter parameters
Options Description Range, default value
Edge Jitter Select from None, Gaussian, and

Uniform. If you select Gaussian
or Uniform, you must specify the
deviation.

None

Deviation Enter the deviation in μs, ps, or ns. 0 to 100 millis, 1 ns
Width Jitter Select from None, Gaussian, and

Uniform. If you select Gaussian
or Uniform, you must specify the
deviation.

None

Deviation Enter the deviation in μs, ps, or ns. 0 to 100 millis, 1 ns
xxx

Width jitter is described as the change in the time duration, or on-time, of the pulse. The width of the
pulse is changed by jitter. Width jitter is applied to the falling edge of the pulse; the leading edge is not
changed by this parameter. Edge jitter describes differences in the repetition intervals of pulses.

Follow these steps to add amplitude deviation:

1. Click Turn on.

2. Set the following amplitude parameters to specify droop and ripple for the pulse:

Table 116: Amplitude deviation parameters
Options Description Range, default value
Droop Enter the droop in percentage of

power.
–50 % to 0, 0

Overshoot Enter the overshoot in percentage of
voltage.

0 to 50 %, 0

Ripple Enter the ripple in percentage of
voltage.

0 to 50 %, 0

Ripple Frequency Enter the ripple frequency in Hz, kHz,
MHz, or GHz.

Based on the instrument and the
options installed, 3 MHz

xxx
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Multipath
Follow these steps to set multipath parameters for a signal:

1. Select the Multi-Path tab.

2. Select Turn On to define the path. (Select Turn On again to exclude multipath parameters. By default,
Turn On is disabled.)

3. Click Add to add a row to the table. To delete a row, select the row and click Delete.

In the table, edit or set the following parameters:

Table 117: Multipath parameters for radar
Selection Description Range, default value
Delay (μs) Enter the delay in symbols from the

reference path. The delay can be
positive or negative. The delay values
cannot be repeated.

–2 to +2 μs, 0 μs

Amplitude (dB) Enter the amplitude in dB from the
reference path. The amplitude is
always negative.

–60 to 0 dB, 0 dB

Phase (deg) Enter the phase in degrees from the
reference path. The phase can be
positive or negative.

–180 to +180 degrees, 0 degree

xxx

You can define a maximum of ten multipaths, including the reference path that has the delay, amplitude
and phase values set to zero. You can neither delete the reference path with a delay of 0 symbols nor
change the delay value. However, you can change the amplitude and phase values. No two paths can have
the same delay value. The table rows are automatically sorted in the ascending order of the delay value.
The table contains the Delay, Amplitude, and Phase that you entered.

Antenna
RFXpress allows antenna beam pattern settings to be applied. It allows some standard beam patterns
and also a custom beam pattern. The custom beam pattern is a file containing values for angle versus
amplitude. The standard beam patterns are Linear Array and Pencil Beam.

Follow these steps to set the antenna parameters for a signal:

1. Select the Antenna tab.

2. Select Turn On to define the antenna parameters. (Select Turn On again to exclude antenna parameters.
By default, Turn On is disabled.)

3. Set the following parameters:
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Table 118: Antenna parameters for radar
Selection Description Range, default value
Beam Type Select the beam type from the

following: Sinc, Gaussian, and User
defined.

Sinc

Beam Width (degrees) Enter the beam width. 0.001 to 180 degrees, 0 degree
Target Bearing (degrees) Enter the maximum radial axis. –180 to +180 degrees, 0 degree
Scan Rate (degrees/sec) Enter the rate at which the scan takes

place.
0.001 to 180 degrees, 0 degree

Beam File Enabled only when the beam type
is User Defined. Select a file that
contains the beam pattern.
The values in the beam file ranges
between 0 and 1 and can have up to
seven decimal places. The maximum
length of the beam file is 1 M samples.

\Samples\SimpleBeamProfile.txt

xxx

The following illustration shows the antenna parameters.

RFXpress RFX100 User Manual 149



Creating a Radar Signal Clutter

Clutter
The Clutter tab allows you to provide the different clutter schemes that can be applied to the pulse group.

Follow these steps to set the clutter parameters for a signal:

1. Select the Clutter tab.

2. Select Turn On to define clutter parameters. (Select Turn On again to exclude clutter parameters. By
default, Turn On is disabled.)

3. Set the following parameters:

Table 119: Clutter parameters for radar
Selection Description Range, default value
Signal to Clutter Ratio (SCR) (dB) Enter the level of clutter to add to the

signal.
-60 to +60 dB, 10 dB

Start Time (s) Enter start time of the clutter signal. 0 s to a value less than PRI, 0 s
Duration (s) Enter the duration of the clutter signal.

Start time plus duration must be less
than PRI.

Pulse width to PRI, 1 μs

Statistical Profile Displays the statistical profile of how
the clutter elements are distributed.
This field is display only.

Rayleigh

Power Spectral Density Select the power spectral density from
the following: None, Gaussian.

None

Gaussian Bandwidth (Fs) Enter the Gaussian bandwidth. 0.00001 Fs to 0.5 Fs, 0.001 Fs
Clutter Frequency Offset (Hz) Enter the clutter frequency offset. Default is 0 kHz. The range depends

on the instrument and options
installed.

xxx

150 RFXpress RFX100 User Manual



Creating a Radar Signal Hardware Skew for Radar

Hardware Skew for Radar
Hardware skew is common for all pulses. The number of channels shown depends on the AWG model
being used. Follow these steps to define hardware skew for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include hardware skew for all pulses. (Select Turn On again to exclude hardware
skew. By default, Turn On is set to off.)

3. Set the following parameters:

Table 120: Hardware skew parameter for radar
Selection Description Range, default value
Channel N (ps) Enter a value for each channel.

Adjusting the skew dynamically
updates the dialog box display. The
adjustment applies to analog output
and marker output.

AWG7000: –100 ps to +100 ps, 0 ps
AWG5000: –5 ns to +5 ns, 0 ns

xxx

Carrier Leakage for Radar
Follow these steps to define carrier leakage for all pulses:

1. Select the I/Q Impairments tab.

2. Select Turn On to include carrier leakage (I and Q) impairments to the pulse. (Select Turn On again to
exclude carrier leakage (I and Q) impairments. By default, Turn On is set to off.)

3. Set the carrier leakage for I and Q modulator signal in percentage.

Table 121: Carrier leakage parameters for radar
Selection Description Range, default value
I (%) Enter the carrier leakage for the I

signal.
–50% to +50%, 0

Q (%) Enter the carrier leakage for the Q
signal.

–50% to +50%, 0

xxx
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Quadrature Error for Radar
Quadrature Error allows you to control the phase angle between the I and Q signals. Follow these steps
to define quadrature error for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include quadrature error for all pulse. (Select Turn On again to exclude quadrature
error. By default, Turn On is set to off.)

3. Quadrature error is defined in degrees. A positive value indicates that the phase angle is greater
than 90 degrees. Set the following parameter:

Table 122: Quadrature error parameter for radar
Selection Description Range, default value
Degrees Enter the phase angle between the I

and Q signals.
–30° to +30°, 0°

xxx

I/Q Imbalance for Radar
I/Q Imbalance allows you to create gain imbalance between I and Q. Follow these steps to define I/Q
imbalance for a signal:

1. Select the I/Q Impairments tab.

2. Select Turn On to include I/Q imbalance for all pulses. (Select Turn On again to exclude I/Q
imbalance. By default, Turn On is set to off.)

3. I/Q imbalance is defined in percentage. Set the following parameter:

Table 123: I/Q imbalance parameters for radar
Selection Description Range, default value
Percentage Enter the imbalance between the I

and Q signals.
–30% to +30%, 0%

xxx

I/Q Swap for Radar
1. Select the I/Q Impairments tab.

2. Enable I/Q Swap to interchange I and Q signal outputs.
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Signal Addition
The software allows you to add an imported waveform to the generated waveform.

Follow these steps to add a signal to a waveform:

1. Select a pulse from the table.

2. Select the Interference Addition tab.

3. Select Turn On to add signal file for the pulse. (Select Turn On again to exclude signal file. By
default, Turn On is disabled.)

4. Set the following parameters:

Table 124: Signal addition parameters for radar
Selection Description Default value
Format

I/Q Specifies the signal format of the file to be added. I/Q
IF/RF Specifies the signal format of the file to be added. N/A

Add Interference via:
Software Specifies that the interference addition is through software. Software
Hardware Specifies that the interference addition is through hardware. N/A
Waveform_I Click the icon next to the Waveform_I field and a list of waveforms

appears. Select the I waveform to use.
N/A

Waveform_Q Click the icon next to the Waveform_Q field and a list of
waveforms appears. Select the Q waveform to use.

N/A

Waveform_RF Click the icon next to the Waveform_RF field and a list of
waveforms appears. Select the RF waveform to use.

N/A

xxx

Noise
Follow these steps to add noise to a waveform.

1. Select a pulse from the table.

2. Select the Interference Addition tab.

3. Select Turn On to add noise to the pulse. (Select Turn On again to exclude noise. By default, Turn
On is disabled.)

4. Set the following parameters:
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Table 125: Signal addition parameters for radar
Selection Description Range, default value
SNR (dB) Enter the singal-to-noise ratio. +60 dB to –60 dB, 20 dB
Bandwidth (fs) Enter the bandwidth of the noise. 0.01 fs to 0.5 fs, 0.5 fs
xxx

S-Parameters
Follow these steps to specify the scattering parameter for the signal:

1. Click the S-Parameters tab.

2. Select Turn On to include the scattering parameter for the carrier. (Select Turn On again to exclude the
scattering parameter. By default, Turn On is set to off.)

3. Select the mode: Non-Cascading or Cascading. In the non-cascading mode, you can apply S-parameter
characteristics on the signal from only one S-parameter file. In the cascading mode, you can cascade
up to six S-parameter files and apply the characteristics on the signal. You can select the files to apply
them by turning on or turning off the corresponding blocks shown in the display.

When the selected mode is cascading, all the selected files should be of the same type. The settings
depends on the selected type of file (*.s1p, *.s2p or *.s4p). The settings are common to all the files
(in cascading).

The default mode is Non-Cascading.

4. Select the bandwidth of the filter. Set it to Auto, Full Bandwidth, or Manual. In Manual, enter the
bandwidth in Hz. A bandwidth limit filter is applied to the response of the Touchstone file to limit the
bandwidth of the filter. The cutoff frequency of this bandwidth limit filter is calculated depending
on the selection.

5. Select Apply Inversion to invert magnitude and phase response given in S-parameter file. By default,
the Apply Inversion check box is disabled.

6. In the non-cascading mode, from the Read From File field, browse and select the file from which to
read the filter. The files supported are s1p, s2p, and s4p. In the cascading mode, select the files by
clicking inside the boxes and browsing to the file. Click On/Off to include or exclude the file.

7. Select the Touchstone 4-Port Data Type: Single-ended or Differential.

Files with data for four ports may contain single-ended or differential data. These are Touchstone
4-port files (s4p). By default, the application assumes the file to be single-ended data type. If the data
is single-ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21
parameter (for transmission of a differential signal) from the appropriate four S-parameters measured
using single-ended data.

8. Select the port for both transmitter and receiver from the drop-down list. Each drop-down list has ports
from 1 to 4. The default port number assignment is as follows:
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Type Default port
Tx+ 1
Tx– 3
Rx+ 2
Rx– 4
xxx

9. If the data is differential, you must select the data layout in the file: Typical or Alternate. By default,
RFXpress assumes the file to use the Typical data location format.
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Basic Setup
Use the Basic Setup tab to define the carrier setup. Define the following parameters:

Table 126: Basic setup parameters for OFDM
Selection Description Range, default value
Frequency (Hz) Enter the frequency of carrier in Hz, kHz, MHz, and GHz. This is

not available for an IQ signal.
100 Hz to maximum
supported by the
instrument, 1 GHz

Carrier Magnitude
(Peak)/Amplitude

For an IF/RF signal, enter the amplitude of the carrier in dBm.
For an IQ signal, enter the amplitude in volts.

For IF/RF signals: The
range depends on the
instrument and options
installed, 0 dBm
For IQ signals: Minimum
and Maximum Vpp of the
instrument, 0.5 Vpp

xxx

You can define up to eight base data types for a carrier. For each selected base data, define the following:

Table 127: Basic setup parameters for base data
Selection Description Default value
Name Enter a name for the base data, or use the default name

provided.
Base data <n>

Data Source Select the data source for the selected base data. Select from
one of the following: All 0, All 1, Pattern, PRBS, and User
defined file.

All 0

Pattern Data Enter a pattern of zeros and ones up to a maximum of 80 digits
in the text field that appears.
Available only when the data source is set to Pattern.

10101010

PRBS Type Select the PRBS type from the following: 7, 9, 15, 16, 20, 21, 23,
and User Defined. To edit the bit sequence, select User Defined
in the PRBS drop-down menu. This causes the PRBS Editor…
button to appear.
Available only when the data source is set to PRBS.

7

PRBS Editor Click this to define a PRBS polynomial expression.
Available only when the PRBS Type is set to User Defined.

X31+X30+1

xxx
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To apply Reed Solomon Coding (see page 69), Scrambling (see page 71), and Convolution Coding (see
page 72), select the base data and select the corresponding buttons.

Symbols
Use the Symbols tab to define the symbols. At least one symbol is present in the symbol tab. Click Add to
add a symbol to the table. To rename a symbol, select the symbol, double-click it and type a name.

Define the following symbol parameters:

Table 128: Symbol parameters for OFDM
Selection Description Range, default value
Symbol Name Enter a name for the symbol, or use the default name provided. Symbol <n>
Spacing between
carriers

Enter the frequency interval between carriers. 1 Hz to the maximum
supported by the
instrument, 100 kHz

User-defined Frequency
Weight

Specify the file from which to load symbol data. You still
have to specify the Frequency Offset, Carrier spacing, and
Prefix/Padding information.

userdefinedsym-
bol_IQ.txt

Subcarrier table (disabled for user defined frequency)
– to + Select – to + to display the subcarriers from –x to +x. Selected
all+ Select all+ to displays the subcarriers from 0 to x. Not selected
Add new subcarriers Enter the number of subcarriers to add for a symbol. Enter

values as multiples of 2.
2 to 65536, 2

Padding/Prefix
Zero Padding Select this to pad zeros at the end of the symbol. You can

specify the length of zero padding in time or in percent.
Selected

Cyclic Prefix Select this to have a copy of the end-of-the-symbol to be prefixed
at the beginning of the symbols. You can specify the length of
cyclic prefixing in time or in percent.

Not selected

Time Enter the time (in seconds) for cyclic prefixing or zero padding. 0 ns to 1 sec, 1 μsec
Percent Enter the percent for cyclic prefixing or zero padding. 0 to 1000, 150
Frequency Offset Enter the frequency offset value for the selected symbol. 0 M
Clipping Select the option and specify the clipping ratio. Clipping Ratio is

the Clip power level divided by Average Power.
0.01 to 50, 1

Edit selected subcarriers
Edit Subcarrier Enter the subcarrier to edit. Depending on how the subcarriers

are viewed, enter a positive or negative value.
You can also select the subcarrier from the table.

Depends on the
instrument and options,
0 kHz

Type Select the subcarrier type from the following: Data, Guard, Pilot,
and Null.

Data
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Table 128: Symbol parameters for OFDM (cont.)

Selection Description Range, default value
Modulation Select the modulation type from the following: BPSK, QPSK,

16-QAM, 32-QAM, 64-QAM, 256-QAM, and 8-PSK.
BPSK

Base Data Select the base data to which the subcarrier belongs. The base
data list is the same as that defined in the basic setup.

Base Data 1

xxx

Clipping Ratio is defined as the Clip power level / Average Power.

Clipping Ratio = Clip power level / Average power.

The magnitude for clipping is obtained by:

Clip magnitude level=sqrt(Clipping Ratio*Average power).

The signal above the clipping magnitude level is clipped to the specified clipping level and the phase is
retained as it is.

Click Tone Nulling (see page 73). For the selected carrier, the tone nulling table shows the carrier index,
the amplitude (dB), and the phase (degrees). Click Turn On to edit the amplitude and phase fields.
Double-click the field and enter a new amplitude for the selected carrier.

Each of the modulations is normalized by a factor given by √(3/(2*(Constellation points-1)).

The following table lists the normalization factor for each of the modulations:

Table 129: Normalization factor for modulations
Modulation Normalization factor
BPSK 1
QPSK 1/√2
16-QAM 1/√10
32-QAM √(3/(2*31))
64-QAM √1/42
256-QAM √1/170
8-PSK √(3/(2*3))
xxx
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Packets
Use the Packets tab to combine different OFDM symbols as a packet. At least one symbols is present in
the symbol list. Click Add to add a packet to the table. Define the following packet parameters:

1. Enter the number of packets and click Add Packet. You can add up to 100 packets.

NOTE. The packet table must have at least one symbol. You cannot delete all packets from the table.

2. Enter the number of packets and click Add Packet. You can add up to 100 packets.

3. A list of available symbols is displayed. These symbols are those you defined in the Symbols tab.
Click Add or Insert to define the symbols in the selected packet.

4. Select a packet from the table. Add the symbols in the packet by clicking Add or Insert.

In the symbol list of the packet, click the Repeat column and enter a value (the default is 1). The
symbol IDs for the packet are updated to reflect the repeat count.

5. Set the following parameters:

Table 130: Packet parameters for OFDM
Selection Description Range, default value
Preamble/Postamble
Preamble Enable this option to provide a preamble symbol file. preamblesymbol_IQ.txt
Sampling Rate (Hz) Enter the sampling rate for the data in the preamble file. 10 kHz to 100 GHz,

528 MHz
Postamble Enable this option to provide a postamble symbol file. postamblesymbol_IQ.txt
Sampling Rate (Hz) Enter the sampling rate for the data in the postamble file. 10 kHz to 100 GHz,

528 MHz
Spacing/Overlapping
Spacing between
symbols

Select this option and enter the spacing between symbols in
seconds.

0 to 1 sec, 0 sec

Overlap between
symbols

Select this option and enter the overlap between symbols in
percentage.

0 to 50%, 0

Overlap Window Select the overlap window type from the following: None,
Trapezoidal, Hanning, Hamming, and Blackmann.
This option is available only when Overlap between symbols
is enabled.

None

xxx

6. Click the Frequency Hopping button to define the symbols between which the signal will hop, the
frequency offset, and relative amplitude. Frequency Hopping (see page 73).

7. Click the Gated Noise button to apply noise to specific symbols in the packet. Select the start and end
index of the symbol, and the noise to be applied. Gated Noise (see page 74).
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Frames
Use the Frames tab to combine packets into frames and to create multiple frames.

Click Add to add a frame to the Frame List. You can add up to 100 frames. Double-click the frame to
highlight and rename the frame.

Set the following frame parameters:

1. Select a frame from the frame list.

2. Specify the spacing in seconds between packets.

3. A list of available packets is displayed. These packets are those you defined in the Packets tab. Click
Add or Insert to define the packets in the selected frame.

4. In the selected Frame table, enter the Repeat value. The repeat value defines the number of times the
packet is repeated. You can also add the same packet more than once.

5. For each frame you can set multipath parameters.

a. Select the Multi-Path tab.

b. Select a frame from the table.

c. Select Turn On to define the path for the frame. (Select Turn On again to exclude multipath
parameters. By default, Turn On is disabled.)

d. Set the following parameters:
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Table 131: Multipath parameters for frames
Selection Description Range, default value
Delay (μs) Enter the time delay from the

reference path. The delay can be
positive or negative. The delay
values cannot be repeated.

Depends on the instrument and
options, 0 symbols

Amplitude (dB) Enter the amplitude in dB from the
reference path. The amplitude is
always negative.

–60 to 0 dB, 0 dB

Phase (deg) Enter the phase in degrees from the
reference path. The phase can be
positive or negative.

–180 to +180 degrees, 0 degree

xxx

6. For each frame you can set phase noise parameters.

a. Select the Phase Noise tab.

b. Select a frame from the table.

c. Select Turn On to define the phase noise. (Select Turn On again to exclude phase noise
parameters. By default, Turn On is disabled.)

d. Select the phase noise model: Time or Frequency Profile.

The Time Model or 1/fα method provides for adding noise with different roll off after the VCO
bandwidth. The integrated phase noise is in specified degrees. The noise generated is integrated
across Sampling Rate/2.

1/f0: Adds white Gaussian phase noise to the signal.

1/f1: Adds Gaussian phase noise with a roll-off of 10 dB/decade to the signal after the VCO
bandwidth (cutoff).

1/f2: Adds Gaussian phase noise with a roll-off of 20 dB/decade to the signal after the VCO
bandwidth (cutoff).

1/f4: Adds Gaussian phase noise with a roll-off of 40 dB/decade to the signal after the VCO
bandwidth (cutoff).
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Set the following parameters for Time Model:

Table 132: Time model parameters for phase noise
Selection Description Range, default value
Profile Select the profile from the following:

1/f0, 1/f1, 1/f2, and 1/f4.
1/f0

VCO Bandwidth Enter the bandwidth (VCO cutoff)
for the selected profile. This field is
not available if the selected profile
is 1/f0.

1 Hz to the maximum supported by
the instrument, 100 kHz

Phase noise (RMS) Enter the phase in degrees for the
selected profile.

0.01 to 60 degrees, 3 degree

xxx

In the Frequency Profile method, you can provide five frequency points and define the phase noise in
dBc/Hz. The application adds phase noise with this profile to the signal. Set the following parameters
for Frequency Profile Model. The table displays five rows and you cannot delete or add new rows.
However, you can edit the values in the table.

Table 133: Frequency profile model parameters for phase noise
Selection Description Range, default value
Frequency Offset (± Hz) Displays five frequency offsets. Edit

the frequency values if needed.
1 Hz to the maximum supported by
the instrument
10 kHz, 100 kHz, 1 MHz, 10 MHz,
100 MHz

dBc/Hz Displays five phase noise values.
Edit the values if needed.

–50 to –80 dBc/Hz
–58, –71, –98, –118, –118

xxx

Distortion
Use the Distortion tab to quantize the signal to the specified bits (less than the maximum allowed by the
instrument). It reduces the resolution of the signal keep the peak-to-peak value same.

For a 4-bit DAC, the resolution is 2/24=0.125. All I, Q, and RF signals are quantized. This is useful when
you want to test your DUT with quantized data because the real hardware is of a lower DAC resolution.

1. Select Turn On to define quantization. (Select Turn On again to exclude quantization. By default,
Turn On is disabled.)

2. Enter the Resolution (in bits). The value ranges from 1 to the maximum instrument resolution and
the default value is 8.

RFXpress RFX100 User Manual 163



Creating an OFDM Signal S-Parameters

S-Parameters
Follow these steps to specify the scattering parameter for the signal:

1. Click the S-Parameters tab.

2. Select Turn On to include the scattering parameter for the carrier. (Select Turn On again to exclude the
scattering parameter. By default, Turn On is set to off.)

3. Select the mode: Non-Cascading or Cascading. In the non-cascading mode, you can apply S-parameter
characteristics on the signal from only one S-parameter file. In the cascading mode, you can cascade
up to six S-parameter files and apply the characteristics on the signal. You can select the files to apply
them by turning on or turning off the corresponding blocks shown in the display.

When the selected mode is cascading, all the selected files should be of the same type. The settings
depends on the selected type of file (*.s1p, *.s2p or *.s4p). The settings are common to all the files
(in cascading).

The default mode is Non-Cascading.

4. Select the bandwidth of the filter. Set it to Auto, Full Bandwidth, or Manual. In Manual, enter the
bandwidth in Hz. A bandwidth limit filter is applied to the response of the Touchstone file to limit the
bandwidth of the filter. The cutoff frequency of this bandwidth limit filter is calculated depending
on the selection.

5. Select Apply Inversion to invert magnitude and phase response given in S-parameter file. By default,
the Apply Inversion check box is disabled.

6. In the non-cascading mode, from the Read From File field, browse and select the file from which to
read the filter. The files supported are s1p, s2p, and s4p. In the cascading mode, select the files by
clicking inside the boxes and browsing to the file. Click On/Off to include or exclude the file.

7. Select the Touchstone 4-Port Data Type: Single-ended or Differential.

Files with data for four ports may contain single-ended or differential data. These are Touchstone
4-port files (s4p). By default, the application assumes the file to be single-ended data type. If the data
is single-ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21
parameter (for transmission of a differential signal) from the appropriate four S-parameters measured
using single-ended data.

8. Select the port for both transmitter and receiver from the drop-down list. Each drop-down list has ports
from 1 to 4. The default port number assignment is as follows:

Type Default port
Tx+ 1
Tx– 3
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Type Default port
Rx+ 2
Rx– 4
xxx

9. If the data is differential, you must select the data layout in the file: Typical or Alternate. By default,
RFXpress assumes the file to use the Typical data location format.

Using Presets
The Preset menu appears in the menu bar only in the OFDM module. This menu offers preset files that you
can use to create WiFi and WiMax signals according to standards.

To load a WiFi preset, do the following:

1. Select the setup from Preset > WiFi > 802.11a 36 Mbit/s QAM16. For more information on the setup,
refer to the WiFi standards.

2. Click Compile.

To load a WiMax preset, do the following:

1. Select a setup from Preset > WiMax. The following setups are available: 802.16-2004 Downlink
5 MHz QAM16, 802.16-2004 Downlink 10 MHz QAM64, and 802.16-2004 Downlink 20 MHz
QAM64. For more information on the setup, refer to the WiMax standards.

2. Click Compile.
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Understanding the Environment Interface
The Environment plug-in allows you create an environment signal. You can define the carrier magnitude
peak for an IF/RF signal or amplitude for an IQ signal. Each element that you choose from the list opens
a configuration box, where you can configure basic settings for interference parameters. Each signal
configuration box also includes a Configure button, which you can click to access options for advanced
configuration settings.

When you make changes in a signal configuration box, the two graphs at the bottom of the Signals tab
update to show the results.

You can add the following elements to an environment signal:

Generic Signal

UWB

Radar

OFDM

WiFi

WiMax

GSM

CDMA

W-CDMA

DVB-T

User Defined

Noise

Configuring Basic Settings for an Environment Signal
Follow these steps to configure basic settings for a signal type:

1. From the list of available elements, double-click or drag and drop the element you want to configure.

The configuration box for that element opens.

2. Modify the values of the following parameters:
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Table 134: Configuration box parameters
Item Description Range, default value
Carrier Magnitude
Peak/Amplitude

For an IF/RF signal, enter the amplitude of the carrier in dBm.
For an IQ signal, enter the amplitude in volts.

The range depends
on the instrument and
options installed, 0 dBm.

Turn On When selected, the interference parameters for the selected
signal are enabled.

Disabled

Carrier Frequency/Base-
band Offset

For an IF/RF signal, enter the carrier frequency of the signal. For
an IQ signal, enter the baseband offset.

For IF/RF and IQ signals:
the range and default
value depend on the
instrument used.

Power Sets the power level of the signal relative to zero reference. –80 dB to 0 dB, 0 dB
Start Time Enter the initial off time (start of the pulse from the reference) for

the pulse in ps, ns, μ, s, ms, or seconds.
0 to 1 s, 0 s.
The maximum value
depends on instrument
memory.

Duration Defines the actual signal duration. You can reduce this value but
not increase it. If you reduce the duration, the signal is truncated
until the specified duration.

Range: 0–1 s
Default: depends on
the interference signal
selected

Periodically Extend If you select the Periodically repeat for integer multiples only
check box in the Compile Settings dialog box for the Environment
plug-in, and the interference signal duration is less than the final
signal duration, then the signal is repeated X number of cycles
(where X is an integer) until its duration is less than or equal to
the final signal duration.
For information on the Periodically repeat for integer multiples
only check box, see Compile Settings for Environment Signal
(see page 74).

Unchecked

Anchor The overall duration of the final waveform is limited by the anchor
signal duration. If you specify the duration of the waveform
through the Compile Settings dialog box, then those settings
take precedence.

xxx

The following button is available:

Table 135: Configuration box buttons
Button Description
Configure Opens a dialog box where you can configure advanced settings for the element you have selected
xxx
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Advanced Settings for a Generic Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a Generic signal:

1. On the Generic Signal configuration box, click Configure.

The Generic Signal Configure window opens.

2. For information on this window, see Single Carrier (see page 79).

Advanced Settings for a UWB Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a UWB signal:

1. On the UWB configuration box, click Configure.

The UWB Configure window opens.

2. For information on this window, see Conformance Mode (see page 103).

Advanced Settings for a Radar Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a Radar signal:

1. On the Radar configuration box, click Configure.

The Radar Configure dialog box opens.

2. For information on this window, see Radar Configure (see page 76).
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Advanced Settings for an OFDM Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for an OFDM signal:

1. On the OFDM configuration box, click Configure.

The OFDM Configure window opens.

2. For information on this window, see Basic Setup (see page 157).

Advanced Settings for a WiFi Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a WiFi signal:

1. In the WiFi configuration box, click Configure.

The WiFi Configure window opens.

2. Modify the values of the following parameters:

Table 136: Advanced WiFi parameters
Item Description Default value
Standard Select the WiFi standard from the following: 802.11a, 802.11b,

and 802.11g.
802.11a

Data Rate Select the data rate that you require. The options available
change depending on the selection you made in the Standard
field. The data rate is associated with the type of Modulation, in
accordance with the 802.11 standard.

6 Mbps

PLCP Format Select the Preamble type. The options available change
depending on the selections you made in the Standard and
Data Rate fields.
The available options are Standard, Short, Long, SDSSS (Short
Direct Sequence Spread Spectrum), LDSSS (Long Direct
Sequence Spread Spectrum), and OFDM.

Disabled

Data Length Select the data length from the following: 40 bytes or 1024 bytes. 40 bytes
Offtime Defines the spacing between the packets Range is 1 μs to

1 second. Default is
1 μs

xxx
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Advanced Settings for a WiMax Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a WiMax signal:

1. On the WiMax configuration box, click Configure.

The WiMax Configure window opens.

2. Modify the values of the following parameters:

Table 137: Advanced WiMax parameters
Item Description Range, default value
Bandwidth Select the bandwidth the OFDM signal. The following values are

available: 1.25 M, 2.5 M, 5 M, 7 M, 10 M, 15 M, 20 M, and 28 M.
1.25 M to 28 M, 1.25 M

Modulation Select the modulation type from the following: BPSK, QPSK,
QAM 16, and QAM 64.

BPSK

Payload Select the payload length from the following: 4 symbols,
10 symbols, and 40 symbols.

4 symbols

Guard interval Displays the guard/cyclic prefix interval. The value is fixed at 1/4
(25%) of the symbol duration.

1/4

Offtime Defines the spacing between the packets 1 μs to 1 second, 1 μs
xxx

Advanced Settings for a GSM Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a GSM signal:

1. On the GSM configuration box, click Configure.

The GSM Configure window opens.

2. Modify the values of the following parameters:
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Table 138: Advanced GSM parameters
Item Description Default value
ARFCN This display-only field shows a value based on what you choose

in the Frequency Band field: either 100, 512, or 600.
ARFCN specifies a pair of physical ratio carriers and channels
used for transmission and reception.

None

Frequency band Specifies the cellular frequencies designated by the ITU. Select
the frequency band from the following: P-GSM_900, DCS_1800,
and PCS_1900.

P-GSM_900

Transmit device GSM networks consist of a Mobile Station (MS) and a
BaseStation Subsystem (BSS). Select the transmit device from
the following: Base and Mobile.

Base

Radio format Select the radio format from the following: GSM, EDGE,
EGPRS2A, and EGPRS2B.

GSM

The options in this list depend on what you chose for Radio
format:
Radio format Timeslot burst type

Normal
Frequency correction
Synchronization
Access

GSM
EDGE

Dummy

Timeslot burst type

EGPRS2A
EGPRS2B

Normal

Normal

The options in this list depend on what you chose for Radio
format:
Radio format Modulation
GSM GMSK
EDGE 8PSK-PI/4 rotation

16QAM-PI/4 rotationEGPRS2A
32QAM-PI/4 rotation
HSR 16QAM-PI/4 rotation
HSR 32QAM-PI/4 rotation

Modulation

EGPRS2B

HSR QPSK-3PI/4 rotation

GMSK
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Table 138: Advanced GSM parameters (cont.)

Item Description Default value
The options in this list depend on what you chose for Radio
format:
Radio format Modulation
GSM 157 symbols*2 timeslots,

156 symbols*6 timeslots
EDGE 156.25 symbols*8 timeslots
EGPRS2A 188.4 symbols*2 timeslots,

187.2 symbols*6 timeslots

Timeslot timing mode

EGPRS2B 187.5 symbols*8 timeslot

157 symbols*2 timeslots,
156 symbols*6 timeslots

Timeslot configuration Specifies the number of timeslots that are occupied. Select from
the following: All timeslots, 1 timeslot, and 047 timeslots.

All timeslots

xxx

Advanced Settings for a CDMA Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a CDMA signal:

1. On the CDMA configuration box, click Configure.

The CDMA Configure window opens.

2. Modify the values of the following parameters:

Table 139: Advanced CDMA parameters
Item Description Default value
Link Select the CDMA channel type from the following: Forward and

Reverse.
Forward

Number of channels Select the number of traffic channels from the following: 9, 12,
and 15.

None

Radio configuration Select the radio configuration from the following: RC1, RC2,
RC3, RC4, and RC5.

None
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Table 139: Advanced CDMA parameters (cont.)

Item Description Default value
The options in this list depend on what you chose in Radio
configuration:
Radio configuration Data rate (bps)

1200
2300
4800

RC1

9600
1800
3600
7200

RC2

14400
1500
2700
4800

RC3

9600
1500
2700
4800

RC4

9600
1800
3600
7200

Data rate

RC5

14400

None

xxx
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Advanced Settings for a W-CDMA Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a W-CDMA signal:

1. On the W-CDMA configuration box, click Configure.

The W-CDMA Configure window opens.

2. Modify the values of the following parameters:

Table 140: Advanced W-CDMA parameters
Item Description Default value
Link Select the link type from the following: Down and Up. Uplink
Down link mode Select the mode from the following: DPCH or TestMode 1–6.

This option is available when you select Down in the Link list.
Disabled

With CPICH channel Select this to include a CPICH channel. This option is available
when you select Down in the Link list and TestMode4 in the
Down Link Mode list.

Disabled

Number of HS-PDSCH
channels

Select the number of channels from the following: 4 and 8.
This option is available when you select Down in the Link list and
TestMode6 in the Down Link Mode list.

Disabled

Number of DPCH
channels

Select the number of channels, 1–6.
This option is available when you select Down in the Link list
and DPCH in the Down Link Mode list, or when you select Up
in the Link list.

Disabled

The options in this list depend on what you chose in the Link list:
Link Data rate

15 kbps
30 kbps
60 kbps
120 kbps
240 kbps
480 kbps

Up

960 kbps

Data rate

Down 30 kbps

30 kbps

xxx
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Advanced Settings for a DVB-T Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a DVB-T signal:

1. On the DVB–T configuration box, click Configure.

The DVB–T Configure window opens.

2. Modify the values of the following parameters:

Table 141: Advanced DVB-T parameters
Item Description Default value
Transmission In hierarchical modulation, two separate data streams are

modulated onto a single DVB-T stream. A high‐priority stream
(HP) is embedded in a low-priority stream (LP).
In nonhierarchical modulation, all the programs multiplexed
onto the transport stream effectively undergo the same channel
coding and mapping in the physical layer.
Select the transmission type from the following: Hierarchical and
Non-Hierarchical.

Hierarchical

Alpha If you chose hierarchical modulation as the transmission type,
you must allocate a value to the alpha modulation parameter.
Typical values are 1 (uniform modulation) and 2 or 4 (nonuniform
modulation).
Select the alpha from the following: 1, 2, and 4.

1

Mode Select the mode from the following: 2 K and 8 K. 2 K
Bandwidth Select the bandwidth from the following: 5 MHz, 6 MHz, 7 MHz,

and 8 MHz.
5 MHz

Modulation Select the modulation from the following:
Hierarchical transmission: 16 QAM and 64 QAM.
Nonhierarchical transmission: QPSK, 16 QAM, and 64 QAM.

16 QAM

Interleaver Select the interleaver from the following: Native and In-Depth. Native
xxx

Advanced Settings for a User Defined Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

Use the User Defined element to import any external signal to the environment. The imported signal could
be any of the file formats that RFXpress supports, or a previously created signal in the waveform list.

To configure advanced settings for a User Defined signal:
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1. On the User Defined configuration box, click Configure.

The Configure User Defined Signals window opens.

2. Modify the values of the following parameters:

Table 142: Advanced user-defined parameters
Item Description Range, default value
Format Select I/Q or IF/RF to specify the signal format of the file to be

added.
None

Add Interference via: Select Waveform List or File as the source of the interference. None
Waveform RF Available only when you choose IF/RF as the Format.

If you chose to add interference via Waveform List, click the
Waveform RF icon to open the Waveform List dialog box.
If you chose to add interference via File, click Browse to open
the File Import dialog box. In the File Import dialog box, select
IF/RF Data in the Data Type area.

Waveform I Available only when you choose I/Q as the Format.
If you chose to add interference via Waveform List, click the
Waveform I icon to open the Waveform List dialog box.
If you chose to add interference via File, click Browse to open
the File Import dialog box. In the File Import dialog box, select
I Data in the Data Type area.

Waveform Q Available only when you choose I/Q as the Format.
If you chose to add interference via Waveform List, click the
Waveform Q icon to open the Waveform List dialog box.
If you chose to add interference via File, click Browse to open
the File Import dialog box. In the File Import dialog box, select
Q Data in the Data Type area.

xxx

Using the Configure User Defined Signals dialog box creates combinations of signal formats. The options
you choose in the Format area and Add Interference via area must meet certain criteria. The following
table shows valid and invalid combinations.

Table 143: Valid combinations of signal addition
Selection in Format
area Selection in Add Interference via area

Valid or invalid
combination

IQ IQ Valid
IQ IF/RF Invalid
IF/RF IF/RF Valid
IF/RF IQ Valid
xxx
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Advanced Settings for a Noise Signal
Before you complete this procedure, you must configure basic settings for an Environment signal. See
Configuring Basic Settings for an Environment Signal (see page 167).

To configure advanced settings for a Noise signal:

1. On the Noise configuration box, click Configure.

The Noise Configure window opens.

2. Modify the values of the following parameters:

Table 144: Advanced noise parameters
Item Description Default value
Noise
White Adds white noise. White noise.
BandLimited Adds BandLimited noise. If you select this option, the Bandwidth

field becomes active.
White noise.

Bandwidth Available only if you choose BandLimited as the Noise type.
Enter a value to specify the bandwidth of the noise signal.

Range is 100 kHz to
half of the maximum
sampling rate of the
instrument. Default is
10 MHz.

Duration
Final waveform duration Choose this option to match the noise signal duration to the final

waveform duration.
Final waveform duration

User defined If you select this option, the Duration field becomes active. Final waveform duration
Duration Available only if you choose User Defined as the Duration type.

Enter a value to specify the duration, in seconds, of the noise
signal.

0 to 1 s, 10 μs

xxx

NOTE. If the Noise element is the anchor signal on the Signals tab, and if you choose Final waveform
duration in the Noise Configure dialog box (see previous table), then the noise signal duration is fixed at
1 ms.
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Controlling an Instrument
RFXpress can be used to control a connected instrument (for example a Tektronix oscilloscope or an
Agilent Performance Signal Generator E8267D with Option 015) in many ways: You can:

Install RFXpress on an AWG5000 or AWG7000 series instrument. RFXpress can directly send and
receive data from the AWG.

Install an offline version of RFXpress on a PC with an offline version of the AWG software. In this
case, RFXpress can detect the presence of the AWG and send data to it. This data can be opened and
viewed in the AWG.

Install RFXpress on a PC and use it to control an Agilent E8267D and any Tektronix oscilloscope. The
software uses TekVisa version 3.3.4.6 to interface with the Agilent E8267D and the oscilloscope. The
instruments can be connected using LAN or GPIB.

Follow these steps to find other instruments connected to the instrument on which RFXpress is running:

1. Click Find Instruments. The following dialog box opens.

The table lists the instruments found with the name of the instrument, model, status (connected or
not), and the connection type (Ethernet or GPIB).

2. Select an instrument from the table. Use the following buttons.
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Table 145: Find instruments options
Button Description
Connect Allows you to Connect to the instrument selected in the table. Enabled is default if an instrument is

highlighted in the table; disabled if no instrument is highlighted.
Disconnect Allows you to Disconnect the connected instrument. Enabled only when an instrument is connected.
Refresh Refreshes the list of instruments.
Import... (see
page 28)

Opens the Import from Tektronix Oscilloscope dialog box.

xxx

3. Click Connect to connect to the selected instrument.

Controlling an Arbitrary Waveform Generator (AWG)
Waveform transfer and control of the AWG5000 or AWG7000 series can be performed directly from
RFXpress. You can run the software on an AWG5000 or AWG7000 series arbitrary waveform generator
and control it.

1. Select Window > Instrument Control.

2. From the AWG tab, you can modify the values of the following AWG parameters:

Table 146: AWG parameters
Selection Description Default value
Sampling Rate Displays the sampling rate of the arbitrary

waveform generator.
The default is as set in the AWG.

Interleave (see
page 221)

Sets the interleave option to On or Off. Off

Zeroing (see page 223) Enabled only when Interleave is set to On. Cleared or unchecked.
Channel (On/Off) Select the channel or channels to receive the

output from these channels.
This depends on the number of channels
present on the AWG.

Amplitude (Vpp) Displays the amplitude of the selected
channel. Change the amplitude in this field
to change the amplitude on the channel.

The default is as set in the AWG.

Offset (V) Displays the amplitude offset of the selected
channel. Change the amplitude in this field to
change the amplitude offset on the channel.

The default is as set in the AWG.

Waveform button Opens the Waveform List and allows you to
select the waveform to be output.

Cleared or unchecked.

Waveform Displays the selected waveform name. You
can drag and drop the waveform from the
Waveform List. When you drag and drop a
waveform, the sampling rate is automatically
set.

N/A

xxx
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The following button is available:

Table 147: AWG option
Button Description
Advanced Opens a dialog box where you can set the advanced options.
xxx

3. When you click Advanced, the following options are available for each channel:

Table 148: Advanced AWG parameters
Selection Description
DAC Resolution
8 bits Sets the DAC resolution to 8 bits.
10 bits Sets the DAC resolution to 10 bits. When the DAC resolution is set to 10 bits, the marker options

are not available.
Markers (M1 and M2)
High (V) Enter the high value for the markers.
Low (V) Enter the low value for the markers.
Delay (s) Enter the maker delay.
xxx

NOTE. When connected to the AWG5000 series instruments, DAC resolution is fixed to 14 bits and cannot
be changed.
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Connecting to and Controlling an Oscilloscope
You can connect to and control a Tektronix oscilloscope using RFXpress.

1. Select Window > Instrument Control.

2. A table lists the connected oscilloscopes. From the Oscilloscope tab, you can modify the values of the
following oscilloscope parameters:

NOTE. Ensure that the Sampling mode on the oscilloscope is set to Real Time. If the Sampling mode is set
to Interpolation (either automatically or manually), the parameter values in RFXpress Instrument control
and the oscilloscope may not match.

Table 149: Oscilloscope parameters
Selection Description
Vertical settings
Channel Displays the channel to which to output the signal. To change this setting, select another

channel.
Scale (V) Displays the vertical scale set in the oscilloscope for the selected channel. Change the value in

this field to change the vertical scale on the connected instrument.
Horizontal settings
Scale (s) Displays the horizontal scale set in the oscilloscope. Change the value in this field to change

the horizontal scale on the connected instrument.
Record length Displays the record length set in the oscilloscope. Change the value in this field to change the

record length on the connected instrument.
Sampling rate
(Samples/sec)

Displays the sampling rate set in the oscilloscope. Change the value in this field to change the
sampling rate on the connected instrument.

Acquisition
Run Starts the acquisition of data in on the oscilloscope.
Stop Stops the acquisition of data on the oscilloscope.
Single Sets the oscilloscope to acquire one full record length and then stop.
xxx

The following buttons are available in this tab:

Table 150: Oscilloscope options
Button Description
Autoset Performs Autoset on the oscilloscope.
Refresh Settings Refreshes the display with the current instrument settings.
Refresh List Refreshes the connection status of the instruments.
Find Instruments Finds instruments on the network.
xxx
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Connecting to and Controlling a Performance Signal Generator (PSG)
You can connect to and control an Agilent performance signal generator (E8267D with Option 015)
using RFXpress.

1. Select Window > Instrument Control.

2. In the PSG tab, the following parameters as set on PSG are displayed. However, you can modify the
values of the PSG parameters:

Table 151: PSG parameters
Selection Description
Signal
Frequency (GHz) Displays the frequency of the signal. Change the frequency in this field to change the

frequency on the connected instrument.
Frequency offset (Hz) Displays the frequency offset of the signal. Change the frequency offset in this field

to change the frequency offset on the connected instrument.
Amplitude (dBm) Displays the amplitude of the signal. Change the amplitude in this field to change the

amplitude on the connected instrument.
Amplitude offset (dB) Displays the amplitude offset of the signal. Change the amplitude offset in this field

to change the amplitude offset on the connected instrument.
Output
RF Select On to set the output format of the signal to RF.
Mod Select On to set the output format of the signal to MOD.
xxx

The following buttons are available:

Table 152: PSG options
Button Description
Advanced Opens a dialog box where you can set the advanced options.
Refresh Refreshes the display with the current instrument settings.
Test Connection... Checks the state of the connection and displays the status.
Find Instruments Finds instruments on the network.
xxx

3. When you click Advanced, the following options are available:
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Table 153: Advanced PSG parameters
Selection Description
Signal
Source Type Displays the source type of the signal. To change this select one of the following:

EXT, INT, BBG1, EXT600, and OFF.
Frequency Mode Displays the frequency mode of the signal. To change this, select on of the following:

FIX, CW, SWE, and LIST.
ALC
ALC: On, Off Sets ALC to On or Off.
ALC Mode Displays the ALC mode of the signal. To change this, select on of the following:

FIX, SWE, and LIST.
ALC Bandwidth (Hz) Displays the ALC bandwidth.
ALC Level (dBm) (Volts) Displays the ALC level.
ALC Power Displays the ALC power of the signal. To change this, select on of the following:

ON, OFF, and ONCE.
Attenuation (dB) Displays the attenuation.
Carrier Leakage Suppression
IQ State When set to On, suppresses the IQ State.
IQ Adjustment When set to On, suppresses the IQ Adjustment.
I Offset (volts) Offsets the I signal.
Q Offset (volts) Offsets the Q signal.
xxx

You must click Refresh to update any new settings on the performance signal generator.
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Connecting to a Real-Time Spectrum Analyzer
You can connect to a Tektronix Real-time Spectrum Analyzer (RSA) and use it directly from the
application. You can change the values of the RTSA parameters that are enabled only when the RTSA
is in the online mode.

Follow these steps to establish the Ethernet connection:

1. Establish communication between RFXpress and RSA using a crossover Ethernet cable. You can
also use an Ethernet router or switch.

2. Set the Firewall option on the real-time spectrum analyzer to Off before connecting to it.

3. Test the connection by "pinging" each unit from the other in a "DOS" command window.

4. Use Windows file sharing allows the AWG and RFXpress to directly load TIQ files that are physically
located on the RSA.

NOTE. When communicating with an RSA3000 series spectrum analyzer, the spectrum analyzer must have
write permission on the PC/AWG running RFXpress application.

Follow these steps to establish the TekVISA connection:

1. Ensure that the same version of TekVISA is installed on both the AWG and the RSA.

2. On the RSA, start the VXI-11 Server.

3. On the AWG, open the Instrument Manager application and search for VISA devices by clicking the
Update button. You can also specify the search criteria to locate the instruments.

4. Select the RSA instrument and click ID.

In RFXpress, do the following:

1. Select Window > Instrument Control.

2. Click the RSA tab. A table lists the available real-time spectrum analyzers. Click the List RSA
button to refresh the table.

The following buttons are available:

Table 154: RSA options
Button Description
Preset Resets the instrument settings to the factory defaults. This button is enabled only

after selecting a connected real-time spectrum analyzer from the table.
Refresh Updates settings on the selected instrument on to the real-time spectrum analyzer.

This button is enabled only after selecting a connected real-time spectrum analyzer
from the table.
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Table 154: RSA options (cont.)

Button Description
List RSA Lists the connected instruments once the real-time spectrum analyzer is found and

connected using the Find Instruments dialog box.
Acquire Imports I & Q trace data from the instrument and I & Q waveforms in the waveform

list. This button is enabled only after selecting a connected real-time spectrum
analyzer from the table.

xxx

3. The Settings tab contains controls to set the values of the parameters present in the Settings tab of
the RSA when the “RF I & Q vs Time” display is shown and selected. In the Settings tab, set the
following parameters:

Table 155: Settings parameters
Selection Description
Center Frequency (Hz) Enter the center frequency on the RSA.
Start Frequency (Hz) Enter the start frequency on the RSA.
Stop Frequency (Hz) Enter the stop frequency on the RSA.
Step Size (Hz) Enter the step size on the RSA.
Span Enter the span.
Max Trace Points Set the maximum trace points setting for IQVTime graph in

the RSA. The choices are:

1 K sets the maximum trace points to 1 K.

10 K sets the maximum trace points to 10 K.

100 K sets the maximum trace points to 100 K.

Never decimate never limits the trace points.
Auto Enable Auto to set the step size automatically. When the

state is changed from enabled to disabled, the instrument
resets the parameter value of Step Size.

Set as Baseband This option is available and displayed only when the active
module is Generic Signal. This is used to set the imported
I and Q waveforms directly as baseband signals in the
multi-carrier table.

xxx

NOTE. Alternately, to read a TIQ file that was saved on the RSA, you can select File > Import from file…
and navigate to the shared folder on the RSA to read the file directly.

4. The Acquire tab is enabled only when a real-time spectrum analyzer is connected. Set the following
parameters:
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Table 156: Acquire parameters
Selection Description
Run Select the mode of the instrument to either Continuous,

Single, or Stop.

NOTE. Selecting Stop forces any ongoing acquisition to
stop. Pressing Acquire after choosing this option, does not
force a new acquisition while importing IQ data. The IQ
data loaded into the spectrum analyzer acquisition memory
using a file can be directly imported .

Waveform Name Enter the names of the imported I and Q waveforms.
The default name provided is Untitled1. The imported I
and Q waveforms will have the names Untitled1_I and
Untitled1_Q.

Adjust Set the acquisition mode: All Auto, Samples, and Length.

All Auto disables the controls Acq BW, Acq Samples,
and Acq Length.

Samples enables the controls Acq BW, Acq Samples
and disables Acq Length.

Length enables the controls Acq BW, Acq Length, and
disables Acq Samples.

The values of all the three parameters are sometimes
reset by the instrument. These values are queried from
the instrument and updated.

Acq BW (Hz) Set the acquisition bandwidth of the instrument.
Acq Samples Set the number of samples acquired over the acquisition

time of the instrument.
Acq Length (s) Set the time over which the acquisition occurs in the

instrument.
xxx

5. The Analysis tab is enabled only when a real-time spectrum analyzer is connected. Set the following
parameters:

Table 157: Analysis parameters
Selection Description
Analysis Offset Set the analysis offset time of the instrument.
Analysis Offset Auto The analysis offset field is disabled when this check box is

selected.
Analysis Length Set the analysis length of the instrument.
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Table 157: Analysis parameters (cont.)

Selection Description
Analysis Length Auto The analysis length field is disabled when this check box is

selected.
When the check box state is enabled (checked), the
instrument resets the analysis length parameter value.
Whenever this parameter value is changed, the values of
Acq BW, Acq Length and Acq Samples are queried and
updated.

Time Zero Ref Select the analysis time reference:

Acq Start specifies the acquisition start as the time
zero reference.

Trigger specifies the trigger point as the time zero
reference.

Amplitude
Ref Level Set the amplitude level in the instrument.
Units Sets the amplitude fundamental unit of power to: dBm, dBV,

Volts, Watts, dBμW, dBW, dBμV, dBmV, dBμA, dBμV/m,
dBμA/m, and Amps.

xxx

Controlling an Arbitrary Waveform Generator from the Radar Application
The radar application requires the sequence mode feature of AWG. The instrument control feature has all
the necessary controls to use the sequence mode of AWG directly from the application.

Instrument control provides two views:

The Settings view (see page 189) which contains controls to set up the channel information

The Sequence view (see page 189) which contains controls to set up the table, trigger, and event

In both views, you can click the Advanced button to set the marker values for each channel.

Table 158: Advanced AWG options
Selection Description
DAC Resolution
8 bits Sets the DAC resolution to 8 bits.
10 bits Sets the DAC resolution to 10 bits. When the DAC resolution is set to 10 bits, the marker options

are not available.
Markers (M1 and M2)
High (V) Enter the high value for the markers.
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Table 158: Advanced AWG options (cont.)

Selection Description
Low (V) Enter the low value for the markers.
Delay (s) Enter the maker delay.
xxx

Settings View
When you select the application by default the Settings view is displayed in the Instrument Control tab.
Controls to change the values of parameters related to AWG are available. These controls are enabled
only if the AWG is in the online or offline mode. The channel controls that appear depend on the AWG
model. The following controls are available in the Settings view:

Table 159: Settings view options
Control Description State
Sampling Rate Enter the sampling rate. This is used

to set the sampling rate of the AWG.
Enabled for the AWG online and
offline versions.

Interleave On/Off If the Interleave option is on, the
AWG will output the signal from the
Interleave channel.

Enabled when the AWG has Opt
06 installed.

Zeroing This option allows you to handle each
waveform as RZ (Return to Zero) or
NRZ (Non Return to Zero).

This option is enabled only if the
Interleave option is enabled and set
to On.

Chx Select this check box to set the output
of channel to On or Off. Depending on
the AWG model, x is be the channel
number.

The channel group box appears only
if the AWG model has the channel
number.

Amplitude Enter the amplitude. This is used to
set the Amplitude for the waveform
output from the channel.

If the waveform is visible it is always
enabled.

Offset Enter the offset. This is used to set
the offset to the signal.

This option is enabled only if Opt 06 is
not available.

xxx

Sequence View
The Sequence view allows you to control the parameters related to the sequence window of the AWG.
You are able view these settings only if the AWG is in online or offline mode. The following controls are
available in the Sequence view:
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Table 160: Sequence view options
Control Description State
Sampling Rate Enter the sampling rate. This is used

to set the sampling rate of the AWG.
Enabled for the AWG online and
offline versions.

Interleave On/Off If the Interleave option is on, the
AWG will output the signal from the
Interleave channel.

Enabled when AWG has Opt 06.

Zeroing This option allows you to handle each
waveform as RZ (Return to Zero) or
NRZ (Non Return to Zero).

This option is enabled only if the
Interleave option is enabled and set
to On.

xxx

The sequence table allows you to set the waveforms for the channel in a sequence and generate waveforms
one after the other depending on the sequence. The table behavior is similar to the table view of Sequence
run mode.

Table 161: Sequence table options
Control Description State
Index This column indicates the order in

which the waveform is output from the
channel.

Always enabled but cannot be edited.

Chx Waveform This column indicates the waveform
that is being generated for the
particular channel. The number of
columns representing this information
will depend on the channels supported
by the AWG.

Always enabled.

Wait This column allows you to set the wait
to On/Off. If you set the wait to On,
then the waveform is played after the
wait trigger has occurred.

Always enabled.

Repeat This column allows you to specify
a value that is used to repeat the
waveform before going to the next
waveform in the sequence. You can
also choose to repeat the waveform
infinitely.

Always enabled.

Event Jump To This column allows you to specify a
value which is used to specify the
jump destination when an event takes
place.

Always enabled.

Go To This column allows you to specify a
value which is used to specify the
jump destination after this waveform
is output.

Always enabled.

xxx

The following buttons are available: Advanced (see page 188), Trigger (see page 191), and Event (see
page 191).
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Trigger Options
You can click the Trigger button in Sequence view to set trigger source. The trigger source provides
the signal that triggers waveform output action.

Table 162: Trigger options in the sequence view
Option Description State
Internal Select this to specify that the trigger

source is internal.
Always enabled.

Interval Enter the interval for internal trigger. Enabled only if Internal is selected.
External Select this to specify that the trigger

source is external.
Always enabled.

Level Enter the trigger level. The trigger
level determines the voltage level
where the trigger point occurs.

Enabled only if External is selected.

Slope Select the trigger slope: Positive
or Negative. The trigger slope
determines whether the instrument
finds the trigger point on the rising
edge or falling edge of the signal.

Enabled only if External is selected.

Impedance Select the impedance. It specifies
external trigger impedance (50 Ω or
1 KΩ).

Enabled only if External is selected.

xxx

Event Options
You can click the Event button in Sequence view to set event controls.

Table 163: Event options in the sequence view
Option Description State
Level Set the external event input threshold

level.
Always enabled.

Polarity Select the polarity of external event
input signal: Positive or Negative.

Always enabled.

Jump Timing Select the jump timing: Async or Sync. Always enabled.
Event Impedance Select the event impedance: 50 Ω or

1 KΩ.
Always enabled.

xxx
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Graphing Zooming Graphs

Zooming Graphs
You can zoom in or zoom out on a graph. You can zoom in on a plot by selecting an area of interest.
RFXpress supports four levels of zoom.

The following graphs provide zoom buttons that help you zoom the plot:

Spectrum (see page 196)

I(t), Q(t) (see page 194)

See also:

Graph (see page 30)

Pulse Shape
The pulse shape graph shows the plot of Points (X-axis) and Amplitude (Y-axis).
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I(t), Q(t)
The I (t), Q(t) graph shows two plots: Points (X-axis) against Inphase(t) (Y-axis), and Points (X-axis)
against Quadrature(t) (Y-axis).

The cursor readouts show the X and Y values and delta of the cursor positions. Moving the cursors
causes the cursor readouts and the delta values to be updated. You can also specify the points values in
the fields to position the cursors. This graph is available for the Generic, UWB-WiMEdia, Radar, and
OFDM applications.

The following controls are available:

Zoom In. Click Zoom In. Select an area on the plot to zoom in on. You can use the horizontal scroll
bar to scroll through the plot while in the zoom mode.

Zoom Out. Click Zoom Out to zoom out in the same manner that you zoomed in.
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CCDF Plot
The CCDF graph shows the plot of dB over Average Power (X-axis) and % of Time (Y-axis). The readouts
show the % of Time, the dB over Average Power, and the Crest Factor. You can specify the dB over
Average Power value in the field to position the cursor.
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Graphing Spectrum

Spectrum
The Spectrum graph shows a plot of Frequency (MHz) on the X-axis and Amplitude (dB) on the Y-axis.
The Cursor 1 and Cursor 2 positions, and the Delta (between the cursor positions) are displayed. Moving
the cursors causes the cursor readouts and the delta values to be updated. You can also specify the
frequency values in the fields to position the cursors. The number of FFT points (8192) and average points
are also shown. This graph is available for the Generic, UWB-WiMedia, Radar, and OFDM applications.

The following controls are available:

Zoom In. Click Zoom In. Select an area on the plot to zoom in on. You can use the horizontal scroll
bar to scroll through the plot while in the zoom mode.

Zoom Out. Click Zoom Out to zoom out in the same manner that you zoomed in.

Averaging
If the number of sample points is high, you can use the Average field to enter a value and average the FFT
data. The value entered in the average field can range from 1 to 1024.
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Constellation Plotting
The constellation graph shows the plots of Points (X-axis) against I and Q (Y-axis). It is a graphical
representation of permissible modulation states at the I/Q level.
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Eye Diagram
The Eye Diagram shows the plots of Points (X-axis) against I and Q (Y-axis).
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Graphing Spectrogram

Spectrogram
The Spectrogram is available for all the applications.

It is a 3-dimensional plot with Frequency along the X axis, Time along the Y axis, and the Amplitude of the
point shown by the brightness of the color. The points with the highest amplitude are plotted in red and the
points with lowest amplitude are plotted in blue. The color palette containing the color grading is shown
on the right of the plot. The palette also shows the highest amplitude values present in the spectrogram.

The frame size can be selected to specify the chunk size to be used while plotting the frequency
spectrogram. On clicking the Refresh button, the spectrogram is re-plotted based on the chunk size.
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FFT of Coherent Pulse Interval
The FFT of Coherent Pulse Interval (CPI) is available only for the radar application. It is a 3-dimensional
plot with Frequency on X axis, Time on Y axis, and Amplitude on Z axis. This plot gives a 3-dimensional
representation of a radar pulse. The number of pulse repeats must be greater than four for plotting the
coherent pulse interval (CPI) of a pulse. The pulse should have no impairments or modulation specified.
This plot is only applicable for IQ waveforms and not IF/RF waveforms.
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Error Messages for Generic Signal
Error message Description Possible solution
Waveform Errors
Error generating waveform. An exception occurred while running

the application.
Restart the application.

Waveform does not exist. Operation in an illegal state. Delete all the waveforms.
Memory failed. Operation in an illegal state.

Memory overflow.

Try one of the following:

Restart the application.

Free space on the hard disk.
Data not found. Accessing data beyond range. Delete all the waveforms.
Invalid size. The waveform length is beyond the

range.
Check the range help page for valid
range.

Maximum number of waveforms:
13000.

The limit of 13000 is reached on
completing the selected operation.

Delete waveforms which are not in
use.

Invalid sampling rate. The clock rate from the file is incorrect. Check the format of the file being
imported.

Unable to access data. The application is the invalid state. Restart the application.
Generic Signal Errors
Symbol Map table cannot be empty. The table should have valid entries. Check the parameters in the

Modulation Symbol map table.
Maximum number of carriers: 1024. The maximum carriers that can

be generated by the application is
reached.

Delete the carriers that are not in use.

No carrier available. At least one carrier is required to
produce data.

Try one of the following:

Add at least one carrier to the
table.

At least one carrier should have
the State turned 'ON'.

User defined file name cannot be
empty.

Valid files need to be present. Valid files need to be present.

File does not exist. The file does cannot be found. The
file may be deleted.

Select existing files.

The interference input signal
waveforms cannot be the same as the
compile waveforms.

The waveform is overwritten. Try one of the following:

Select a different name for the
compilation waveform.

Rename the waveform in the list
and select the waveform again.

Base data file not found. The file was deleted after updating the
setup.

Select existing base data files.
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Error message Description Possible solution
Filter file not found. The user defined filter file was not

selected.
Select a user defined filter file.

Modulation Symbol file not found. The user defined symbol file was not
found.

Select a user defined symbol file.

Modulation Sample file not found. The user defined sample file was not
found.

Select a user defined sample file.

Maximum total symbols: 512. The total number of symbols of 512 is
exceeded.

N/A

Error on parsing PRBS polynomial. The PRBS polynomial syntax is
incorrect.

Enter the correct PRBS polynomial.

Symbol rate should be less than
carrier frequency.

The specified symbol rate is greater
than the carrier frequency.

Enter a symbol rate that is less than
the carrier frequency.

The entries cannot have the same
symbol values.

No two entries in the power ramp table
can have the same symbol values.

Enter unique symbol values for each
entry in the table.

Port selected in the S-parameter file
is not supported.

The port selected in the S-parameter
file is not supported.

Select a port (one, two, or four) that
is supported.

Sub-carrier frequency should be
greater than the maximum of the
individual carrier frequencies.

Enter a frequency that is greater than
the maximum carrier frequency.

S-parameter file has an invalid port.
RFXpress supports one, two, and four
port networks.

The port in the S-parameter file is not
supported.

Select a port (s1p, s2p, or s4p) that
is supported.

Not a valid S-parameter file. The S-parameter is invalid. Select a valid S-parameter file.
Invalid option line in the S-parameter
file.

The option line in the S-parameter file
is incorrect.

Ensure that the option line in the
S-parameter file is correct.

Not a valid one/two/four-port
S-parameter file.

The files provided are invalid
S-parameter files.

Provide valid one-, two-, and four-port
S-parameter files.

S-parameter file does not exist. The entered file does not exist. Enter a file that exists.
No two physical ports assigned for
a single-ended connection can be
same.

In a four-port TouchStone file, a port is
assigned to a physical location more
than once.

Assign each port to a unique location.

The number of points in the
S-parameter file exceeds the
maximum number of points (32769).

Reduce the number of points in the
S-parameter file.

The number of points in the
S-parameter file does not have the
minimum number of points (1).

The number of points must be
nonzero.

All the cascading files need to have
the same number of ports.

The S-parameter files provided for
cascading do not have the same
number of ports.

Ensure that all the files have the same
number of ports (s1p, s2p, or s4p).
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Error message Description Possible solution
S-parameter cascading should at least
have one S-parameter file enabled.

S-parameter cascading requires at
least one file to be available.

Enable at least one file for S-parameter
cascading.

S-parameter file does not exist for File
{0}.

The S-parameter file(s) specified for
cascading does not exist.

Ensure that the specified S-parameter
file exists.

xxx

Error Messages for UWB-WiMedia
Error message Description Possible solution
Length of arrays does not match the
size in RFC file.

The correction file may be corrupt. Calibrate again.

Select at least one band for calibration. The band data is required for
calibration.

Select at least one band.

Enter valid correction file path in Ch
N tab.

The path does not exist. Select an existing file path.

Select at least one channel to apply
corrections.

Choose the channel to which the
calibration should be applied.

N/A

Select both the channels to apply
corrections.

IQ Signal format requires two channels
for signal generation.

Select appropriate I and Q channels.

Initialization for the test signal
generation is failed.

Invalid parameters were used. Rerun the calibration after closing and
opening the window.

Error in generating Test Signal. The test signal file was corrupt. Restart the application.
Failed to set calibration signal
parameters.

Invalid parameters were used. Rerun the calibration after closing and
opening the window.

Initialization for the reference signal
generation has failed.

Invalid parameters were used. Rerun the calibration after closing and
opening the window.

Error in generating Reference Signal. The reference signal file was
corrupted.

Restart the application.

Error in setting Reference Signal. Invalid parameters were used. Rerun the calibration after closing and
opening the window.

Failed to set oscilloscope parameters.
Error in acquiring signal from
oscilloscope.
Error in setting oscilloscope signal.
Error in averaging the signal.

The oscilloscope communication was
not successful.

Check the oscilloscope connections.
Try one of the following:

Refresh the list in Find
Instruments window.

Refresh the TekVisa instrument
manager.

Close the application. Restart
TekVisa. Restart the application.

Restart the oscilloscope.
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Error message Description Possible solution
Correction file does not exist. Please
calibrate to generate correction files.

Correction files need to be given if
correction is chosen.

Try one of the following:

Select existing correction files to
apply for correction.

Choose not to give correction
files.

Invalid correction file. Correction file format is incorrect. Apply valid correction files.
Correction file not found. The correction file was deleted after

updating the values in window.
Select existing correction files.

Compilation aborted. One or more
user defined file(s) does not exist.

The user defined payload data source
file in the conformance mode is
incorrect.

Select the correct payload data source
data file.

Payload file does not exist. Payload data source user defined file
custom mode is incorrect.

Select the correct payload data source
data file.

No packets present in the current
configuration.

At least one packet is necessary for
generating data.

Select at least one valid packet.

Compilation aborted. The correction files do not match with
the selected channel.

Calibrate and choose appropriate
correct correction files.

xxx

Error Messages for Radar
Error message Description Possible solution
Cannot delete all pulse elements. At
least one pulse should be present.

At least one pulse must be present in
the pulse train. You cannot delete all
the pulses.

Maintain at least one pulse in the
pulse train.

Cannot cut all pulse elements. At least
one pulse element should be present.

At least one pulse must be present in
the pulse train. You cannot cut all the
pulses.

Maintain at least one pulse in the
pulse train.

Maximum number of phase codes
reached.

You can add N number of steps for
“User defined codes” modulation.
When N is exceeded, this message
indicates that the maximum number of
steps than can be added is reached.

N/A

Maximum number of nonlinear
coefficients reached.

You can add N number of steps for
“Nonlinear FM” modulation. When N
is exceeded, this message indicates
that the maximum number of steps
than can be added is reached.

N/A

Maximum number of steps reached. You can add N number of steps for
“User Defined Step FM” modulation.
When N is exceeded, this message
indicates that the maximum number of
steps than can be added is reached.

N/A
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Error message Description Possible solution
Reached maximum number of pulse
elements.

This message appears when you try
to add pulse elements that exceed the
maximum capacity of the pulse table.

N/A

Cannot add more than 100% of pulse
width (inclusive of rise and fall times).

This message appears when you try
to add a duration less than or greater
than 100% of the pulse width for
the modulation types “User Defined
Codes” or “User Defined Step FM”.

Ensure that the sum of subdurations
of all steps is 100% of pulse width.

RFXpress cannot compile. At least
one pulse element should be present.

This message appears when you try
to compile without having at least one
pulse in the pulse table.

Maintain at least one pulse in the
pulse train.

RFXpress cannot compile. Enough
memory is not available on application
drive.

This message appears when the
memory required to generate the
waveform is not available in the drive
where the application is running.

Increase the free space in the drive
where the application is running.

RFXpress cannot compile. Could not
create temporary files.

This is an internal error. Try compiling again or restart the
application.

Memory clean up failed. This is an internal error. Try compiling again or restart the
application.

Modulation is not set for the entire
pulse width (inclusive of rise and fall
times).

This message appears when you set
the modulation to User Defined Codes
or User Defined Step FM and define
the steps for only part of the duration.

Set the modulation width to 100% of
the pulse width.

Memory initialization failed. This is an internal error. Try compiling again or restart the
application.

RFXpress cannot compile. The
waveform length is longer than the
maximum supported length of the
instrument.

This message appears when you try
to compile a waveform that is longer
than the maximum supported length.

Change the values of the pulse
parameters or sampling rate.

RFXpress cannot compile. The
waveform length is shorter than the
minimum supported length of the
instrument.

This message appears when you try
to compile a waveform that is shorter
than the minimum supported length.

Change the values of the pulse
parameters or sampling rate.

RFXpress cannot compile. At least
one deviation in staggered PRI should
be present.

This message appears when you
set Staggered PRI to User Defined
but do not add any deviations before
compiling.

Add at least one deviation.

RFXpress cannot compile. At least
one nonlinear FM coefficient in
modulation should be present.

This message appears when you set
Modulation to Nonlinear FM but do not
add any coefficients before compiling.

Add at least one coefficient.

Custom pulse shape file for pulse
group <x> is not found.

This message appears when you set
Pulse Shape to Custom, provide a
file which does not exist, and try to
compile.

Enter an existing file.
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Error message Description Possible solution
Custom modulation file for pulse group
<x> is not found.

This message appears when you set
pulse Modulation to Custom, provide
a file which does not exist, and try to
compile.

Enter an existing file.

Custom pulse shape file for pulse
group <x> is invalid.

This message appears when you
select pulse shape as custom, provide
a file which is invalid, and try to
compile.

Enter a valid file.

Custom modulation file for pulse group
<x> is invalid.

This message appears when you
select pulse modulation as custom,
provide a file which is invalid, and try
to compile.

Enter a valid file.

The number of samples in the custom
pulse shape file for pulse group <x>
exceeds the maximum number of
samples.

This message appears when you
select pulse shape as custom,
provide a file in which the number
of points/values exceeds the points
expected, and try to compile.

Reduce the number of samples in the
file. The maximum number of samples
is 1 M.

The number of samples in the custom
modulation file for pulse group <x>
exceeds the maximum number of
samples.

This message appears when you
select pulse modulation as custom,
provide a file in which the number
of points/values exceeds the points
expected, and try to compile.

Reduce the number of samples in the
file. The maximum number of samples
is 1 M.

RFXpress cannot compile. At least
one hopping offset should be present.

This message appears when the pulse
hopping feature is turned on and no
hopping value is added to the table.

Either turn off the hopping feature or
add hopping values to the table.

The total number of hops cannot
exceed the pulse repeat value.

This message appears when you
try to add more hops than the pulse
repeat value.

To add more hops, increase the repeat
value for each pulse.

The total number of hops cannot
exceed eight hops.

The maximum number of hops is
eight. This message appears when
the try to add more than eight hops.

The maximum number of hops is
eight. You cannot add more than this.

RFXpress cannot compile. The
waveform length is longer than the
maximum supported.

This message appears when you try
to compile a waveform that is longer
than the maximum supported length.

Reduce the waveform length.

RFXpress cannot compile. The
waveform length is shorter than the
minimum supported.

This message appears when you try
to compile a waveform that is shorter
than the minimum supported length.

Increase the waveform length.

Maximum number of staggered PRI
deviations cannot exceed the repeat
value.

This message appears when you set
Staggered PRI to User Defined and
then try to add deviations that exceed
the number of pulse repeats.

The number of PRIs cannot exceed
the repeat value.

Invalid MATLAB file. It should have
the sampling rate and waveform
samples. Refer to the online help for
the file format.

This message appears when you try
to import an invalid MATLAB file.

Use a valid file.
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Error message Description Possible solution
RFXpress cannot compile. Tr is less
than zero.

This message appears when the rise
time is negative. The application
cannot create samples for this value.

Change the sampling rate or increase
the rise time.

RFXpress cannot compile. Tf is less
than zero.

This message appears when the fall
time is negative. The application
cannot create samples for this value.

Change the sampling rate or increase
the fall time.

RFXpress cannot compile. Ton is less
than zero.

This message appears when the pulse
width time is negative. The application
cannot create samples for this value.

Change the sampling rate or increase
the pulse width time.

RFXpress cannot compile. Offtime is
less than zero.

This message appears when the
offtime is negative. The application
cannot create samples for this value.

Change the sampling rate or increase
the offtime.

RFXpress cannot compile. Start time
is less than zero.

This message appears when the start
time is negative. The application
cannot create samples for this value.

Change the sampling rate or increase
the start time.

Compilation failed. This message appears when the
application was unable to compile the
waveform.

Report the problem to customer
support attaching the log.txt file and
error code.

RFXpress cannot compile.
Resampled data too large. Increase
custom sampling rate or reduce file
size.

This message appears when the
custom file size is too big and
RFXpress cannot handle resampling
of so much data.

Reduce file size or the sampling
frequency.

RFXpress compilation failed. Mem
mapped file not found.

This message appears when the
memory mapped files are not found.

Make sure files are not deleted and
recompile.

RFXpress compilation failed. Sample
rate might not be good enough.

This message appears when the
sample rate calculated is less than
2.5 times the highest frequency to be
generated.

Reduce the frequency and recompile.

RFXpress compilation failed.
Waveform Length too short, increase
sampling rate or the PRI.

This message appears when the
number of samples required to create
this file is less than minimum waveform
length required by instrument.

Increase the sampling rate and
recompile.

Compilation aborted. This message appears when you
cancel the compilation.

N/A

Subpulse time too small. This message appears when the
subpulse time is too small to create
any samples.

Increase the pulse width or decrease
the number of subpulses.

RFXpress cannot compile. The
waveform length is shorter than the
minimum supported for pulse group X.

This message appears if any one of
the pulse groups in the pulse train is
shorter than the minimum waveform
length.

Increase the sampling rate or change
the pulse parameters.

RFXpress compilation failed. Could
not combine all waveforms.

This is an internal error that occurs
when combining waveforms.

Recompile the waveform.

RFXpress compilation failed. Could
not clear pulse group data.

This is an internal error that occurs
after combining waveforms and trying
to clear pulse group data.

Recompile the waveform.
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Error message Description Possible solution
RFXpress cannot compile. At least
one user defined step must be
present.

This occurs when the modulations,
User-Defined Step FM AM and
User-Defined Step PM AM, contain no
steps (the table is empty).

Add at least one step in the table for
the compilation to proceed.

IQ calibration requires two channels.
Cannot be done on a single channel
instrument.

This message appears when the
instrument has one channel or the
instrument is in the Interleave mode.

Disable Interleave option in the
Instrument control window or from the
AWG.

Pulse width samples are too large.
Press 'Continue' to have the clutter
without the properties of the pulse,
or press 'Cancel' and reduce pulse
ontime/sampling rate.

Convolution cannot be applied on a
signal of this length.

Reduce pulse ontime or the final
sampling rate.

xxx

AWG Sequence Window-Related errors
Error message Description Possible solution
Invalid value for Wait. Wait accepts only On or Off. Any other

value is not accepted.
Enter either On or Off.

Invalid value for Repeat. This message appears when you
enter an invalid value in the Repeat
column. The repeat value has to be
an integer value or Infinite. The repeat
value should be between 0 and the
maximum repeat value allowed by
instrument.

Select Infinite or a valid repeat value.

Invalid value for Event Jump To. This message appears when you
enter an invalid value in the Event
Jump To column. Event Jump To can
be set to a valid sequence index or to
the next sequence element.

Select a valid sequence element
index.

Invalid value for Go To. This message appears when you
enter an invalid value in the Go To
column. Go To can be set to a valid
sequence element index.

Select a valid sequence element
index.

Software sequencer error. Waveform
length exceeds instrument memory.
Reduce pulse parameters.

This message appears when the AWG
software sequencer is unable to run
the waveform.

Reduce the pulse parameters and
recompile.

xxx
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Error Messages for OFDM

Error message Description Possible solution
Compile failed. This message appears when the

application was unable to compile the
waveform.

Report the problem to customer
support attaching the log.txt file and
the error code. The file log.txt is
present in the system folder of the
directory where RFXpress is installed.

Compilation aborted. This message appears when you
cancel the compilation.

N/A

Convolution Code length is greater
than constraint length.

The code length does not match the
constraint length.

Change the convolution encoder
polynomial or the constraint length.

Convolution Code length is less than
constraint length.

The code length does not match the
constraint length.

Change the convolution encoder
polynomial or the constraint length.

Reed Solomon Primitive polynomial
has to be less than 2(number of bits)–1.

The primitive polynomial is greater
than 2(number of bits)–1.

Change the primitive polynomial or
the bits per symbol.

Reed Solomon is not a primitive
polynomial.

The polynomial is not a primitive
polynomial.

Provide a primitive polynomial.

Number of parity symbols must be a
multiple of 2.

Number of Encoded
Symbols–-Number of Input Symbols
should be multiple of 2.

Change the number of input or output
symbols.

Reed Solomon number of encoded
symbols should be greater than input.

Input number of symbols should be
less than output.

Ensure that the number of input
symbols is less than the output.

Encoded symbol should be less than
2(number of bits)–1.

Maximum Number of Encoded
symbols is 2(m–1).

N/A

Size of the encoded data in each block
is too large to handle.

Number of bits for each block of Reed
Solomon should be less than 1 M bits.

N/A

Multipath delay is greater than the
waveform length.

This message appears when the
multipath delay provided is greater
than the waveform duration.

Decrease the multipath delay or
increase the waveform duration.

Phase noise VCO bandwidth is
greater than sampling rate/2.

The filter cut-off must be less than the
sampling rate/2.

Reduce the cut-off or increase the
sampling rate.

Sample rate might not be good
enough.

Samples rate is less than 2.5 times
the maximum signal bandwidth.

Reduce the signal bandwidth.

Symbol name must be unique. This message appears if the user tries
to provide a symbol name which is
already present in the symbol list.

Provide a unique name.

Cannot delete all symbols. At least
one symbol should be present.

This message appears when the user
tries to delete all the symbols in the
symbol list.

N/A

Subcarrier index is out of range. This message appears when the user
enters an invalid subcarrier range in
the edit box.

Provide a range based on the number
of subcarriers present for the symbol.

Invalid range. Ensure that range is
entered as shown in the example.

The format of the range is invalid. Provide the range with a valid format.

RFXpress RFX100 User Manual 209



Reference Error Messages for OFDM

Error message Description Possible solution
Packet name must be unique. The packet name provided is already

present in the packet list.
Provide a unique name.

Cannot delete all packets. At least
one packet should be present.

This message appears if the user tries
to delete all the packets in the packet
list.

N/A

Invalid file. This message appears if the
user provides an invalid file for
preamble/postamble or user defined
frequency weight file.

Provide a valid file with a proper
format.

Frame name must be unique. This message appears if the user
provides a frame name which is
already present in the frame list.

Provide a unique name.

Cannot delete all frames. At least one
frame should be present.

This message appears if the user tries
to delete all the frames in the frame
list.

N/A

All puncture bits for an output tap
cannot be zero.

This message appears if the user
punctures all the bits in the puncturing
scheme of convolution coding.

Have at least one bit with a value 1.

Base data name must be unique. This message appears if the user
provides a name for base data which
is already present in the base data list.

Provide a unique name.

Cannot delete all subcarriers. At least
two subcarriers should be present.

This message appears if the user tries
to delete all the subcarriers of the
symbol.

N/A

Cannot delete all hop frequency
entries. At least one entry should be
present.

This message appears if the user tries
to delete all the frequency hops from
the frequency hopping dialog.

N/A

Maximum number of symbols: 100. This message appears if the user
tries to add more than the maximum
number of symbols supported.

Delete symbols that are not used and
try adding again.

Maximum number of packets: 100. This message appears if the user
tries to add more than the maximum
number of packets supported.

Delete packets that are not used and
try adding again.

Maximum number of frames: 100. This message appears if the user
tries to add more than the maximum
number of frames supported.

Delete frames that are not used and
try adding again.

Data source file name for <base_data>
is not found in the specified path.

This message appears if the path
provided (by the user) for source file
name of an base data is invalid.

Provide a valid path.

Data source file name of <base_data>
contains more than 1M points.

This message appears if the data
source file contains more than 1M
points.

Delete some of the data in the file
such that it has only 1M points.

Data source file name of <base_data>
contains invalid data.

This message appears if the format of
the data source file is not valid.

Follow the file format for the data
source file.
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Error message Description Possible solution
Internal error: No entries are present
in the hash table of memory mapped
files.

N/A Restart the application.

User defined Frequency weight file for
<symbol_name> Symbol is not found
in the specified path.

This message appears if the path
provided for "user defined frequency
weight" file of a symbol is invalid.

Provide a valid path.

Preamble file for
<packet_name>packet is not
found in the specified path.

This message appears if the path
provided for "preamble" file of a packet
is invalid.

Provide a valid path.

Postamble file for <packet_name>
packet is not found in the specified
path.

This message appears if the path
provided for "postamble" file of an
packet is invalid.

Provide a valid path.

RFXpress cannot compile. The
waveform length is shorter
than the minimum supported for
<instrument_name>.

This message appears if the
parameters provided generate a
waveform that is less than the
minimum supported.

Increase the sampling rate in compile
settings, or increase the duration of
the waveform.

Start symbol cannot be more than End
symbol.

This message appears if the user
provides the value of start symbol ID
more than the end symbol ID.

Provide a value for Start symbol ID
less than End Symbol ID, or increase
the value of End Symbol ID and then
provide Start Symbol ID.

End symbol cannot be less than Start
symbol.

This message appears if the user
provides the value of end symbol ID
less than the start symbol ID.

Provide a value for End symbol
ID more than Start Symbol ID OR
Decrease the value of Start Symbol ID
and then provide End Symbol ID.

Cannot add more than {n} subcarriers. This message appears if the user tries
to add more than maximum number
of subcarriers.

Delete subcarriers that are not used.

Select a subcarrier to delete. This message appears if the user
clicks on the delete button without
selecting the carrier.

Select a carrier in the Symbol setup
to delete it.

Cannot delete odd number of
subcarriers.

This message appears if the user tries
to delete carriers resulting in an odd
number of carriers left for the symbol.

Delete carriers such that the number
of remaining carriers are even.

The paste operation cannot be done
since the number of subcarriers will
not be a multiple of 2.

This message appears if the user
pastes the carriers resulting in an odd
number of carriers for the symbol.

Do the paste operation such that the
number of remaining carriers are
even.

Number of carriers in the file are not
multiple of 2.

This message appears if the number
of carriers in the "User Defined
Frequency weight" file is not even.

Either add more carriers or delete
some to keep the number even.

Number of carriers in the file are more
than <max_number_of_carriers>.

This message appears if the number
of carriers in the "User Defined
Frequency weight" file is more than
the maximum supported.

Delete some of the carriers.

Invalid User defined frequency weight
file for <symbol_name>.

This message appears if the user
provides an file which does not match
the format of "User defined Frequency
weight" file.

Provide a file with the correct format.
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Error message Description Possible solution
The number of carriers in the User
defined frequency weight file are not
multiple of 2 for <symbol_name>.

This message appears if the number
of carriers in the "User Defined
Frequency weight" file is not even.

Either add more carriers or delete
some to keep the number even.

Number of carriers in the User Defined
frequency weight file are more than
65536 for <symbol_name>.

This message appears if the number
of carriers in the "User Defined
Frequency weight" file is more than
the maximum supported.

Delete some carriers.

Invalid amplitude value. If the amplitude value in the Tone
Nulling dialog box is not valid.

Enter a valid value.

Invalid phase value. This message appears if the phase
value in the Tone Nulling dialog box
is not valid.

Enter a valid value.

Invalid Preamble file for
<packet_name>.

This message appears if the file
provided for "Preamble" file of an
packet is invalid.

Provide a valid file with proper format.

Preamble file length is more than 2 M
for <packet_name>.

This message appears if the file
provided for "Preamble" is more than
2 M points.

Delete some values to make it within
2M points.

Invalid Postamble file for
<packet_name>.

This message appears if the file
provided for "Postamble" file of an
packet is invalid.

Provide a valid file with proper format.

Postamble file length is more than 2 M
for <packet_name>.

This message appears if the file
provided for "Postamble" is more than
2 M points.

Delete some values to make it within
2M points.

Internal error. Could not resample the
preamble file.

N/A Save the RFS file. Restart RFXpress.
Load the RFS file and compile.

Internal error. Could not resample the
postamble file.

N/A Save the RFS file. Restart RFXpress.
Load the RFS file and compile.

Internal error. RFXpress Compilation
failed. Could not clear waveform data.

N/A Save the RFS file. Restart RFXpress.
Load the RFS file and compile.

Internal error. Could not load the
preset files.

N/A Restart RFXpress.

Internal error. Not a valid preset. N/A Restart RFXpress.
Internal error. Could not load the
values. Compile failed.

N/A Save the RFS file. Restart RFXpress.
Load the RFS file and compile.

Frequency offset value cannot be
repeated.

This message appears when the user
tries to enter the same frequency
value in the frequency model table for
phase noise.

Enter a unique frequency offset value.

RFXpress cannot compile. At least
one hopping element should be
present for <packet_name> packet.

This message appears if the user has
turned on Frequency Hopping and has
not provided any hop element.

Either turn off Frequency Hopping or
add at least one hop element.

RFXpress cannot compile. At least
one noise element should be present
for <packet_name> packet.

This message appears if the user
has turned on Gated Noise and not
provided any noise element.

Either turn off Gated Noise or add at
least one noise element.

xxx
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Error Messages for Environment Plug-In
Error message Description Possible solution
No anchor signal defined. None of the signals in the environment

is defined as an anchor.
Right-click any of the signals and click
Set as anchor.

No signal. No environment signal exists. Add a signal to the environment
by double clicking or dragging and
dropping it from the list.

Invalid operation. Cannot add RF
signal to the environment if output
signal type is IQ.

If the signal format is IQ, you cannot
add an RF signal as interference if
you are using the User Defined signal
type.

Change the user-defined interference
signal type to IQ, or change the
environment output signal format to
RF.

Cannot generate signal with these
settings.

For any standard signal, RFXpress
cannot generate a waveform with the
current Configure dialog box settings.

Try a different combination of
parameters on the Configure dialog
box.

The output waveform name and the
interference waveform name in the
User Defined signal is the same.

The waveform name added as
interference on the User Defined
dialog box cannot be identical to
the output waveform name on the
Compile Settings dialog box.

Change the output waveform name on
the Compile Settings dialog box.

Cannot add more than 25 elements to
the environment.

You cannot add more than 25
elements to the environment.

Reduce the number of environment
elements to 25 or less.

Waveform name(s) cannot be empty.
Please specify the waveform name(s).

The IQ or RF Waveform Name field is
empty on the User Defined dialog box.

Specify a valid waveform name.

IQ Waveform not found for User
Defined signal.

The IQ waveforms specified on the
User Defined dialog box do not exist.

Verify that the waveform list contains
the waveforms.
Import or generate the waveforms
again.

RF Waveform not found for User
Defined signal.

The RF waveforms specified on the
User Defined dialog box do not exist.

Verify that the waveform list contains
the waveforms.
Import or generate the waveforms
again.

Not enough memory to compile.
Restart the application and try again.

RFXpress cannot generate one of the
interference signals due to memory
limitations.

Restart the application and try again.
If the error still occurs, reduce the
number of interference signals or the
final signal duration.

Compilation failed. RFXpress cannot generate the signal
for the given settings.

Restart the application and try again.
If the error still occurs, contact
Customer Support.

xxx
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DUT Characterization Errors
Error message Description Possible solution
Connect to an oscilloscope before
proceeding.

This message appears when you click
Next before selecting and connecting
to an oscilloscope.

Select an oscilloscope from the list
and click Connect.

Connect to only one oscilloscope
which will be used for calibration.

This message appears if you
have connected to more than one
oscilloscope from the list.

Ensure that you are connected to
only one oscilloscope. Disconnect the
others.

Internal Error: Failed to allocate
memory.

This is an internal error. Restart the application.

Internal Error: Exception occurred
during calibration.

This is an internal error. Restart the application.

Choose the AWG channel to connect
to the oscilloscope.

This message appears when you
click Next before selecting the AWG
channel to connect to.

Select a channel to connect to the
oscilloscope.

Start Frequency has to be less than
End Frequency.

The specified Start Frequency is
greater than the specified End
Frequency.

Change the Start Frequency so that it
is less than the End Frequency.

Enter the file name to export the
characteristics of DUT.

This message appears when no name
is given.

Enter a valid file name.

Cannot skip Step 1. The required
correction file is missing.

This message appears when you skip
Step 1 (calibration) and the internal
correction file is missing.

Run Step 1.

Start Frequency cannot be less than
Frequency Resolution.

The specified Frequency Resolution is
greater than the specified Frequency
Resolution.

Change the Start Frequency so
that it is more than the Frequency
Resolution.

Error in communicating with the
oscilloscope.

This appears when the communication
between the AWG and oscilloscope is
not available.

Check the connections.

Restart the application and try
again.

xxx
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RTSA Connectivity-Related Errors
Error message Description Possible solution
Waveform name not entered. The waveform name has not been

entered.
Enter a waveform name.

Unable to communicate with Spectrum
Analyzer. The I and Q data cannot
be imported. Please check the
instrument connection.

This error appears when you press
the Acquire button and the application
is unable to communicate with the
spectrum analyzer.

Check the instrument connection and
acquire again.

Error creating waveform. This error appears when a memory
shortage or an internal error occurs.

Restart the instrument.

Error creating shared directory. This error appears when the
application is unable to create a
shared folder for copying the iqt file.

Ensure that you have administrator
rights on the machine on which the
application is running.

Error in transferring the IQT file from
Spectrum Analyzer.

This error appears when the file
transfer is unsuccessful.

Check the instrument
connections.

Restart TekVisa on the spectrum
analyzer.

Unable to communicate with Spectrum
Analyzer. Please check the instrument
connection.

This error appears when the
application is unable to communicate
with the spectrum analyzer.

Check the instrument connections.

xxx

Miscellaneous Error Messages
Error message Description Possible solution
Compile failed. Invalid parameters were found during

compilation.
Check compilation parameters

before compiling.

Restart the application.
Compile failed. The correction factors cannot be

applied to the channel.
Increase the length of the

waveform.

Create a correction file with lower
resolution.

Maximum number of averages: 1024. The total number of averages exceeds
1024 in the spectrum plot.

N/A

Invalid file extension. This file type is not supported by the
application for import.

Select the correct format supported by
the application.

Invalid file type. Data cannot be
imported.

The file contains wrong data.

The data (in the file) does not
match the file type specified during
file import.

Use a valid file.
Specify the type of data in the file
correctly.

Unable to retrieve the file size. The file size could not be computed
based on the data in the file.

Use a valid file.
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Error message Description Possible solution
Unable to create buffer for the
imported file.

The software is unable to allocate the
required memory for importing the file.

Release memory by deleting some
waveforms in the waveform list.

Unable to load the setup file.
Application not available.

The selected setup file cannot be
loaded because the application
(UWB-WiMedia) is not available.

Use a valid file.
Purchase the UWB-WiMedia
application.

Error opening setup file. File cannot
be opened.

The setup file is corrupt and cannot
be opened.

Use a valid file.

Invalid data in the setup file. File may
be corrupted.

The setup file contains invalid data or
may be corrupt.

Use a valid file.

Error loading data from the setup file.
File cannot be loaded.

The data contained in the setup file is
not usable.

Use a valid file.

Error writing the setup file. File cannot
be written.

The setup file is not writable. The
setup file may be read only.

Check whether the file is being
used by another program.

Check the file properties.
Error opening the data file. File cannot
be opened.

The data file is corrupt and cannot be
opened.

Use a valid file.

Error writing the data file. File cannot
be written.

The data file is not writable. The data
file may be read only.
Enough disk space may not be
available on the disk drive to which
you are writing the file.

Check whether the file is being
used by another program.

Check the file properties.

Free some disk space on the
drive or save the file on another
disk drive.

Error reading the data file. File cannot
be read.

The data contained in the file is not
usable.

Use a valid file.

No waveform selected in the waveform
list.

No waveform has been selected to
save.

Select a waveform to save.

Compilation aborted. Waveform
length exceeds the instrument
memory in the AWG waveform list.
Delete some of the waveforms in the
list and compile.

This message appears when the
total waveform length in the AWG
waveform list and the waveform to be
generated by RFXpress exceeds the
maximum instrument capacity.

Delete some waveforms from the list
and compile again.

You cannot transfer data for the
currently selected unlicensed option.

This message appears when you have
not entered a valid license for the plug
in and are using the Compiles and
Sends option in the Compile Settings
dialog box.

Enter the valid license key in Option
Installation dialog box.

xxx
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Miscellaneous Error Messages 2
Error message Description Possible solution
Invalid selection of waveforms. Only
one waveform must be selected.

More than one waveform is selected
to save.

Select only one waveform at a time
to save.

Error opening the IQT file. File cannot
be opened.

The .iqt file is corrupt and cannot be
opened.

Use a valid file.

Error reading the IQT file. File cannot
be read.

The .iqt file is corrupt and cannot
be opened.

The data contained in the .iqt file
is not usable.

Use a valid file.

Error opening the TIQ file. File cannot
be opened.

The .tiq file is corrupt and cannot be
opened.

Use a valid file.

Invalid data in the TIQ file. File may
be corrupted.

The .tiq file contains invalid data or
may be corrupt.

Use a valid file.

Error reading the TIQ file. File cannot
be read.

The .tiq file is corrupt and cannot
be opened.

The data contained in the .tiq file
is not usable.

Use a valid file.

Selected waveforms have different
length.

Spectrum calculation requires
waveforms of same length.

Select I and Q format waveforms of
same length from the waveform list.

Unable to retrieve the license
information.

The option key string or the serial
number is incorrect.

Enter the correct option key string or
serial number.

Invalid option string. CRC error in
option string.

Incorrect option key string. Enter the correct option key string.

Invalid option string. Incorrect unique
ID.

Mismatch of the option key string and
the associated serial number.

Enter the correct option key string and
associated serial number.

Invalid option string. Incorrect option key string. Enter the correct option key string.
Compilation aborted. Waveform
length exceeds the instrument
memory.

The combination of waveform length
and oversampling is such that the
number of samples to be generated
exceeds the maximum memory.

Change either the waveform length
or the oversampling value so that
the product does not exceed the
instrument memory.

Compilation aborted. Waveform
length exceeds the generation limit.

The combination of waveform length
and oversampling is such that the
number of samples to be generated
exceeds the maximum memory.

Change either the waveform length
or the oversampling value so that
the product does not exceed the
instrument memory.

Maximum number of entries in
multipath table:10

The maximum number of paths that
you can define in 10.

Do not define more than ten paths.

The delay cannot be the same for
different paths.

No two paths can have the same
delay value.

Change the delay to a unique value.

Invalid waveform name entered. An invalid waveform name has been
entered.

Enter a valid waveform name.

File name cannot exceed 30
characters. File cannot be imported.

The file name is too long. Rename the file. Make sure that the
new name is 30 characters or less.
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Error message Description Possible solution
Error while setting the oscilloscope
record length.

RFXpress could not set the required
oscilloscope record length.

Try the operation again. Ensure
that the SignalVu Vector Signal
Analysis software is not running on
the oscilloscope.

Invalid ADS® file. The provided ADS® format file is
invalid.

Provide a valid ADS® file.

Invalid VSA® file. The provided VSA® format file is
invalid.

Provide a valid VSA® file.

Waveform length exceeds the
instrument memory. Please enter a
new sampling rate.

This message appears when the
application runs in the offline mode
(that is on the PC).

Enter a new sampling rate such that
the resulting waveform length lies
within the instrument memory limit.

Waveform length exceeds the
generation limit. Please enter a new
sampling rate.

This message appears when the
application runs in the online mode
(that is on the AWG).

Enter a new sampling rate such that
the resulting waveform length lies
within the AWG memory limit.

Unable to import a file with the
sampling rate equal to zero.

This message appears when the
sampling rate specified in the file is
zero.

Enter a nonzero sampling rate.

xxx

Shortcut Keys
Menu/Menu item Shortcut key
File Alt+F
File> Open Setup... Ctrl+O
File> Save Setup Ctrl+S
View Alt+V
Configure Alt+C
Waveform Alt+A
System Alt+S
Window Alt+W
Help Alt+H
xxx

RFXpress Options and AWG Models

Generic and Radar Signals
The following tables list the AWG models and options to generate generic and radar signals using
RFXpress.
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Table 164: AWG models and options for generic and radar signal generation
Instrument model Direct RF IF from AWG IQ from AWG Hardware signal

addition
AWG7102 Yes Yes Yes No
AWG7101 Yes Yes No No
AWG7052 No Yes Yes No
AWG7051 No Yes No No
AWG5014 No Yes Yes Yes
AWG5012 No Yes Yes Yes
AWG5004 No Yes Yes Yes
AWG5002 No Yes Yes Yes
xxx

Table 165: AWG B series models and options for generic and radar signal generation
Instrument model Direct RF IF from AWG IQ from AWG Hardware signal

addition
AWG7122B Yes Yes Yes No
AWG7121B Yes Yes No No
AWG7062B No Yes Yes No
AWG7061B No Yes No No
AWG5014B No Yes Yes Yes
AWG5012B No Yes Yes Yes
AWG5004B No Yes Yes Yes
AWG5002B No Yes Yes Yes
xxx

UWB-WiMedia

The following tables list the AWGmodels and options to generate UWB-WiMedia signals using RFXpress.

Table 166: AWG models and options for UWB-WiMedia signal generation
Instrument model Direct RF IF from

AWG
IQ from
AWG

Calibra-
tion

Remarks

AWG7102 – Opt 06 Yes, BandGroup1 and
BandGroup2

Yes Yes Yes Recommended
option for Direct RF
generation.

AWG7102 – Standard No Yes Yes Yes Not recommended for
Direct RF generation.

AWG7101– Standard No Yes No Yes N/A
AWG7101– Opt 02 Yes, BandGroup1 Yes No Yes Not recommended for

Direct RF generation.
AWG7052 No Yes Yes Yes N/A
AWG7051 No Yes No Yes N/A
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Table 166: AWG models and options for UWB-WiMedia signal generation (cont.)

Instrument model Direct RF IF from
AWG

IQ from
AWG

Calibra-
tion

Remarks

AWG5014 No No Yes No Only Non hopping IQ.
AWG5012 No No Yes No Only Non hopping IQ.
AWG5004 No No No No N/A
AWG5002 No No No No N/A
xxx

Table 167: AWG B series models and options for UWB-WiMedia signal generation
Instrument model Direct RF IF from

AWG
IQ from
AWG

Calibra-
tion 1

AWG7122B – Opt 06 Yes, all BandGroups (BandGroup1 to
BandGroup6)

Yes Yes Yes

AWG7122B – Opt 02 Yes, BandGroup1, BandGroup2 Yes Yes Yes
AWG7122B – Std Yes, BandGroup1 Yes Yes Yes
AWG7121B – Opt 02 Yes, BandGroup1, BandGroup2 Yes No Yes
AWG7121B – Std Yes, BandGroup1 Yes No Yes
AWG7062B No Yes Yes Yes
AWG7061B No Yes No Yes
AWG5014B No No Yes 2 No
AWG5012B No No Yes 2 No
AWG5004B No No No No
AWG5002B No No No No
xxx

1 Supports RF/IF calibration
2 Supports nonband hopping IQ signals
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AWG Specifications
For information on the specifications of the AWG5000 and AWG7000 series instruments, refer to the
following documents:

AWG5000 Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2082-XX.

AWG5000B Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2486-XX.

AWG7000 Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-1853-XX.

AWG7000B Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2487-XX.

You can view the documents from Start > All Programs > Tektronix > AWG > Documentation.

Interleave
The AWG7000 with Option 06 supports the interleaving mode. Interleaving is a mode where the sampling
rate ranges from 10 GS/s to 20 GS/s. The following table shows the amplitude and sampling rates for the
interleaving and noninterleaving modes.

Table 168: Amplitude and sampling rates in noninterleave and interleave modes
NonInterleaving Interleaving
Amplitude (min, max) Sampling rate (min, max) Amplitude (min, max) Sampling rate (min, max)
500 mVpp, 1 Vpp 10 MS/s, 10 GS/s (for

AWG7102)
10 MS/s, 12 GS/s (for
AWG7122B)

500 mVpp, 1 Vpp 10 GS/s, 20 GS/s (for AWG7102)
12 GS/s, 24 GS/s (for
AWG7122B)

xxx

In the Interleaving mode, the output is available in a separate interleave connector as shown in the figure.
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As an example, in the noninterleave mode let the sampling rate be 20 GS/s and the original amplitude
samples be 0.1, 0.2, 0.3, 0.4, 0.5, 0.1, 0.2. This can be represented graphically as shown in the following
figure (not drawn to scale).

In the interleave mode, alternate samples are output from each channel. The samples are distributed
between the two channels as shown below:

Ch1 Ch2
0.1 0.2
0.3 0.4
0.5 0.1
0.2 0
xxx

This can be represented graphically as shown in the following figure (not drawn to scale).
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Zeroing
When Interleave is on, you can turn Zeroing on or off. This function is only available when Interleave is
available. If you compose waveform data that is divided into two channels, the zeroing function allows you
to select whether you want to handle each waveform as RZ (Return to Zero) or NRZ (Non Return to Zero).

If you turn the zeroing function on, the bandwidth increases. However, spurious characteristics worsen
(increase in the frequency spectra that should not be output) and the amplitude range is halved.
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PRBS Editor Starting Values
When the option Use different PRBS at the beginning is selected, the starting value for each PRBS
varies. The following table gives the initial shift register values and the PRBS polynomial expression:

Table 169: Initial shift values and PRBS polynomial expressions
PRBS Initial PRBS Polynomial for the Standard PRBS
PRBS 7 0 0 0 0 0 0 1 X7+X6+1=0
PRBS 9 0 0 0 0 0 0 0 0 1 X9+X5+1=0
PRBS 15 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 X15 +x14+1=0
PRBS 16 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 X16+X14+X13+X11+1=0
PRBS 20 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 X20+X17+1=0
PRBS 21 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 X21+X19+1=0
PRBS 23 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 X23+X18+1=0
xxx

Amplifier Distortions
Nonlinear amplifier distortions (AM/AM and AM/PM) are calculated using the following equations:
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Nonlinear Impairments

AM/AM
Nonlinear modulator AM/AM impairments are calculated using the following equations:

The inphase and quadrature distortions are applied to the signal as follows:

AM/PM

Nonlinear modulator AM/PM impairments are calculated using the following equations:

The inphase and quadrature distortions are applied to the signal as follows:

RFXpress RFX100 User Manual 225



Reference Image Calibration

Image Calibration
When a digital signal is converted to an analog signal though the DAC, the signal spectrum will repeat
every harmonic of the sampling rate (Fs). The spectrum of the reconstructed signal will show the signal
spectrum and its image around the sampling rate.

For example, if a signal with a center frequency of 5.8 GHz and a bandwidth of 1 GHz is created with a
sampling rate 15 GHz, the positive signal spectrum out of the DAC will show spectral components at:

5.8 GHz with a bandwidth of 1 GHz

9.2 GHz with a bandwidth of 1 GHz (This is an image with I and Q swapped and inverted in phase)

20.8 GHz with a bandwidth of 1 GHz

24.2 GHz with a bandwidth of 1 GHz (This is an image with I and Q swapped and inverted in phase)

The following figure shows the image signal at 9.2 GHz.

RFXpress can create a signal above Nyquist (Fs/2) using undersampling. Calibration would allow you to
get a flat frequency and linear phase response in the first image of the signal, in this example at 9.2 GHz.
RFXpress also provides for swapping of I and Q (in the IQ impairments tab) and phase inversion of I and
Q (in the Compile Settings dialog box) to create undersampled signals.

226 RFXpress RFX100 User Manual



Reference Types of Modulation

Types of Modulation
No Modulation

This modulation will generate a simple, constant-frequency pulsed waveform. The carrier frequency
is not modulated.

Linear Frequency Modulation (LFM)

In Linear Frequency Modulation or Chirp Modulation, the frequency is swept linearly across the pulse
width. The sweep can be Low to High (upward) or High to Low (downward). You provide the frequency
sweep range. LFM is used to achieve higher bandwidths in pulse compression radars.

Up Down Chirp Modulation
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Up-down chirp modulation varies the frequency of the carrier from –Sweep Range/2 to +SweepRange/2
and then again from +Sweep Range/2 to –Sweep Range/2.

For Number of Up-downs = 1 and Invert = OFF, the pulse width is divided into two. The first half of the
pulse will have linear chirp from –Sweep/2 to +Sweep/2 and the second half of the pulse will have linear
chirp from +Sweep/2 to –Sweep/2 creating an inverted ‘V’ chirp within the total pulse width.

When Invert is enabled (set to ON), the modulation creates a ‘V’ shaped frequency profile. When the
Number of Up-downs is greater than 1 (n>1), the modulation creates multiple (n) number of ‘V’s or
Inverted ‘V’s. The subpulse width of each V is equal to PulseWidth/n.

RFXpress uses four types of Up-Down Chirp modulation. They are:

Up Down Chirp with a single up-down

Up Down Chirp with a single up-down inverted
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Up Down Chirp with multiple up-downs

Up Down Chirp with multiple up-downs inverted
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Biphase Coded Pulses and Barker Codes

Biphase codes refer to a type of phase-coded pulse waveforms. In phase-coded waveforms, the frequency
of the pulse width is held constant, but the absolute phase is switched between one of the N fixed values.
Each pulse width is divided into M subpulses (or chips), where each of the subpulses are switched between
one of the N phase values.

In Biphase Coded Pulses, N=2. The most important biphase codes are Barker codes, where the phase is
switched between 0 and 180 degrees. The number of subpulses is defined by the Barker Code number, for
example Barker 11 has eleven subpulses. The Barker codes are predefined.

Polyphase Codes
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Polyphase codes are a type of phase-coded pulse waveforms. You can define the number of subpulses
by providing number of steps. An initial offset provides the phase for the first pulse and the phase offset
provides the offset in phase for subsequent subpulses.

Frank Code

Frank code is a type of Polyphase code, where the pulse width is divided into (Code length)2 subpulses.
For example, a code length of 4 will have 16 subpulses of equal width. The phase for each of the subpulses
is derived from the formula:

Phase(p,q) = 2*pi*p*q/Code length

where p=0, 1, 2,…..code length–1 and q=0, 1, 2…code length–1
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P1 Polyphase Code

P1 code is another type of Polyphase code, where the pulse width is divided into (Code length)2 subpulses.
For example, a code length of 4 will have 16 subpulses of equal width. The phase for each of the subpulses
is derived from the formula:

Phase(p,q) = –180/Codelength*(Codelength–(2*p–1))*[(p–1)*Codelength)+(q–1))]

where p=1, 2,…..code length and q=1, 2, …code length

P2 Polyphase Code

P2 code is yet another type of Polyphase code, where the pulse width is divided into (Code length)2
subpulses. For example, a code length of 4 will have 16 subpulses of equal width. The phase for each of
the subpulses is derived from the formula.

Phase(p,q)=[((180/Codelength )*((Codelength –1)/ Codelength))–((180/ Codelength)*(p–1))]*[
Codelength+1–(2*q)]
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where p=1, 2, … code length and q=1, 2, .. code length.

P3 Polyphase Code

P3 code is yet another type of Polyphase code, where the pulse width is divided into (Code length)2
subpulses. For example, a Code length of 4 we will have 16 subpulses of equal width. The phase for
each of the subpulses is derived from the formula:

Phase(p)=180*(p–1)2/ code length2

where p=1, 2, …..code length2.
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P4 Polyphase Code

P4 code is yet another type of Polyphase code, where the pulse width is divided into (Code length)2
subpulses. For example, a Code length of 4 we will have 16 subpulses of equal width. The phases for
each of the subpulses is derived from the formula:

Phase(p)=[180*(p–1)2/ code length2]–[180*(p–1)]

where p=1, 2, …..code length2.

User-Defined Step PM AM
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User-defined codes allow you to define your own phase coding. The number of subpulses is defined by the
total number of steps. You define the duration, phase, and amplitude of each subpulse. Use user-defined
codes to create Biphase codes that are not predefined or to create Frank’s code.

Step Frequency Modulation

Step Frequency creates a frequency modulated pulse waveform. The pulse width is divided into subpulses
and each subpulse can have a different frequency. The number of subpulses can be defined by number
of steps. The initial step provides the frequency for the first subpulse and the step size provides the
frequency offset for subsequent subpulses.

Nonlinear Frequency Modulation
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Nonlinear FM can be used to define a frequency modulation which can have a nonlinear profile unlike
the Linear FM under LFM.

Nonlinear FM uses the coefficients to create the instantaneous frequencies for modulation.

F(t) = 2*π*C(t)*t, where C(t) is the instantaneous frequency.

Instantaneous frequency C(t) can be defined by the following polynomial:

C(t) = c0+c1*t+c2*t*t +c3*t*t*t..., where c0, c1, c2 and others are the coefficients with order 0, 1, 2, ...
and others.

The following MATLAB code generates the Taylor weighting curve.

function coeff = createcoeff_nonSymmetrical(Pulsewidth,BW,NoofCoefficients);

% Tektronix

% This function will create coeffecients for

% non-symmetrical Non linear FM profile.(with 40 dB Taylor weighting)

% Reference: Radar Handbook: Merrill Skolnik

% This free software may not have gone through Tektronix normal quality

% control or production processes, but is provided to users as an

% accommodation to respond to user requests. The free software is provided

% hereunder on an As-Is basis without any representation or warranty.

% TEKTRONIX DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING

% WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,

% AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT SHALL

TEKTRONIX

% BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL

% DAMAGES IN ANY WAY ARISING OUT OF, OR CONNECTED WITH, THE USE OF THIS

% FREE SOFTWARE.

%Example:

%Pulsewidth=30e-6;

%NoofCoefficients=15;

%BW=10e6; % Bandwidth

NumberofSamples=100000;

Fs=NumberofSamples/Pulsewidth; % Sampling Rate

curve=zeros(1,NumberofSamples); % This will contain the frequency vs time

profile

t=-NumberofSamples/(2*Fs):1/Fs:(NumberofSamples-1)/(2*Fs);

K(1) = -0.1145;

K(2) = 0.0396;

K(3) = -0.0202;

K(4) = 0.0118;

K(5) = -0.0082;

K(6) = 0.0055;

K(7) = -0.0040;

for k=1:1:NumberofSamples,

y=sum(K(1:7).*(sin(2*pi*(1:7)*t(k)/Pulsewidth)));
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curve(k)=BW*((t(k)/Pulsewidth) + y);

end

timeindex=[0:Pulsewidth/(NumberofSamples-1):Pulsewidth];

s = warning('off', 'MATLAB:polyfit:RepeatedPointsOrRescale');

coeff = polyfit(timeindex,curve,NoofCoefficients-1);

warning(s.state, s.identifier);

coeff=coeff(end:-1:1);

testcurve = zeros(1,NumberofSamples);

for n = 1:NoofCoefficients

testcurve = testcurve + coeff(n) * (timeindex .^ (n-1));

end

figure(1);

plot(curve, 'b');hold on; plot(testcurve, 'r'); hold off;

legend('Original NLFM Curve', 'From Coefficients');

User-Defined Step FM AM

User-defined codes allows you to define your own frequency agile signals or frequency hopping within the
pulse width. The number of subpulses is defined by the total number of steps. You define the duration,
the frequency offset from the carrier, and the amplitude of each subpulse. User-defined step FM AMs
can be used to create Costa's Code modulation.

QPSK

Each pulse is divided into number of symbols where the duration of each subpulse is equal to Pulse
Duration/Number of Symbols. Random symbols are generated and the phase for each of the symbols is
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based on the following equation. You can have the same symbols for all the pulses in the pulse group or
can select to have different symbols.

BPSK

Each pulse is divided into number of symbols where the duration of each subpulse is equal to Pulse
Duration/Number of Symbols. Random symbols are generated and the phase for each of the symbols is
based on the following equation. You can have the same symbols for all the pulses in the pulse group or
can select to have different symbols.

238 RFXpress RFX100 User Manual



Reference Frequently Asked Questions

Custom Modulation

Custom Modulation accommodates user-defined phase modulation by providing a phase profile in ASCII
or in MATLAB .mat files.

Frequently Asked Questions
1. How do you set your own Biphase and Polyphase codes?

Under Modulation, use the User Defined Codes option to define your own phase codes. Define the
number of subpulses by the total number of steps and define the phase for each subpulse.

2. How many pulse definitions can you have?

You can define up to 4096 pulse groups.

3. Is the number of pulse definitions really just limited by the waveform memory used by each definition?

You can define up to 4096 pulse groups. But the overall waveform length (total waveform length of all
the pulse groups) cannot exceed the maximum waveform memory.
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